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1 Getting Started

MATLAB Builder EX Product Description
Deploy MATLAB® code as Microsoft® Excel® add-ins

MATLAB Builder™ EX lets you package MATLAB programs as Microsoft
Excel add-ins and integrate them into Excel spreadsheets. These add-ins
enable you to perform analyses and simulations within Excel that include
MATLAB math, graphics, and user interfaces developed in MATLAB.
The add-ins can be distributed royalty-free to computers that do not have
MATLAB installed using the MATLAB Compiler Runtime (MCR) that is
provided with MATLAB Compiler™.

Using MATLAB Compiler, MATLAB Builder EX encrypts your MATLAB
programs and then generates Microsoft Visual Basic® for Applications (VBA)
wrappers around them so that they behave just like other Excel add-ins.

MATLAB Builder EX creates VBA macros that let you pass Excel worksheet
values to a deployed MATLAB program without writing or editing VBA code.
It lets you prototype in Excel, debug your MATLAB source code, build the
add-in, and load and test it in the worksheet.

Key Features

® Royalty-free distribution of Excel add-ins to computers that do not have
MATLAB installed

® Automatic conversion between Excel and MATLAB data types

® One-click VBA macro creation for interacting with a MATLAB application
from within Excel

e Ability to prototype in Excel and debug source code in MATLAB
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MATLAB® Application Deployment Products

MATLAB Application Deployment Products

MATLAB Suite of Application Deployment Products

The following table and figure summarizes the target applications supported
by each product.

Product Target Standalone| Function | Graphical | Web Apps | WebFigures
ApplicationslLibraries | Apps

MATLAB Standalone | Yes Yes Yes No No
Compiler applications

and C and

C++ shared

libraries
MATLAB C# NET No Yes Yes Yes Yes
Builder NE | components

Visual

Basic COM

components
MATLAB Java® No Yes Yes Yes Yes
Builder JA | components
MATLAB Microsoft No Yes Yes No No
Builder EX | Excel

add-ins
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MATLAB Compiler

MATLAB MATLAB MATLAB
Builder EX Builder JA Builder NE

Y Y
Excel

MATLAB® Application Deployment Products

As this figure illustrates, each of the builder products uses the MATLAB
Compiler core code to create deployable components.



How MATLAB® Builder™ EX Works

How MATLAB Builder EX Works

The builder converts MATLAB functions to methods of a class that you define.
From this class, the builder creates Excel add-ins (an .x1a file, in addition to
a .bas file).

MATLAB Builder EX components are Microsoft® COM objects that are
accessible from Microsoft Excel through Visual Basic® for Applications
(VBA). MATLAB Builder EX integrates the COM wrapper with the MATLAB
Compiler-generated VBA code, saving you considerable development
resources and time.

COM is an acronym for Component Object Model, which is a Microsoft
binary standard for object interoperability. COM components use a common
integration architecture that provides a consistent model across multiple
applications. All Microsoft Office applications support COM add-ins.

Each COM object exposes a class to the Visual Basic programming
environment. The class contains a set of functions called methods. These
methods correspond to the original MATLAB functions included in the project.
The COM components created by MATLAB Builder EX contain a single class.
This class provides the interface to the MATLAB functions that you add to the
class at build time. The COM component provides a set of methods that wrap
the MATLAB code and a DLL file.

When you package and distribute an application that uses your component,
include supporting files generated by MATLAB Builder EX. Include the
MATLAB Compiler Runtime (MCR), which gives you access to an entire
library of MATLAB functions within one file.

For information about how MATLAB® Compiler works, see “How Does
MATLAB® Compiler™ Software Build My Application?” on page 5-2.

1-5



1 Getting Started

MATLAB Builder EX Prerequisites

In this section...

“Your Role in the Deployment Process” on page 1-6

“Products, Compilers, and IDE Installation” on page 1-7

“Macro Execution Security Levels in Microsoft® Excel®” on page 1-8
“Deployment Target Architectures and Compatibility” on page 1-8

“Dependency and Non-Compilable Code Considerations” on page 1-9

“For More Information” on page 1-9

Your Role in the Deployment Process

The table Application Deployment Roles, Goals, and Tasks on page 1-6
describes the different roles, or jobs, that MATLAB Builder EX users typically
perform. It also describes tasks they would most likely perform when running
the examples in this documentation.

You may occupy one or more of the following roles.

Application Deployment Roles, Goals, and Tasks

Role Knowledge Base Responsibilities

MATLAB programmer | ® Understand the e Build a Microsoft
end-user business Excel add-in with
requirements and MATLAB tools.

the mathematical

[ )
models that support ez i

component for

e distribution to
* MATLAB expert customers.
® No IT experience ® Pass the package

to the Microsoft
Excel developer for
further integration
into the end-user
environment.
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Application Deployment Roles, Goals, and Tasks (Continued)

Microsoft Excel
developer

Little or no MATLAB
experience.

Microsoft Excel
expert.

Proficient writing
VB/VBA code..

Roll out the packaged
component and
integrate it into

the end-user
environment.

Write VB/VBA code
to complement

or augment the
Excel Add-in built
by the MATLAB
programmer. Add
and modify code as
needed.

Uses Function
Wizard to customize
the add-in and create
executable macros.

Verify that the
final application
executes reliably
in the end-user
environment.

Products, Compilers, and IDE Installation

Install the following products to run the example described in this chapter:

e MATLAB

e MATLAB Compiler
e MATLAB Builder EX

e A supported C or C++ compiler

1-7
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Macro Execution Security Levels in Microsoft Excel

If you will be creating macros and generating add-ins with MATLAB Builder
EX, adjust the security settings accordingly in Microsoft Excel.

Failure to do so may result in add-ins not being generated or warning
messages sent to MATLAB Compiler

Depending on what version of Microsoft Office you are using, do one of the
following:
¢ For Microsoft Office 2003:

1 Click
Tools > Macro > Security.

2 For Security Level, select Medium.
¢ For Microsoft Office 2007:
1 Click the 2007 Office ribbon button.

2 Click Excel Options > Trust Center > Trust Center Settings >
Macro Settings.

3 In Developer Macro Settings, select Trust access to the VBA
project object model.

e For Microsoft Office 2010:

1 Click File > Options > Trust Center > Trust Center Settings >
Macro Settings.

2 In Developer Macro Settings, select Trust access to the VBA
project object model.

Deployment Target Architectures and Compatibility

Before you deploy a component with MATLAB Builder EX, consider if your
target machines are 32-bit or 64-bit.

Applications developed on one architecture must be compatible with the
architecture on the system where they are deployed.

For example, if you have a 64-bit system, you usually install a 64-bit version
of MATLAB (and most other applications), by default. Running functions you
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have developed with a 64-bit version of MATLAB requires a Function Wizard
installed with a 64-bit version of Microsoft Excel.

Migration Considerations for 32-bit and 64-bit Microsoft Excel

Add-ins created with MATLAB Builder are not compatible with versions of
Microsoft Excel that do not share the same bitness:

¢ Add-ins created with 64-bit versions MATLAB Builder EX are only
compatible with 64-bit versions of Microsoft Excel.

¢ Add-ins created with 32-bit versions MATLAB Builder EX are only
compatible with 32-bit versions of Microsoft Excel.

Dependency and Non-Compilable Code
Considerations

Before you deploy your code, examine the code for dependencies on functions
that may not be compatible with MATLAB Compiler.

For more detailed information about dependency analysis (depfun) and how
MATLAB Compiler evaluates MATLAB code prior to compilation, see “Write
Deployable MATLAB Code” in the MATLAB Compiler documentation.

For More Information

If you... See...

Want to verify your MATLAB code or | “Write Deployable MATLAB Code”
function can be deployed successfully

Know your function is deployable “Choosing Function Deployment
and want to select a Getting Started | Workflow” on page 1-10
workflow

1-9
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Choosing Function Deployment Workflow

In this section...

“Other Examples” on page 1-10

“Is Your Function Ready for Deployment?” on page 1-10

Is Your Function Ready for Deployment?

If These Statements are True...

See...

¢ [ have a MATLAB function
that conforms to guidelines in
“Write Deployable MATLAB
Code”.

® [ want to create a Microsoft
Excel compatible add-in from
my existing MATLAB function.

® | have tested and debugged
my MATLAB function with
MATLAB.

“Create a Microsoft® Excel® Add-In and
COM Component from MATLAB Code”
on page 1-12 to build your add-in

and

“Integrate an Add-In and COM
Component with Microsoft® Excel®” on
page 1-18 to execute the newly built
add-in and create macros and associated
GUIs with the Function Wizard and
Microsoft Excel.

¢ | have not yet developed
a MATLAB function for
deployment as an add-in or I
am in the process of developing
it.

¢ | have not tested my MATLAB
function thoroughly with
MATLAB.

“End-to-End Deployment of a MATLAB
Function Using the Function Wizard”
on page 4-24 for an end-to-end example
of creating, debugging, building, and
packaging MATLAB function from
scratch using the Function Wizard.

Other Examples

For other types of examples, see the following:

e “Execute a Graphical Function” on page 6-11

e “Create Dialog Box and Error Message Macros” on page 6-15

1-10
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e “Work with Variable-Length Inputs and Outputs” on page 6-5

e MATLAB Central. Set the Search field to File Exchange and search for
one or more of the following:

= InterpExcelDemo
= MatrixMathExcelDemo

= ExcelCurveFit

1-11
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Create a Microsoft Excel Add-In and COM Component
from MATLAB Code

This example shows how to create aMicrosoft Excel add-in. The example
wraps a MATLAB function, mymagic, which computes a magic square. (A
magic square is simply a square array of integers arranged so that their sum
1s the same when added vertically, horizontally, or diagonally.) You can use
this example as a template for deploying functions with no output, scalar
output, or multidimensional matrix output. For information about how to
use the add-in after it has been built, see “Integrate an Add-In and COM
Component with Microsoft® Excel®” on page 1-18.

This example uses the Library Compiler app. For an example using the mcc
command, see the mcc reference page.

Create an Excel Add-in in MATLAB

This example shows how to create an Excel Add-in using a MATLAB function.
You can then hand the generated add-in off to an Excel developer who is
responsible for integrating it into an application.

To create an Excel add-in:

1 In MATLAB, examine the MATLAB code that want to deploy as a shared
library.

a Create the function that you want to deploy.

Note MATLAB Builder EX includes this example code, called mymagic.m,
in the matlabroot\toolbox\matlabxl\examples\xlmagic folder, where
matlabroot represents the name of your MATLAB installation folder.

function y = mymagic(x)

%MYMAGIC Magic square of size X.

Y = MYMAGIC(X) returns a magic square of size x.
This file is used as an example for the MATLAB
Builder EX product.

o® o

o°
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% Copyright 2001-2007 The MathWorks, Inc.
y = magic(x)

b Run the example in MATLAB to make sure it runs.
mymagic(5)

17 24 1 8 15
23 5 7 14 16
4 6 13 20 22
10 12 19 21 3
11 18 25 2 9

2 Open the Library Compiler app.
a On the toolstrip, select the Apps tab.

b Click the arrow at the far right of the tab to open the apps gallery.
¢ Click Library Compiler.

Note You can also call the libraryCompiler command.

1-13
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' ™y
4\ MATLAB Compiler - UntitledL.prj E=E
DEPLOYMENT .
'ﬂj W I Budecsediucas lil Runtime downloaded from web |MyApplnstaller_web |5 MB @ i
New Save =l NET Assembly -~ [ Runtime i in MyApplnstaller_mcr (410 Mg Seffings  Package
> ) cic FORA i + |
FILE AFFLICATION TYFE EXFORTED FUNCTIONS MAIN FILE SETTINGS | PACKAGE

Application Information

. Library Name 10

Author Name

Email Select custom splash screen
Company

m

Set as default contact

Summary

Description

Namespace

Class Name Method Name

© Classl

b Additional Installer Options

3 In the Application Type section of the toolstrip, select Excel Add-in from
the list.

Note If the Application Type section of the toolstrip is collapsed, you can
expand it by clicking the down arrow.

4 Specify the MATLAB functions you want to deploy.
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Create a Microsoft® Excel® Add-In and COM Component from MATLAB® Code

a In the Exported Functions section of the toolstrip, click the plus button.

Note If the Exported Functions section of the toolstrip is collapsed, you
can expand it by clicking the down arrow.

b In the file explorer that opens, locate and select the mymagic.m file.

mymagic.m is located in
matlabroot\toolbox\matlabxl\examples\xlmagic

¢ Click Open to select the file and close the file explorer.

The Library Compiler adds the file you select (mymagic.m) to the list

of files and a minus button appears under the plus button. The Library
Compiler uses the name of the file as the name of the deployment project
file (.prj), shown in the title bar, and as the name of the add-in, shown in
the first field of the Application Information area. The project file saves
all of the deployment settings so that you can re-open the project. The
compiler uses the add-in name as the name of the component output,
shown in the Application Information area, and as the name of the method
in the class it creates.

5 In the Packaging Options section of the toolstrip, verify that the Runtime
downloaded from web check box is selected.

Note If the Packaging Options section of the toolstrip is collapsed, you can
expand it by clicking the down arrow.

This option creates an application installer that automatically downloads the
MATLAB Compiler Runtime (MCR) and installs it along with the deployed
add-in.

6 Explore the main body of the MATLAB Compiler project window.

The project window is divided into the following areas:
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¢ Application Information — Editable information about the deployed
application. This information is used by the generated installer to populate
the installed application’s metadata.

¢ Additional Installer Options — The default installation path for the
generated installer.

¢ Files required for your application — Additional files required by
the generated application. These files will be included in the generated
application installer.

¢ Files installed with your application — Files that are installed with
your application. These files include a Visual Basic file, a DLL, an Excel
Add-in file, and a read me text file.

¢ Additional Runtime Settings — Access to other compiler options.
Click Package.
The Package window opens while the library is being generated.

The packaging process generates a self-extracting file that automatically
registers the DLL and unpacks all deployable deliverables. MATLAB Builder
EX first attempts to register the component to all users on the machine. This
generally requires administrator privileges, however. If it cannot do this, it
defaults to attempting to register under the current user name.

Select the Open output folder when process completes check box.

When the deployment process is complete, a file explorer opens and displays
the generated output.

It should contain:

e for_redistribution — A folder containing the installer to distribute the
library

e for_testing — A folder containing the raw files generated by the compiler

e for_redistribution_files only — A folder containing only the files
needed to redistribute the library

® PackaginglLog.txt — A log file generated by the compiler
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9 Click Close on the Package window.
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In this section...

“Files Necessary for Deployment” on page 1-18

“Add-in and COM Component Registration” on page 1-19

“COM Component Incorporation into Microsoft Excel using the Function

Wizard” on page 1-20

“Distributing MATLAB Code Using the MATLAB Compiler Runtime

(MCR)” on page 8-2

“Add-in Installation and Distribution” on page 1-22

Key Tasks for the Microsoft Excel End User

Task

Reference

Verify that you have received all
necessary files from the MATLAB
programmer.

“Files Necessary for Deployment” on
page 1-18

Verify registry permissions for
the add-in file and associated
component.

“Add-in and COM Component
Registration” on page 1-19

Execute your generated functions
and create macros.

“Executing Functions and Creating
Macros Using the Function Wizard”
on page 4-2

Install the MATLAB Compiler
Runtime on target systems and
update system paths.

“Distributing MATLAB Code Using
the MATLAB Compiler Runtime
(MCR)” on page 8-2

Use the Excel add-in.

“Add-in Installation and
Distribution” on page 1-22

Files Necessary for Deployment
Before beginning, verify that you have access to the following files:
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The MCR Installer. For locations of all MCR Installers, run the
mcrinstaller command.

.x1a file (the add-in)
.bas file (the generated VBA code)

.d11 file

readme.txt

Add-in and COM Component Registration

When you create your COM component, it is registered in either
HKEY_LOCAL_MACHINE or HKEY_ CURRENT_USER, based on your log-in privileges.

If you find you need to change your run-time permissions due to security
standards imposed by Microsoft or your installation, you can do one of the
following before deploying your COM component or add-in:

® Logon as administrator before running your COM component or add-in
¢ Run the following mwregsvr command prior to running your COM

component or add-in, as follows:

mwregsvr [/u] [/s] [/useronly] project _name.dll

where:

= /u allows any user to unregister a COM component or add-in for this
server

= /s runs this command silently, generating no messages. This is helpful
for use in silent installations.

= /useronly allows only the currently logged-in user to run the COM
component or add-in on this server
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Caution If your COM component is registered in the USER hive, it will not be
visible to Windows Vista™ or Windows® 7 users running as administrator
on systems with UAC (User Access Control) enabled.

If you register a component to the USER hive under Windows 7 or Windows
Vista, your COM component may fail to load when running with elevated

(administrator) privileges.

If this occurs, do the following to re-register the component to the LOCAL
MACHINE hive:

1 Unregister the component with this command:
mwregsvr /u /useronly my dl11.dll

2 Reregister the component to the LOCAL MACHINE hive with this command:

mwregsvr my dl11.dll

COM Component Incorporation into Microsoft Excel
using the Function Wizard

Now that your add-in and COM component have been created, use the
Function Wizard to integrate the COM component into Microsoft Excel.

See “Executing Functions and Creating Macros Using the Function Wizard”
on page 4-2 for a complete example of how to execute functions and create
macros using the Magic Square example in this chapter.

Distributing MATLAB Code Using the MATLAB
Compiler Runtime (MCR)

On target computers without MATLAB, install the MCR, if it is not already
present on the deployment machine.
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Install MATLAB Compiler Runtime (MCR)

The MATLAB Compiler Runtime (MCR) is an execution engine made up of
the same shared libraries MATLAB uses to enable execution of MATLAB files
on systems without an installed version of MATLAB.

The MATLAB Compiler Runtime (MCR) is now available for downloading
from the Web to simplify the distribution of your applications or components
created with the MATLAB Compiler. Download the MCR from the MATLAB

Compiler Runtime product page.
The MCR installer does the following:

1 Installs the MCR (if not already installed on the target machine)

2 Installs the component assembly in the folder from which the installer is
run

3 Copies the MWArray assembly to the Global Assembly Cache (GAC), as
part of installing the MCR

MCR Prerequisites

1 Since installing the MCR requires write access to the system registry,
ensure you have administrator privileges to run the MCR Installer.

2 The version of the MCR that runs your application on the target computer
must be compatible with the version of MATLAB Compiler that built the

component.
3 Do not install the MCR in MATLAB installation directories.

4 The MCR installer requires approximately 2 GB of disk space.

Add the MCR Installer to the Installer

This example shows how to include the MCR in the generated installer, using
one of the compiler apps. The generated installer contains all files needed

to run the standalone application or shared library built with MATLAB
Compiler and properly lays they out on a target system.
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1 On the Packaging Options section of the compiler interface, select one or
both of the following options:

® Runtime downloaded from web — This option builds an installer
that invokes the MCR installer from the MathWorks Web site.

* Runtime included in package — The option includes the MCR
installer into the generated installer.

2 Click Package.

3 Distribute the installer as needed.

Install the MCR
This example shows how to install the MATLAB Compiler Runtime (MCR)
on a system.

If you are given an installer containing the compiled artifacts, then the MCR
is installed along with the application or shared library. If you are given
just the raw binary files, download the MCR installer from the Web and run
the installer.

Note If you are running on a platform other than Windows, set the system
paths on the target machine. Setting the paths enables your application to
find the MCR.

Windows paths are set automatically. On Linux and Mac, you can use the
run script to set paths. See “Using MATLAB Compiler on Mac or Linux®” for
detailed information on performing all deployment tasks specifically with
UNIX variants such as Linux and Mac.

Add-in Installation and Distribution

Since Microsoft Excel add-ins are written directly to the distrib folder by
MATLAB Builder EX, you and your end users install them exactly as you
installed the Function Wizard in “Installation of the Function Wizard” on
page 4-29.
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Calling Add-in Code from the Excel Spreadsheet

To run the executable code from a cell in the Excel spreadsheet, invoke the
add-in name with a method call. For example, if you deployed a piece of
MATLAB code called mymagic.m, or a figure called mymagic.fig, you invoke
that code by entering the following in a cell in the spreadsheet:

=mymagic ()

Tip If the method call does not evaluate immediately, press Ctrl, Shift,
and Enter simultaneously.
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Next Steps

MATLAB Builder EX includes several examples, in addition to the
magic square example. You can find these examples in folders in
matlabroot\toolbox\matlabxl\examples\. The following table identifies

examples by folder:

For Example Files
Relating To...

Find Example Code
in Folder...

For Example
Documentation See...

Magic Square Example

xlmagic

“Create a Microsoft®
Excel® Add-In and
COM Component from
MATLAB Code” on
page 1-12

“Integrate an Add-In
and COM Component
with Microsoft® Excel®”
on page 1-18

Variable-Length
Argument Example

xImulti

“Work with
Variable-Length Inputs
and Outputs” on page
6-5

Calling Compiled
MATLAB Functions
from Microsoft Excel

x1lbasic

“Calling Compiled
MATLAB Functions
from Microsoft® Excel®”
on page 8-5

Spectral Analysis
Example

xlspectral

“Build and Integrate
with Spectral Analysis”
on page 7-18

The following topics detail some of the more common tasks you perform as
you continue to develop your applications.



Next Steps

To:

See:

Try more examples using MATLAB
Builder EX

MATLAB Central. Set the Search
field to File Exchange and search
for one or more of the following:

® InterpExcelDemo

® MatrixMathExcelDemo

® ExcelCurveFit

Learn how to write MATLAB code
that is optimized for deployability

“Write Deployable MATLAB Code”

Work with functions having
graphical output

“Execute a Graphical Function” on
page 6-11

Work with functions having variable
inputs and output

“Work with Variable-Length Inputs
and Outputs” on page 6-5

Create displayable dialog boxes and
error messages

“Create Dialog Box and Error
Message Macros” on page 6-15

Troubleshoot common error
messages

Appendix B, “Troubleshooting”

Integrate your application into
your enterprise environment
by enhancing your application’s
generated Visual Basic code

“Code Your Microsoft® Visual Basic®
Application” on page 7-3
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Customizing a Compiler
Project

® “Customize the Installer” on page 2-2

e “Manage Required Files in a Compiler Project” on page 2-6
e “Specify Files to Install with the Application” on page 2-8
e “Manage Support Packages” on page 2-9
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Customize the Installer

In this section...

“Change the Application Icon” on page 2-2
“Add Application Information” on page 2-3
“Change the Splash Screen” on page 2-4
“Change the Installation Path” on page 2-4
“Change the Logo” on page 2-5

“Edit the Installation Notes” on page 2-5

Change the Application Icon

The application icon is used for the generated installer. For standalone
applications, it is also the application’s icon.

You can change the default icon in Application Information. To set a
custom icon:

Click the graphic to the left of the Application name field.

A window previewing the icon opens.

rd

48x448 3232 16x16
|

lcan dl_.plag,-'ed in apps gaIIE|}f|

Selecticon

[ Use mask [ Use border

’ Save and Use




Customize the Installer

Click Select icon.

Using the file explorer, locate the graphic file to use as the application icon.

Select the graphic file.

Click OK to return to the icon preview.

Select Use mask to fill any blank spaces around the icon with white.

Select Use border to add a border around the icon.

Click Save and Use to return to the main compiler window.

Add Application Information

The Application Information section of the compiler app allows you to
provide these values:

Name

Determines the name of the installed MATLAB components. For example,
if the name 1s foo, the installed executable would be foo.exe, the Windows
start menu entry would be foo. The folder created for the application
would be InstallRoot/foo.

The default value is the name of the first function listed in the Main
File(s) field of the compiler.

Version

The default value is 1.0.
Author name

Support e-mail address
Company name

Determines the full installation path for the installed MATLAB
components. For example, if the company name is bar, the full installation
path would be InstallRoot/bar/ApplicationName.

Summary

Description
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This information is all optional and, unless otherwise stated, is only used for
display purposes. It appears on the first page of the installer. On Windows
systems, this information is also displayed in the Windows Add/Remove
Programs control panel.

Change the Splash Screen

The installer’s splash screen displays after the installer is started. It is
displayed, along with a status bar, while the installer initializes.

You can change the default image by clicking the Select custom splash
screen link in Application Information. When the file explorer opens,
locate and select a new image.

Note You can drag and drop a custom image onto the default splash screen.

Change the Installation Path

Default Installation Paths on page 2-4 lists the default path the installer will
use when installing the compiled binaries onto a target system.

Default Installation Paths

Windows C:\Program
Files\companyName\appName

Mac OS X /Applications/companyName [ appName

Linux /usr/companyName [ appName

You can change the default installation path by editing the Default
installation folder field under Additional Installer Options.

The Default installation folder field has two parts:
¢ root folder — A drop down list that offers options for where the install

folder is installed. Custom Installation Roots on page 2-5 lists the optional
root folders for each platform.
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Custom Installation Roots

Windows C:\Users\userName\AppData

Linux /usr/local

¢ install folder — A text field specifying the path appended to the root folder.

Change the Logo

The logo displays after the installer is started. It is displayed on the right
side of the installer.

You change the default image by clicking the Select custom logo link in
Additional Installer Options. When the file explorer opens, locate and
select a new image.

Note You can drag and drop a custom image onto the default logo.

Edit the Installation Notes

Installation notes are displayed once the installer has successfully installed
the packaged files on the target system. They can provide useful information
concerning any additional set up that is required to use the installed binaries
or simply provide instructions for how to run the application.

The field for editing the installation notes is in Additional Installer
Options.
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Manage Required Files in a Compiler Project

In this section...

“Dependency Analysis” on page 2-6
“Using the Compiler Apps” on page 2-6

“Using mcc” on page 2-7

Dependency Analysis

The compiler uses a dependency analysis function to automatically determine
what additional MATLAB files are required for the application to compile and
run. These files are automatically compiled into the generated binary. The
compiler does not generate any wrapper code allowing direct access to the
functions defined by the required files.

Using the Compiler Apps

If you are using one of the compiler apps, the required files discovered by
the dependency analysis function are listed in the Files required by your
application to run field.

To add files:

Click the plus button in the field.

Select the desired file from the file explorer.
Click OK.

To remove files:

Select the desired file.

Press the Delete key.

Caution Removing files from the list of required files may cause your
application to not compile or to not run properly when deployed.
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Using mcc

If you are using mcc to compile your MATLAB code, the compiler does not
display a list of required files before running. Instead, it compiles all of the
required files that are discovered by the dependency analysis function and
adds them to the generated binary file.

You can add files to the list by passing one, or more, -a arguments to mcc.
The -a arguments add the specified files to the list of files to be added into the
generated binary. For example, -a hello.m adds the file hello.m to the list
of required files and -a ./foo adds all of the files in foo, and its subfolders,
to the list of required files.
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Specify Files to Install with the Application

The compiler apps package files to install along with the ones it generates. By
default the installer includes a readme file with instructions on installing the
MATLAB Compiler Runtine(MCR) and configuring it.

These files are listed in the Files installed with your application section
of the app.

to add files to the list:
1 Click the plus button in the field.
2 Select the desired file from the file explorer.
3 Click OK to close the file explorer.
To remove files from the list:
1 Select the desired file.

2 Press the Delete key.

Caution Removing the binary targets from the list results in an installer
that does not install the intended functionality.

When installed on a target computer, the files listed in the Files installed
with your application are placed in the application folder.
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Manage Support Packages

Many MATLAB toolboxes use support packages to interact with hardware
or to provide additional processing capabilities. If your MATLAB code uses

a toolbox with an installed support package, MATLAB Compiler displays a
Suggested Support Packages section.

Suggested Support Packages

Package Product
Digilent Analog Discovery
DirectSound Audio

Data Acquisition Toolbox

Data Acquisition Toolbox

w Additional Installer Options

Default installation folder: | %ProgramFiles% ~ \DAQAudioTest\

* This program requires:
-- Digilent WaveForms from =a href="http://www.digilentinc.com" > http://www.digilentinc.com < /a=> available at <a

href="http:/www.digilentinc.com,/Data/Products WAVEFORMS/digilent.waveforms_v2.4 4.exe" > http:/fwww.digilentine.ce
ts WAVEFORMS/digilentowaveforms_v2.4.4. exe</a=

The list displays all installed support packages that your MATLAB code
requires. The list is determined using these criteria:

¢ the support package is installed
¢ your code has a direct dependency on the support package

® your code is dependent on the base product of the support package
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® your code is dependent on at least one of the files listed as a dependency
in the mcc.xml file of the support package, and the base product of the
support package is MATLAB

Deselect support packages that are not required by your application.

Some support packages require third-party drivers that MATLAB Compiler
cannot package. In this case, the compiler adds the information to the
installation notes. You can edit installation notes in the Additional Installer
Options section of the app. To remove the installation note text, deselect the
support package with the third-party dependency.

Caution Any text you enter beneath the generated text will be lost if you
deselect the support package.




Integrating with MATLAB
Production Server

¢ “Build Deployable Archive and Add-In” on page 3-2

¢ “Install the Deployable Archive” on page 3-7

e “Install the Excel Add-In” on page 3-8

e “Data Marshaling Rules” on page 3-11

e “Change the Server Configuration” on page 3-14

e “XLA File Not Generated” on page 3-16

e “Server Configuration Add-in Not Enabled” on page 3-17

® “Error in myfunc: Object reference not set to an instance of an object” on
page 3-18
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Build Deployable Archive and Add-In

To create an Excel add-In that integrates with MATLAB Production Server™:

1 Open the Production Server Compiler.
a On the toolstrip, select the Apps tab.
b Click the arrow at the far right of the tab to open the apps gallery.

¢ Click Production Server Compiler to open the project window.
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2 In the Application Type section of the toolstrip, select Deployable Archive
with Excel Integration from the list.

3 Specify the MATLAB functions you want to deploy.
a In the Exported Functions section of the toolstrip, click the plus button.
b In the file explorer that opens, locate and select the desired files.

¢ Click Open to select the files and close the file explorer.
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The selected files are added to the list of files and a minus button appears
under the plus button.

Note Functions that return a variable number of outputs are not
supported by add-ins that use code running on a MATLAB Production
Server instance.

Inspect the Archive Information section of the app.

The first text field is the name of the archive. The name of the archive
determines the names of the generated artifacts and the URL used to connect
to the server.

Inspect the class mapping table to ensure that all desired functions are being
compiled.

If you need to change the marshaling rules for a function, select Data
Conversion Properties from the function name’s context menu.

For more information, see “Data Marshaling Rules” on page 3-11.

Optionally configure the default server configuration packaged with the
installer.

The server configuration defines the connection to the MATLAB Production
Server instance running the MATLAB code.

a Search the Default Server Configuration table for the URL to package
with the installer.

b If it is in the table, select it.
¢ If not, click Add to add it to the table.

Inspect the Files required for your archive to run and Files installed
with your archive sections of the app.

These sections of the app list all of the files that are packaged with the
compiled code.
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Files required for your archive to run lists the files on which your
function is dependent. They are packaged into the deployable archive and
are only for the server. See “Manage Required Files in a Compiler Project”

on page 2-6.

Files installed with your archive includes sections for both the client
and the server. The files listed are generated by the compiler and should be
delivered to the person installing the application.

Click Package to generate the add-in and the deployable archive.

L

4\ Package

2]

L=
L=
L=

0 =)

Creating Binaries...

"] Open output folder when process completes |

A

Select the Open output folder when process completes check box to

display the generated output.

When the deployment process is complete, a file explorer opens and displays

the generated output.

Click Close on the Package window.

Verify the contents of the generated output:

e for_redistribution — A client folder containing the generated installer
and a server folder containing a .zip file
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e for_testing — A client folder containing the raw files generated for
the add-in and a server folder containing the raw files generated for the
deployable archive

e for _redistribution files only — A client folder containing only the
files needed to redistribute the add-in and a server folder containing only
the files needed to redistribute the deployable archive

® PackaginglLog.txt — A log file generated by the compiler



Install the Deployable Archive

Install the Deployable Archive
The Production Server Compiler generates a deployable archive containing the
compiled MATLAB code used by the add-in. This archive needs to be deployed
to a MATLAB Production Server instance before the add-in will work.

To install the deployable archive on a server instance:

1 Locate the archive in the for_redistribution files only\server)\ folder.

The file name is similar to archiveName.ctf.

2 Copy the archive file to the auto_deploy folder of the server instance.

For more information, see “MATLAB Production Server” documentation.
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Install the Excel Add-In

In this section...

“Install with the Generated Installer” on page 3-8
“Install with the Raw Files” on page 3-9

Install with the Generated Installer

The Production Server Compiler generates an installer that you use to install
the add-in and configure it to connect to a MATLAB Production Server
instance.

To install the add-in:
1 Locate the installer in the for_redistribution\client folder.

2 Double click the installer to start it.

[ 8l install Excel Add-In =)

This installer will install the Bocel Add-n mymagic

Install location:

C:Msers‘ejohnson' App Data' Roaming "MPS Add-Ins‘mymagic

MATLAB Production Server Corfiguration (optional):

L. ]

nstal | | Cancel |

"

3 In the Install location field, enter the location where the Excel add-in is
installed.




Install the Excel® Add-In

4 Specify the URL of the deployable archive powering the Excel add-in.
a Click Modify.

3 MATLAB Production Server Configuration | = | |ﬂh

Host: Part:

| Save | | Cancel |

e

b In the Host field, enter the host name or the full URL of the machine
running the MATLAB Production Server instance with the deployable
archive.

¢ In the Port field, enter the port number on which the server instance
listens for incoming requests.
The default port number is 9910.

d Click Save.

5 Click Install.

Install with the Raw Files
In the client\for_redistribution_files only you will find the following

files:
® projName.dll— Dynamic library required by the add-in
® projName.bas — VBA module file created for the add-in

® projName.xla — Excel add-in file

Note If projName.xla is not generated, you can still install the add-in
using projName .bas. See “XLA File Not Generated” on page 3-16 for more
information.
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® serverconfig.dll- Excel add-in that manages the server configuration

On the machine running the add-in, you must register the following DLLs
with the regAsm /codebase command:

® mymagic.dll

® serverconfig.dll

If mymagic.xla is generated, install the add-in into Excel. If not, import
mymagic.bas to the workbook’s Visual Basic project.
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Data Marshaling Rules

In this section...

“Default Marshaling Rules” on page 3-11
“Change Rules for Marshaling Data into MATLAB” on page 3-11

“Change Rules for Marshaling Data into Excel” on page 3-12

Default Marshaling Rules

These types of data do not have natural mappings between MATLAB and
Excel:

® Dates: Excel has a special data type for dates, and MATLAB does not.

¢ Blank cells: MATLAB has no equivalent construct for a blank cell in an
Excel spread sheet.

If you do not change the marshaling rules when compiling the add-in, the
rules for marshaling Excel data into MATLAB are:

e Excel dates are marshaled into MATLAB doubles.

¢ Empty cells are marshaled into zeros.

If you do not change the marshaling rules when compiling the add-in, the
rules for marshaling MATLAB data into Excel are:

e MATLAB NaNs are marshaled into zeros.

e MATLAB does not return any Excel dates.

Change Rules for Marshaling Data into MATLAB

You can change how dates and empty cells are marshaled into MATLAB
when compiling the add-in:

® Excel dates can be marshaled as MATLAB strings.
¢ Empty cells can be marshaled as MATLAB NaNs.
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To change the marshaling rules:

1 In the class mapper portion of the MATLAB Compiler project window, select
the signature of the function you want to modify.

2 Select Data Conversion Properties from the context menu.

Input Arguments 7}
[] Replace blanks with Matlab NaM
Convert Excel dates to String

Output Arguments
Replace MATLAB MaM with blanks

Convert numeric outputs to Excel dates

k

3 Select the input argument rules to change.

4 Click outside of the dialog box to close it.

Change Rules for Marshaling Data into Excel

You can change how dates and NaNs are marshaled into Excel when
compiling the add-in:

e MATLAB NaNs can be converted into empty cells.

Note The underlying Visual Basic code receives an Empty from MATLAB.
However, when the empty is passed to Excel, it is converted into a zero.

e MATLAB numeric values can be converted into Excel dates.

Note To see a date in the expected format, ensure that the Excel cell is
formatted to display its contents in a date format.
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To change the marshaling rules:

1 In the class mapper portion of the MATLAB Compiler project window, select
the signature of the function you want to modify.

2 Select Data Conversion Properties from the context menu.

Input Arguments 7}
[] Replace blanks with Matlab NaM
[ Convert Excel dates to String

Output Arguments
[] Replace MATLAB MaM with blanks

[ Convert nurmeric outputs to Excel dates

k A

3 Select the output argument rules to change.

4 Click outside of the dialog to close it.
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3 Integrating with MATLAB® Production Server™
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Change the Server Configuration

Before you can use an add-in uses code running on a MATLAB Production
Server instance, you must configure it to connect to a MATLAB Production
Server instance.

To configure the server information for an add-in:

1 In Excel, select Add-Ins > Configure MATLAB Production Server.

-

MATLAE Preduction Server Configuration Management I&
MATLAB Add-Ins Available MATLAB Production Server Configurations
Add-in Name Active | Server URL
mymagic localhost:3910/mymagic
sdd | Delete | add | Delete |
Ok | Cancel | Apply |

2 Select the add-in to configure.

If the add-in is not listed, click the Add button under the MATLAB Add-ins
Available table. Enter the name of the add-in and click OK.

3 Select the URL of the server hosting the deployable archive implementing
the MATLAB function for the add-in.



Change the Server Configuration

If the server URL is not listed:

Click the Add button under the MATLAB Production Server
Configurations table.

Add Mew MATLAE Server Configuration I&

Host Mame: ||

Part Mumber: |

CTF Archive: |

QK | Cancel

L A

Enter the host name for the server instance in the Host Name field.

Enter the port number on which the server instance listens for requests in the
Port Number field.

The default port number is 9910.
Enter the name of the deployable archive in the CTF Archive field.

The name of the deployable archive is the archive name specified in the
Production Server Compiler.

Click OK.
Click OK.
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3 Integrating with MATLAB® Production Server™

XLA File Not Generated

The compiler may not generate the projName.x1a file for a number of reasons,
including that Excel is not configured to trust access to the VBA project
object model. When this happens, you can install the add-in by importing the
projName .bas file into the workbook’s Visual Basic project.
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Server Configuration Add-in Not Enabled

Server Configuration Add-in Not Enabled

If your trust settings in Excel are configured to either disable all add-ins or
to require add-ins to be published by a trusted publisher, it is possible that
the Configure MATLAB Production Server add-in is not available after
installation. In most cases, the add-in is installed but disabled.

To check if the add-in is installed in Excel:
1 Select File>Options.
2 Select Add-Ins.

3 Look for ServerConfig.Connect in the list of disabled add-ins.

You can enable the add-in by adjusting the trust settings in Excel.
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3 Integrating with MATLAB® Production Server™

Error in myfunc: Object reference not set to an instance
of an object

If your add-in throws the error:

Error in myfunc: Object reference not set to an instance of an object

The likely cause is that the MATLAB function used by the add-in returns a
variable number of outputs.

Add-ins using code run on a MATLAB Production Server instance do not
support MATLAB functions that return a variable number of outputs. You
can either rewrite your MATLAB function to return a fixed number of outputs,
or you can create an add-in that runs locally to your Excel installation.
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The Function Wizard

¢ “Executing Functions and Creating Macros Using the Function Wizard”
on page 4-2

¢ “End-to-End Deployment of a MATLAB Function Using the Function
Wizard” on page 4-24



4 The Function Wizard

Executing Functions and Creating Macros Using the
Function Wizard

In this section...
“What Can the Function Wizard Do for Me?” on page 4-27

“Installation of the Function Wizard” on page 4-29
“Function Wizard Start-Up” on page 4-5

“Workflow Selection for MATLAB Functions Ready for Deployment” on
page 4-7

“Defining Functions Ready to Execute” on page 4-8
“Function Execution” on page 4-19

“Macro Creation” on page 4-19

“Macro Execution” on page 4-52

“Microsoft® Visual Basic® Code Access (Optional Advanced Task)” on page
4-54

“For More Information” on page 4-23

If your MATLAB function is ready to be deployed and you have already built
your add-in and COM component with the Deployment Tool, follow this
workflow to incorporate your built COM component into Microsoft Excel using
the Function Wizard. To follow the workflow in this section effectively, you
must run “Create a Microsoft® Excel® Add-In and COM Component from
MATLAB Code” on page 1-12.

The Function Wizard also allows you to iteratively test, develop, and debug
your MATLAB function. Using this end-to-end workflow assumes you are still
be in the process of developing your MATLAB function for deployment. See
“End-to-End Deployment of a MATLAB Function Using the Function Wizard”
on page 4-24 for complete instructions for this workflow.

See “Choosing Function Deployment Workflow” on page 1-10 for further
details.
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Key Tasks for the End User

Task

Reference

1. Install the Function Wizard.

“Installation of the Function Wizard”
on page 4-29

2. Start the Function Wizard.

“Function Wizard Start-Up” on page
4-5

3. Select the option to incorporate
your built COM component into
Microsoft Excel.

“Workflow Selection for MATLAB
Functions Ready for Deployment” on
page 4-7

4. Define the new MATLAB function
you want to prototype by adding

it to the Function Wizard and
establishing input and output
ranges.

“Defining Functions Ready to
Execute” on page 4-8

5. Test your MATLAB function
by executing it with the Function
Wizard.

“Function Execution” on page 4-19

6. Create a macro.

“Macro Creation” on page 4-19

7. Execute the macro you created
using the Function Wizard.

“Macro Execution” on page 4-52

8. Optionally inspect or modify the
Microsoft Visual Basic code you
generated with the COM component.
Optionally, attach the macro you
created to a GUI button.

“Microsoft® Visual Basic® Code
Access (Optional Advanced Task)”
on page 4-54

What Can the Function Wizard Do for Me?
The Function Wizard enables you to pass Microsoft Excel (Excel 2000 or

later) worksheet values to a compiled MATLAB model and then return model

output to a cell or range of cells in the worksheet.

The Function Wizard provides an intuitive interface to Excel worksheets. You

do not need previous knowledge of Microsoft Visual Basic for Applications

(VBA) programming.
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The Function Wizard reflects any changes that you make in the worksheets,
such as range selections. You also use the Function Wizard to control the
placement and output of data from MATLAB functions to the worksheets.

Note The Function Wizard does not currently support the MATLAB sparse,
and complex data types.

Installation of the Function Wizard

Before you can use the Function Wizard, you must first install it as an add-in
that is accessible from Microsoft Excel.

After you install the Function Wizard, the entry MATLAB Functions
appears as an available Microsoft Excel add-in button.

Using Office 2007

1 Start Microsoft Excel if it is not already running.
0
el /
2 Click the Office Button () and select Excel Options.
3 In the left pane of the Excel Options dialog box, click Add-Ins.

4 In the right pane of the Excel Options dialog box, select Excel Add-ins
from the Manage drop-down box.

5 Click Go.

6 Click Browse. Navigate to
matlabroot\toolbox\matlabxl\matlabxl\arch and select
FunctionWizard2007.xlam. Click OK.

7 In the Excel Add-Ins dialog box, verify that the entry MATLAB Builder
EX Function Wizard is selected. Click OK.



Executing Functions and Creating Macros Using the Function Wizard

Using Office 2010

1 Click the File tab.

2 On the left navigation pane, select Options.

3 In the Excel Options dialog box, on the left navigation pane, select Add-Ins.
4 In the Manage drop-down, select Excel Add-Ins, and click Go.

5 In the Add-Ins dialog box, click Browse.

6 Browse to matlabroot/toolbox/matlabxl/matlabxl/arch, and select
FunctionWizard2007.xlam. Click OK.

7 In the Excel Add-Ins dialog, verify that the entry MATLAB Builder EX
Function Wizard is selected. Click OK.

The Home tab of the Microsoft Office Ribbon should now contain the Function
Wizard tile. See The Home Tab of the Microsoft® Office Ribbon with Function
Wizard Installed on page 4-6.

Using Office 2003

1 Select Tools > Add-Ins from the Excel main menu.

2 If the Function Wizard was previously installed, MATLAB Builder EX
Function Wizard appears in the list. Select the item, and click OK.

If the Function Wizard was not previously installed, click Browse and
navigate to matlabroot\toolbox\matlabxl\matlabxl folder. Select
FunctionWizard.xla. Click OK to proceed.

Function Wizard Start-Up

Start the Function Wizard in one of the following ways. When the wizard has
initialized, the Function Wizard Start Page dialog box displays.
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4 The Function Wizard

Bookl - Microsoft Excel

Using Office 2007 or Office 2010

In Microsoft Excel, on the Microsoft Office ribbon, on the Home tab, select
MATLAB Functions.

[E=RR=E A
o @ o & =
= m| e l-N | Tom T Egill | T AutoSum - Mg a
™ m = = ormal Bad e O ,? :
kél —'3d L[| B8 & @ it - Z i g
i8 3% | Conditional Format | Good Meutral Insert Delete Format | _ Sort & Find & Function
Formatting = as Table = - - - ¢ Clear~ Filter = Select~ Wizard
Styles Cells Editing MATLAE Builder EX

The Home Tab of the Microsoft® Office Ribbon with Function Wizard Installed

Using Office 2003

1 Select Tools > Add-Ins from the Excel main menu.

2 Select Function Wizard.



Executing Functions and Creating Macros Using the Function Wizard

Function Wizard 5tart Page [&J

Welcome to MATLAB Builder EX Function Wizard.

How would you like to use MATLAB Builder EX Function Wizard

" I have one or more MATLAE functions that I want to use in a workbook (MATLAE installation required).

Enter a project to create or open

3 |

< _oonse..|

{* T have an Add-in component that was built in MATLAB with the Deployment Tool that I want to integrate into a workbook

OK | Cancel

The Function Wizard Start Page Dialog Box

Workflow Selection for MATLAB Functions Ready for
Deployment
After you have installed and started the Function Wizard, do the following:

1 From the Function Wizard Start Page, select the option I have an Add-in
component that was built in MATLAB with the Deployment Tool
that I want to integrate into a workbook.

2 Click OK. The Function Wizard Control Panel opens with the Add
Function button enabled..
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4 The Function Wizard

r 2
Function Wizard Control Panel

L

Powered by

MATLAB

— 1. Setup Functions -

— 3. Create Macros

— 4. Execute Functions -

||

Start Over I Close l

== —

The Function Wizard Control Panel for Working with MATLAB Functions Ready for Deployment

4-8

Tip To return to the Function Wizard Start Page, click Start Over.

Defining Functions Ready to Execute

1 Define the function you want to execute to the Function Wizard. Click Add
Function in the Set Up Functions area of the Function Wizard Control
Panel. The MATLAB Components dialog box opens.

2 In the Available Components area of the MATLAB Components dialog box,
select the name of your component (x1lmagic) from the drop-down box.



Executing Functions and Creating Macros Using the Function Wizard

3 Select the function you want to execute (mymagic) from the box labeled
Functions for Class xlmagic.

4 Click Add Function. The Function Properties dialog box opens.

Tip The Function Syntax and Help area, in the Function Properties
dialog box, displays the first help text line (sometimes called the H1 line)
in a MATLAB function. Displaying these comments in the Function
Properties dialog box can be helpful when deploying new or unfamiliar
MATLAB functions to end-users.

5 Define input argument properties as follows.

a On the Input tab, click Set Input Data. The Input Data for n dialog
box opens.



4 The Function Wizard

i

Input Data for n

— Type of Input Argument
% This is a scalar or matrix argument
Set Rangsf\Value for Input Argument 3

© Ronge: | =l

[ Auto recaladlate on change ?

" This is a MATLAB structure array argument ? ]

b Specify a Range or Value by selecting the appropriate option and
entering the value. If the argument refers to a structure array (struct),
select the option This is a MATLAB structure array argument. See
“Working with Struct Arrays” on page 4-42 for information on assigning
ranges and values to fields in a struct array.
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Caution Avoid selecting ranges using arrow keys. If you must use
arrow keys to select ranges, apply the necessary fix from the Microsoft
site: http://support.microsoft.com/kb/291110.

Note Select the Auto Recalculate on Change option to force
Microsoft Excel to automatically recalculate the spreadsheet data each
time it changes.

¢ Click OK.

Tip To specify how MATLAB Builder EX handles blank cells (or cells
containing no data), see “Empty Cell Value Control” on page 4-41.

6 Define output argument properties as follows.

a On the Output tab, click Set Output Data. The Output Data for y
dialog box appears, where y is the name of the output variable you are
defining properties of.
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-

Qutput Data for out ﬁ

Type of Output Argument

{* This is a scalar or matrix argument

Set Range Malue for Output Argument

{*+ Range: J

v Auto Resize [ Transpose | CQutput As date

Treat MATLAB Nal (Not 3 Number) As: | EmPty Cel -

(" This is @ MATLAB structure array argument ?

Done

Tip You can also specify MATLAB Builder EX to Auto Resize,
Transpose or output your data in date format (Output as date). To

do so, select the appropriate option in the Argument Properties for y
dialog box.

b Specify a Range. Alternately, select a range of cells on your Excel sheet;
the range will be entered for you in the Range field.



Executing Functions and Creating Macros Using the Function Wizard

Caution Avoid selecting ranges using arrow keys. If you must use
arrow keys to select ranges, apply the necessary fix from the Microsoft

site: http://support.microsoft.com/kb/291110.

¢ Select Auto Resize if it is not already selected.
d Click Done in the Output Data for y dialog box.

e Click Done in the Function Properties dialog box.

Funchion Wizard Control Pansl

Poswveyed by

MATLAB

— 1. Setup Functions

Active Functions

Add Function |m_

Edit/Set Data |

Maove Up |
Move Diown |
Delete Function |

Deactivate >

Ouschvn > |

4 | i

— 2. Execute Functions

Inactive Functions

— 3. Create Macros

Active functions will be executed in the order specfied above,

Exeaste |

Macros will be created to run the active functions. Go to View
tab ->» Macros to view or run a macro,

Macro Name

Store Macro In

[ ]
Desaription

Create Macro

Start Over | Close |

mymagic now appears in the Active Functions list of the Function Wizard

Control Panel.
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4 The Function Wizard

Empty Cell Value Control
You can specify how MATLAB Builder EX processes empty cells, allowing you
to assign undefined or unrepresented (NaN, for example) data values to them.

To specify how to handle empty cells, do the following.

1 Click Options in the Input Data for N dialog box.

The Input Conversion Options dialog box opens.

-

Input Careersion Options @

Set Conversion Opkions Far inpuk_args
Format Array As: Coerce Mumeric to Type:

{* Makrix " el | Default j
Farmat Dates As: Treat Missing Data As:

{* MNumeric (" Skring | Zero| j

Mak (Mot a Murnber) | |
T I RS | ] |

2 Click the Treat Missing Data As drop-down box.

3 Specify either Zero or NaN (Not a Number), depending on how you want
to handle empty cells.

Working with Struct Arrays

To assign ranges to fields in a struct array, do the following:

1 If you have not already done so, select This is a MATLAB structure
array argument in the Input Data for n dialog box and click OK.
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: = = — ==
Input Data for n -

— Type of Input Argument

% This is a scalar or matrix argument
— Set Rangef\Value for Input Argument

@ oe: | A

[ Auto recaladlate on change ?

" This is a MATLAB structure array argument ll

QK Hel:

The Input Data for Structure Array Argument n dialog box opens.
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4 The Function Wizard

i N
Input Data for Structure Array Argument n ﬁ

Set Fields for Structure Array Argument

Structure Array Organization

There are two WEYS YOU CAN Organize data in & structure array,
Specify how the structure array argument is organized in your
MATLAB function:

(¢ Element by Element Organization 5
" Plane Organization

Delete Field Set Field Data
I This argument is not a MATLAB structure array

Dione | Cancel |

o o

2 The Function Wizard supports Vector and Two-dimensional struct arrays
organized in either Element by Element or Plane organization, for both
input and output.

In the Input Data for Structure Array Argument n dialog box, do the
following:
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a In the Structure Array Organization area, select either Element by
Element Organization or Plane Organization.

b Click Add Field to add fields for each of your struct array arguments.
The Field for Structure Array Argument dialog box opens.

" ™
Field for Structure Array Argument ﬁ
Set Mame and Range for Structure Array Field
The field name you enter here should match with the field name of the
structure array in your MATLAB function, Field names are case sensitive.
Mame: |
Range:;
™ Auto recaloulate on change ﬂ
Options...
oK | Cance
" |

3 In the Field for Argument dialog box, do the following:

a In the Name field, define the field name. The Name you specify must
match the field name of the structure array in your MATLAB function.

b Specify the Range for the field.

Caution Avoid selecting ranges using arrow keys. If you must use
arrow keys to select ranges, apply the necessary fix from the Microsoft
site: http://support.microsoft.com/kb/291110.
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4 The Function Wizard

Field for Structure Array Argument ﬁ

— Set Mame and Range for Structure Array Field

The field name you enter here should match with the field name of the
structure array in your MATLAB function, Field names are case sensitive.

MName: Mame|

Range: | cheet11§A51:5A%6

™ Auto recalculate on change il

Options. ..
— MATLAB representation of your selection
1, 1).Name=Sheat1$451
n{2, 1).Name=5heet1! $452
n{3, 1).Name=Sheet1!5A53
oK Cancel

¢ Click Done.

How Structure Arrays are Supported. MATLAB Builder EX supports one
and two-dimensional MATLAB structure arrays.

The product converts data passed into structure arrays in element-by-element
organization or plane organization. See MATLAB Programming
Fundamentals for more information about all MATLAB data types, including

structures.
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Deploying Structure Arrays as Inputs and Outputs. If you are a
MATLAB programmer and want to deploy a MATLAB function with structure
arrays as input or output arguments, build Microsoft Excel macros using the
Function Wizard and pass them (with the Excel Add-In and COM component)
to the end users. If you can’t do this, let your end users know:

® Which arguments are structure arrays

¢ Field names of the structure arrays

Using Macros with Struct Arrays. The macro generation feature of
MATLAB Builder EX works with struct arrays as input or output arguments.
See “Macro Creation” on page 4-19 if you have a MATLAB function you are
ready to deploy. See “Microsoft® Excel® Add-in and Macro Creation Using the
Function Wizard” on page 4-50 if you are using the Function Wizard to create
your MATLAB function from scratch. See “Choosing Function Deployment
Workflow” on page 1-10 for more information on both workflows.

Function Execution

In the Execute Functions area of the Function Wizard Control Panel, click
Execute to run mymagic. Cells A1:E5 on the Excel sheet are automatically
populated with the output of mymagic (a magic square of dimension 5).

T — C D E
17 24 1 8 15
23 5 7 14 16
3 6 13 20 22
10 12| 19.| 21
11 18 25 2

Macro Creation

Continuing the example, create a Microsoft Excel macro using the Function
Wizard Control Panel:

1 In the Create Macros area of the control panel, enter mymagic in the
Macro Name field.
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2 Select the location of where to store the macro in the Store Macro
drop-down box.

3 Enter a brief description of the macro’s functionality in the Description
field.

4 Click Create Macro.

A macro is created in the current Excel workbook.

Macro Execution

Run the macro you created in “Macro Creation” on page 4-19 by doing one of
the following, after first clearing cells A1:E5 (which contain the output of the
Magic Square function you ran in “Function Execution” on page 4-19).

Tip You may need to enable the proper security settings before running
macros in Microsoft Excel. For information about macro permissions and
error messages occuring from executing macros, see the Appendix B,
“Troubleshooting” appendix.

Using Office 2007 or Office 2010

1 In Microsoft Excel, click View > Macros > View Macros.
2 Select mymagic from the Macro name drop-down box.

3 Click Run. Cells A1:E5 on the Excel sheet are automatically populated
with the output of mymagic.

Using Office 2003

1 In Microsoft Excel, click Tools > Macro > Macros.
2 Select mymagic from the Macro name drop-down box.

3 Click Run. Cells A1:E5 on the Excel sheet are automatically populated
with the output of mymagic.
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Watch a Video

Watch a video that demonstrates how to execute deployed functions with the
Function Wizard and Microsoft Excel.

Microsoft Visual Basic Code Access (Optional
Advanced Task)

Optionally, you may want to access the Visual Basic code or modify it,
depending on your programming expertise or the availability of an Excel
developer. If so, follow these steps.

From the Excel main window, open the Microsoft Visual Basic editor by doing
one of the following. select Tools > Macro > Visual Basic Editor.

Using Office 2007 or Office 2010

1 Click Developer > Visual Basic.

2 When the Visual Basic Editor opens, in the Project - VBAProject window,
double-click to expand VBAProject (mymagic.xls).

3 Expand the Modules folder and double-click the Matlab Macros module.

This opens the VB Code window with the code for this project.

Using Office 2003

1 Click Tools > Macro > Visual Basic Editor.

2 When the Visual Basic Editor opens, in the Project - VBAProject window,
double-click to expand VBAProject (mymagic.xls).

3 Expand the Modules folder and double-click the Matlab Macros module.

This opens the VB Code window with the code for this project.

Mapping a Macro to a GUI Button or Control (Optional)
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To attach the macro to a GUI button, do the following:

1 Click Developer > Insert.

2 From the Form Controls menu, select the Button (Form Control) icon.

Tip Hover your mouse over the Form Controls menu to see the various
control labels.

3 In the Assign Macros dialog box, select the macro you want to assign the
GUI button to, and click OK.
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For More Information

If you want to...

See...

e Perform basic MATLAB
Programmer tasks

¢ Understand how the deployment
products process your MATLAB
functions

¢ Understand how the deployment
products work together

e Explore guidelines about writing
deployable MATLAB code

“Write Deployable MATLAB Code”
on page 5-10

See more examples about building
add-ins and COM components

“Add-in and Macro Creation from
MATLAB Functions ” on page 6-5

Learn how to customize and
integrate the COM component you
built by modifying the Microsoft
Visual Basic code

“Code Your Microsoft® Visual Basic®
Application” on page 7-3
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End-to-End Deployment of a MATLAB Function Using the
Function Wizard

In this section...

“What Can the Function Wizard Do for Me?” on page 4-27
“Example File Copying” on page 4-28

“mymagic Testing” on page 4-28

“Installation of the Function Wizard” on page 4-29
“Function Wizard Start-Up” on page 4-30

“Workflow Selection for Prototyping and Debugging MATLAB Functions”
on page 4-32

“New MATLAB Function Definition” on page 4-35
“MATLAB Function Prototyping and Debugging” on page 4-47
“Function Execution from MATLAB” on page 4-49

“Microsoft® Excel® Add-in and Macro Creation Using the Function Wizard”
on page 4-50

“Function Execution from the Deployed Component” on page 4-52
“Macro Execution” on page 4-52

“Microsoft® Excel® Add-in and Macro Packaging using the Function Wizard”
on page 4-53

“Microsoft® Visual Basic® Code Access (Optional Advanced Task)” on page
4-54

“For More Information” on page 4-56
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MATLAB Programmer

Role Knowledge Base Responsibilities
o MATLAB expert ® Develops models; implements in
MATLAB

e No IT experience
MATLAB e No access to IT svsterms e Uses tools to create a component that
programmer Y 1s used by the COM developer

If you are still in the process of developing a MATLAB function that is not
yet ready to be deployed, you may find this example to be an appropriate
introduction to using MATLAB Builder EX.

The Function Wizard allows you to iteratively test, develop, and debug your
MATLAB function. It does this by invoking MATLAB from the Function
Wizard Control Panel.

Developing your function in an interactive environment ensures that it works
in an expected manner, prior to deployment to larger-scale applications.
Usually, these applications are programmed by the Excel Developer using an
enterprise language like Microsoft Visual Basic.

Similar to the Magic Square example, the Prototyping and Debugging
example develops a function named mymagic, which wraps a MATLAB
function, magic, which computes a magic square, a function with a single
multidimensional matrix output.

If your MATLAB function is ready to be deployed and you have already built

your add-in and COM component with the Deployment Tool, see “Executing
Functions and Creating Macros Using the Function Wizard” on page 4-2.
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Key Tasks for the MATLAB Programmer

Task

Reference

1. Review MATLAB Builder EX
prerequisites, if you have not already
done so.

“MATLAB® Builder™ EX
Prerequisites” on page 1-6

2. Prepare to run the example by
copying the example files.

“Example File Copying” on page 4-28

3. Test the MATLAB function you
want to deploy as an add-in or COM
component.

“mymagic Testing” on page 4-28

4. Install the Function Wizard.

“Installation of the Function Wizard”
on page 4-29

5. Start the Function Wizard.

“Function Wizard Start-Up” on page
4-5

6. Select the prototyping and
debugging workflow.

“Workflow Selection for Prototyping
and Debugging MATLAB Functions”
on page 4-32

7. Define the new MATLAB function
you want to prototype by adding

it to the Function Wizard and
establishing input and output
ranges.

“New MATLAB Function Definition”
on page 4-35

8. Test your MATLAB function
by executing it with the Function
Wizard.

“Function Execution from MATLAB”
on page 4-49

9. Prototype and Debug the
MATLAB function if needed, using
MATLAB and the Function Wizard.

“MATLAB Function Prototyping and
Debugging” on page 4-47

10. Create the add-in and COM
component, as well as the macro,
using the Function Wizard to invoke
MATLAB and the Deployment Tool.

“Microsoft® Excel® Add-in and
Macro Creation Using the Function
Wizard” on page 4-50
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Key Tasks for the MATLAB Programmer (Continued)

Task Reference
11. Execute the your function from | “Function Execution from the
the newly created component, to Deployed Component” on page 4-52

ensure the function’s behavior is
identical to when it was tested.

12. Execute the macro you created “Macro Execution” on page 4-52
using the Function Wizard.

13. Package your deployable add-in | “Microsoft® Excel® Add-in and

and macro using the Function Macro Packaging using the Function
Wizard to invoke MATLAB and the | Wizard” on page 4-53

Deployment Tool.

14. Optionally inspect or modify “Microsoft® Visual Basic® Code
the Microsoft Visual Basic code you | Access (Optional Advanced Task)”
generated with the COM component. | on page 4-54

Optionally, attach the macro you
created to a GUI button.

What Can the Function Wizard Do for Me?

The Function Wizard enables you to pass Microsoft Excel (Excel 2000 or
later) worksheet values to a compiled MATLAB model and then return model
output to a cell or range of cells in the worksheet.

The Function Wizard provides an intuitive interface to Excel worksheets. You
do not need previous knowledge of Microsoft Visual Basic for Applications
(VBA) programming.

The Function Wizard reflects any changes that you make in the worksheets,
such as range selections. You also use the Function Wizard to control the
placement and output of data from MATLAB functions to the worksheets.

Note The Function Wizard does not currently support the MATLAB sparse,
and complex data types.
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Example File Copying

All MATLAB Builder EX examples reside in
matlabroot\toolbox\matlabxl\examples\. The following table identifies
examples by folder:

For Example Files Find Example Code | For Example

Relating To... in Folder... Documentation See...

Magic Square Example | xlmagic “Integrate an Add-In
and COM Component
with Microsoft® Excel®”
on page 1-18

Variable-Length xlmulti “Work with

Argument Example Variable-Length Inputs
and Outputs” on page
6-5

Calling Compiled xlbasic “Calling Compiled

MATLAB Functions MATLAB Functions

from Microsoft Excel from Microsoft® Excel®”
on page 8-5

Spectral Analysis xlspectral “Build and Integrate

Example with Spectral Analysis”
on page 7-18

mymagic Testing

In this example, you test a MATLAB file (nymagic.m) containing the
predefined MATLAB function magic. You test to have a baseline to compare
to the results of the function when it is ready to deploy.

1 In MATLAB, locate mymagic.m. See “Example File Copying” on page 4-28
for locations of examples. The contents of the file are as follows:

function y = mymagic(x)

%SMYMAGIC Magic square of size x.

Y = MYMAGIC(X) returns a magic square of size x.
This file is used as an example for the MATLAB
Builder EX product.

o® o°

o°
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% Copyright 2001-2012 The MathWorks, Inc.
y = magic(x)

2 At the MATLAB command prompt, enter mymagic(5). View the resulting
output, which appears as follows:

17 24 1 8 15
23 5 7 14 16
4 6 13 20 22
10 12 19 21 3
11 18 25 2 9

Installation of the Function Wizard

Before you can use the Function Wizard, you must first install it as an add-in
that is accessible from Microsoft Excel.

After you install the Function Wizard, the entry MATLAB Functions
appears as an available Microsoft Excel add-in button.

Using Office 2007

1 Start Microsoft Excel if it is not already running.

Cin
2

i/
2 Click the Office Button ( > ) and select Excel Options.

3 In the left pane of the Excel Options dialog box, click Add-Ins.

4 In the right pane of the Excel Options dialog box, select Excel Add-ins
from the Manage drop-down box.

5 Click Go.

6 Click Browse. Navigate to
matlabroot\toolbox\matlabxl\matlabxl\arch and select
FunctionWizard2007.xlam. Click OK.
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7 In the Excel Add-Ins dialog box, verify that the entry MATLAB Builder
EX Function Wizard is selected. Click OK.

Using Office 2010

1 Click the File tab.

2 On the left navigation pane, select Options.

3 In the Excel Options dialog box, on the left navigation pane, select Add-Ins.
4 In the Manage drop-down, select Excel Add-Ins, and click Go.

5 In the Add-Ins dialog box, click Browse.

6 Browse to matlabroot/toolbox/matlabxl/matlabxl/arch, and select
FunctionWizard2007.xlam. Click OK.

7 In the Excel Add-Ins dialog, verify that the entry MATLAB Builder EX
Function Wizard is selected. Click OK.

The Home tab of the Microsoft Office Ribbon should now contain the Function
Wizard tile. See The Home Tab of the Microsoft® Office Ribbon with Function
Wizard Installed on page 4-6.

Using Office 2003

1 Select Tools > Add-Ins from the Excel main menu.

2 If the Function Wizard was previously installed, MATLAB Builder EX
Function Wizard appears in the list. Select the item, and click OK.

If the Function Wizard was not previously installed, click Browse and
navigate to matlabroot\toolbox\matlabxl\matlabxl folder. Select
FunctionWizard.xla. Click OK to proceed.

Function Wizard Start-Up

Start the Function Wizard in one of the following ways. When the wizard has
initialized, the Function Wizard Start Page dialog box displays.
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Bookl - Microsoft Excel

Using Office 2007 or Office 2010

In Microsoft Excel, on the Microsoft Office ribbon, on the Home tab, select
MATLAB Functions.

[B==R A
o @ o & =
:?i':l = ' Tem T FE] T AutoSum - Ag ¥
™ m = = ormal Bad o e [ ,? :
= O . B | @ Fin - Zr W
53 00 Conditional Format | Good Meutral Insert Delete Format i Sort & Find & Function
Formatting = as Table = - - - ¢ Clear~ Filter = Select~ Wizard
Styles Cells Editing MATLAE Builder EX

The Home Tab of the Microsoft® Office Ribbon with Function Wizard Installed

Using Office 2003

1 Select Tools > Add-Ins from the Excel main menu.

2 Select Function Wizard.
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-

Function Wizard Start Page

Welcome to MATLAB Builder EX Function Wizard.

How would you like to use MATLAE Builder EX Function Wizard

{* i have one or more MATLAB functions that I want to use in a workbook (MATLAB installation required). |

Enter a project to create or open

(% Mew Project Project Location | Browse. ..

Project Name | Untitled1
Clazs Name | Class1
Version | 1.0

{” Open Project

{1 have an Add-in component that was built in MATLABE with the Deployment Tool that I want to integrate into a workbook

0K Car

The Function Wizard Start Page Dialog Box

Workflow Selection for Prototyping and Debugging
MATLAB Functions

After you have installed and started the Function Wizard, do the following.
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1 From the Function Wizard Start Page dialog box, select I have one
or more MATLAB functions that I want to use in a workbook
(MATLAB installation required). The New Project option is selected
by default. Enter a meaningful project name in the Project Name field,
like testmymagic, for example.

Tip Some customers find it helpful to assign a unique name as the Class
Name (default is Class1) and to assign a Version number for source
control purposes.

2 Click OK. The Function Wizard Control Panel displays with the Add
Function button enabled.
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r ™
Function Wizard Control Panel - Praject Untitled1 [
R
— 1. Setup Functions — 3. Create G b
e R— - . }

[all
Lalls

— 2E ute Functions

The recommended workflow is

Start Over | Close |

About Project Files

Keep in mind the following information about project files when working
with the Function Wizard:

¢ The project files created by the Function Wizard are the same project files
created and used by the Deployment Tool (deploytool).

¢ The Function Wizard prompts you to specify a location for your project files
when you open your first new project. Project files are auto-saved to this
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location and may be opened in the future through either the Deployment
Tool or the Function Wizard.

¢ If you previously built a component using the Function Wizard, the wizard
will prompt you to load it.

Quitting the MATLAB Session Invoked by the Function Wizard
Avoid manually terminating the MATLAB session invoked by the Function
Wizard. Doing so can prevent you from using the Wizard’s MATLAB-related
features from your Excel session. If you want to quit the remotely invoked
MATLAB session, restart Excel.

New MATLAB Function Definition

1 Add the function you want to deploy to the Function Wizard. Click Add in
the Set Up Functions area of the Function Wizard Control Panel. The New

MATLAB Function dialog box appears.

Mew MATLAB Function

E=X=)

L

Add MATLAB Function

If your function is not on the MATLAE path, you must enter the full path or use
the "Browse..." button to locate the function. Functions not already on the

MATLAE path will be added automatically.

Add

Browse...

Cancel

2 Browse to locate your MATLAB function. Select the function and click
Open.

3 In the New MATLAB Function dialog box, click Add. The Function
Properties dialog box appears.
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4-36

Function Properties -

— Edit Funchon Properties
Function Syntax and Help:

function [\r] - mm{n]

MYMAGIC Magic sguare of size x.
¥ = MYMAGIC(X) returns a magic sguare of size x.
This file is used as an example for the MATLAB
Builder EX product.

Edit Function Name:

[

Inputs | gutputs |

Select Input Ranges/Values -

(+ Reguired Arguments € varargin Arguments
Input Arguments
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Tip The Function Syntax and Help area, in the Function Properties
dialog box, displays the first help text line (sometimes called the H1I line)
in a MATLAB function. Displaying these comments in the Function
Properties dialog box can be helpful when deploying new or unfamiliar
MATLAB functions to end-users.

4 Define input argument properties as follows.

a On the Input tab, click Set Input Data. The Input Data for n dialog
box appears.

4-37



4 The Function Wizard

4-38

5 - -
Input Data forn “

— Type of Input Argument

(%" This is a scalar or matrix argument
Set RangeValue for Input Argument

(* Range: | J

[~ Auto recalaulate on change ?

™ This is a MATLAB structure array argument ? |

oK

b Specify a Range or Value by selecting the appropriate option and
entering the value.

Caution Avoid selecting ranges using arrow keys. If you must use
arrow keys to select ranges, apply the necessary fix from the Microsoft
site: http://support.microsoft.com/kb/291110.

¢ Click Done.


http://support.microsoft.com/kb/291110

End-+o-End Deployment of a MATLAB Function Using the Function Wizard

Tip To specify how MATLAB Builder EX handles blank cells (or cells
containing no data), see “Empty Cell Value Control” on page 4-41.

5 Define output argument properties as follows.

a On the Output tab, click Set Output Data. The Output Data for y
dialog box appears, where x is the name of the output variable you are
defining properties of.

-~

Output Data for out ﬁ

Type of Qutput Argument

{* This is @ scalar or matrix argument

set Range Value for Output Argument

{* Range: J

[v Auto Resize [ Transpose [ Output As date

Treat MATLAB Nal (Mot a Number) As: | Empty Cell j

{ This is @ MATLAB structure array argument 7

Done
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Tip You can also specify MATLAB Builder EX to Auto Resize,
Transpose or output your data in date format (Output as date). To
do so, select the appropriate option in the Argument Properties For y
dialog box.

Specify a Range. Alternately, select a range of cells on your Excel sheet;
the range will be entered for you in the Range field.

Caution Avoid selecting ranges using arrow keys. If you must use
arrow keys to select ranges, apply the necessary fix from the Microsoft
site: http://support.microsoft.com/kb/291110.

Select Auto Resize if it is not already selected.
Click Done in the Argument Properties For y dialog box.

Click Done in the Function Properties dialog box. mymagic now appears
in the Active Functions list of the Function Wizard Control Panel.


http://support.microsoft.com/kb/291110

End-to-End Deployment of a MATLAB Function Using the Function Wizard

-
Function Wizard Control Panel - Project Untitled1

Powered by

— 3. Create C

— 1. Setup Functions

[ L Execute Functions

’, The recommended workflow is

Start Over Close

Empty Cell Value Control

You can specify how MATLAB Builder EX processes empty cells, allowing you
to assign undefined or unrepresented (NaN, for example) data values to them.

To specify how to handle empty cells, do the following.

1 Click Options in the Input Data for N dialog box.

The Input Conversion Options dialog box opens.
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i

Input Careersion Options

Format Array As:

(¥ Matrix = el

Farmat Dates As:

* Murneric

2 Click the Treat Missing Data As drop-down box.

(" Skring | Zero|

Set Conversion Opkions Far inpuk_args

Coerce Mumeric to Type:
| Default

=~

Mal {Mok a Mumber) |
T I

_OrTCeET

Treak Missing Data As:

3 Specify either Zero or NaN (Not a Number), depending on how you want

to handle empty cells.

Working with Struct Arrays

To assign ranges to fields in a struct array, do the following:

1 If you have not already done so, select This is a MATLAB structure
array argument in the Input Data for n dialog box and click OK.
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: = = — ==
Input Data for n -

— Type of Input Argument

% This is a scalar or matrix argument
— Set Rangef\Value for Input Argument

@ oe: | A

[ Auto recaladlate on change ?

© vale: | | Double  ~|
" This is a MATLAB structure array argument ll
QK Hel:

The Input Data for Structure Array Argument n dialog box opens.
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i N
Input Data for Structure Array Argument n ﬁ

Set Fields for Structure Array Argument

Structure Array Organization

There are two WEYS YOU CAN Organize data in & structure array,
Specify how the structure array argument is organized in your
MATLAB function:

(¢ Element by Element Organization 5
" Plane Organization

Delete Field Set Field Data
I This argument is not a MATLAB structure array

Dione | Cancel |

o o

2 The Function Wizard supports Vector and Two-dimensional struct arrays
organized in either Element by Element or Plane organization, for both
input and output.

In the Input Data for Structure Array Argument n dialog box, do the
following:
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a In the Structure Array Organization area, select either Element by
Element Organization or Plane Organization.

b Click Add Field to add fields for each of your struct array arguments.
The Field for Structure Array Argument dialog box opens.

" ™
Field for Structure Array Argument ﬁ
Set Mame and Range for Structure Array Field
The field name you enter here should match with the field name of the
structure array in your MATLAB function, Field names are case sensitive.
Mame: |
Range:;
™ Auto recaloulate on change ﬂ
Options...
oK | Cancel
" |

3 In the Field for Argument dialog box, do the following:

a In the Name field, define the field name. The Name you specify must
match the field name of the structure array in your MATLAB function.

b Specify the Range for the field.

Caution Avoid selecting ranges using arrow keys. If you must use
arrow keys to select ranges, apply the necessary fix from the Microsoft
site: http://support.microsoft.com/kb/291110.
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Field for Structure Array Argument ﬁ

— Set Mame and Range for Structure Array Field

The field name you enter here should match with the field name of the
structure array in your MATLAB function, Field names are case sensitive.

MName: Mame|

Range: | cheet11§A51:5A%6

™ Auto recalculate on change il

Options. ..
— MATLAB representation of your selection
1, 1).Name=Sheat1$451
n{2, 1).Name=5heet1! $452
n{3, 1).Name=Sheet1!5A53
oK Cancel

¢ Click Done.

How Structure Arrays are Supported. MATLAB Builder EX supports one
and two-dimensional MATLAB structure arrays.

The product converts data passed into structure arrays in element-by-element
organization or plane organization. See MATLAB Programming
Fundamentals for more information about all MATLAB data types, including

structures.
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Deploying Structure Arrays as Inputs and Outputs. If you are a
MATLAB programmer and want to deploy a MATLAB function with structure
arrays as input or output arguments, build Microsoft Excel macros using the
Function Wizard and pass them (with the Excel Add-In and COM component)
to the end users. If you can’t do this, let your end users know:

® Which arguments are structure arrays

¢ Field names of the structure arrays

Using Macros with Struct Arrays. The macro generation feature of
MATLAB Builder EX works with struct arrays as input or output arguments.
See “Macro Creation” on page 4-19 if you have a MATLAB function you are
ready to deploy. See “Microsoft® Excel® Add-in and Macro Creation Using the
Function Wizard” on page 4-50 if you are using the Function Wizard to create
your MATLAB function from scratch. See “Choosing Function Deployment
Workflow” on page 1-10 for more information on both workflows.

MATLAB Function Prototyping and Debugging

Use the Function Wizard to interactively prototype and debug a MATLAB
function.

Since mymagic calls the prewritten MATLAB magic function directly, it
does not provide an illustrative example of how to use the prototyping and
debugging feature of MATLAB Builder EX.

Following is an example of how you might use this feature with myprimes, a
function containing multiple lines of code.

Prototyping and Debugging with myprimes

For example, say you are in the process of prototyping code that uses the
equation P = myprimes(n). This equation returns a row vector of prime
numbers less than or equal to n (a prime number has no factors other than 1
and the number itself).

Your code uses P = myprimes(n) as follows:

function [p] = myprimes(n)
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if length(n)~=1, error('N must be a scalar'); end
if n <2, p = zeros(1,0); return, end

p =1:2:n;
q = length(p);
p(1) = 2;

for k = 3:2:sqrt(n)

if p((k+1)/2)
p(((k*k+1)/2):k:q) = 0;
end

end

p = (p(p>0));

In designing your code, you want to handle various use cases. For example,
you want to experiment with scenarios that may assign a column vector value
to the output variable p ( (nyprimes only returns a row vector, as stated
previously). You follow this general workflow:

1 Set a breakpoint in myprimes at the first if statement, using the GUI or
dbstop, for instance.

2 On the Function Wizard Control Panel, in the Execute Functions area, click
Execute. Execution will stop at the previously set breakpoint. Note the
value of p in the yellow box in the following figure. Step-through and debug
your code as you normally would using the MATLAB Editor.
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- = e e —
] Editor - St\work\mycompanentimyprimes.m g SRICEL X
File Edit Tet Go Cell Tools Debug Desktop Window Help RIS
TNE@E smER90 |82 - e l-B80QQE B E | stec myprimes ~ | fi HOA SO
BB -0 [+ 211 % [«Ee | @

1 function [p] = myprimes(n)

2

1@ if length(n)~=1l, error('N must be a scalar'); end

4= if n < 2, p = zero=(1,0); return, end

5= p = 1:2:n;

[ g = length(p):

7 - p(l) = 2;

8- for k = 3:2:3gqrt(n)

9

10 — if p((k+1)/2)

11 = Bl (k*k+1)/2) :k:q) = O;

12 = end

13

14 — end

15

16 — = >0)):

g B (e(p>0))
p: 1x4 double =
2 3 5 7
myprimes Ln 14 Col 4 OVR

Debugging myprimes Using the Function Wizard

For more information about debugging MATLAB code, see “Editing and
Debugging MATLAB Code” in the MATLAB Desktop Tools and Development

Environment User’s Guide.

Function Execution from MATLAB

Test your deployable MATLAB function by executing it in MATLAB:

1 From the Function Wizard Control Panel, in the Execute Functions area,
select Execute MATLAB Functions in MATLAB.

2 Click Execute. In Excel, the Magic Square function executes, producing

results similar to the following.
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A B C D E
17 24 A 8 15
23 5 i 14 16
4 6 13 20 22
10 12| 19.| 21
11 18 25 2

Microsoft Excel Add-in and Macro Creation Using the
Function Wizard

The Function Wizard can automatically create a deployable Microsoft Excel
add-in and macro. To create your add-in in this manner, use one of the
following procedures.

Creating an Add-in and Associated Excel Macro
To create both a deployable add-in and an associated Excel macro:

1 In the Function Wizard Control Panel dialog box, in the Create Component
area, select Create Both Builder EX Component and Excel Macro.

2 Enter mymagic in the Macro Name field.

3 Select the location of where to store the macro, using the Store Macro In
drop-down box.

4 Enter a brief description of the macro’s functionality in the Description
field.

5 Click Create to build both the add-in (as well as the underlying COM
component) and the associated macro. The Deployment Tool Build dialog
box appears, indicating the status of the add-in and COM component
compilation (build).
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o\ Build =

i) Build Finished.

) Hide Details [ Close

[C:\USERS\XLIUNAPPDATA\LOCAL\TEMP\MBUILD~1\templib, def” -
--> mt.exe -outputresource:”3:\ADEPLO~1.15\MATLAB\ TESTMY~1\SRC\testmymagic_1_0.d11%;2
-manifest "S:\ADEFLO~1.15\MATLAB\TESTMY~1\SRC\testmymagic_1_0.msvc.manifest"”
Microsoft (R} Manifest Tool wversion 5.2.3790.2075

Copyright (¢} Microsoft Corporation 2005.

All rights reserved.

==> del "$:\ADEFLO~1.15\MATLAB\TESTMY~1\SRC\testmymagic_1_0.mesve.manifest”

-=-> S:\ADEPLO~1.15\mat lab\runtime\win3Z\miregsvr.exe
S:\Adeploy.10.15\matlab\testmymagichsrch ymagic_1_0.dll

DllRegisterServer in S:\Adeploy.10.15\matlab)\testnymagic\src\testnywagic_1_0.dll
succeeded

DEMO Compiler license.

The generated application will expire 30 days from today,

on Thu Nov 18 09:55:49 2010,

copy 'S:\Adeploy.10.15\matlab\testmymagic\src\readme. txt’

'S:\Adeploy. 10, 15\mat lab\ testnymagic\distrib\readwe, txt'

copy 'S:\Adeploy.10.15\matlab)\testmymagic)\src\testmymagic_1 0.d11'

'S:\Adeploy. 10. 15\mat lab\ testmymagichdistrib\testmymagic_1_0.dl1'

copy 'S:\Adeploy.10.15\matlab\testmymagic\src\testmymagic.xla’

'S:\Adeploy. 10, 15\mat lab\ testmymagici\distrib\testmymagic.xla'

copy 'S:\Adeploy.10.15\matlab\testmymagic)src\testmymagic.bas’ =

‘ 1 ]

to log fil

The Build Dialog

Creating a COM Component or a Macro Only Without Creating

an Add-in

To create either a COM component or a macro without also creating the Excel
add-in, do the following

1 In the Function Wizard Control Panel dialog box, in the Create Component
area, select either MATLAB Builder EX Component Only or Create
Excel Macro Only.

2 Enter mymagic in the Macro Name field.

3 Select the location of where to store the macro, using the Store Macro In
drop-down box.
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4 Enter a brief description of the macro’s functionality in the Description
field.

5 Click Create.

Function Execution from the Deployed Component

Execute your function as you did similarly in “Function Execution from
MATLAB” on page 4-49, but this time execute it from the deployed component
to ensure it matches your previous output.

1 From the Function Wizard Control Panel, in the Execute Functions area,
select Execute MATLAB Functions from Deployed Component.

2 Click Execute. In Excel, the Magic Square function executes, producing
results similar to the following.

a | B C D E
17 24 1 8 15
23 5 7 14 16
a 6 13 20 22
10 1] 19_| 71
11 18 25 2

Macro Execution

Run the macro you created in “Macro Creation” on page 4-19 by doing one of
the following, after first clearing cells A1:E5 (which contain the output of the
Magic Square function you ran in “Function Execution” on page 4-19).

Tip You may need to enable the proper security settings before running
macros in Microsoft Excel. For information about macro permissions and
error messages occuring from executing macros, see the Appendix B,
“Troubleshooting” appendix.
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Using Office 2007 or Office 2010

1 In Microsoft Excel, click View > Macros > View Macros.
2 Select mymagic from the Macro name drop-down box.

3 Click Run. Cells A1:E5 on the Excel sheet are automatically populated
with the output of mymagic.

Using Office 2003
1 In Microsoft Excel, click Tools > Macro > Macros.
2 Select mymagic from the Macro name drop-down box.

3 Click Run. Cells A1:E5 on the Excel sheet are automatically populated
with the output of mymagic.

Watch a Video

Watch a video that demonstrates how to execute deployed functions with the
Function Wizard and Microsoft Excel.

Microsoft Excel Add-in and Macro Packaging using
the Function Wizard
The Function Wizard can automatically package a deployable Microsoft Excel

add-in and macro for sharing. To package your add-in in this manner, use one
of the following procedures.

1 After successfully building your component and add-in, in the Share
Component area of the Function Wizard Control Panel dialog box, review
the files listed in the Files to include in packaging field. Add Files or
Remove Files to and from the package by clicking the appropriate buttons.

2 To add access to the MCR Installer to your package, select one of the
options in the MCR area. For information about the MCR and the MCR
Installer, see “Install MATLAB Compiler Runtime (MCR) ” on page 8-2.

3 When you are ready to create your package, click Create Package.
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Microsoft Visual Basic Code Access (Optional
Advanced Task)

Optionally, you may want to access the Visual Basic code or modify it,
depending on your programming expertise or the availability of an Excel
developer. If so, follow these steps.

From the Excel main window, open the Microsoft Visual Basic editor by doing
one of the following. select Tools > Macro > Visual Basic Editor.

Using Office 2007 or Office 2010

1 Click Developer > Visual Basic.

2 When the Visual Basic Editor opens, in the Project - VBAProject window,
double-click to expand VBAProject (mymagic.xls).

3 Expand the Modules folder and double-click the Matlab Macros module.

This opens the VB Code window with the code for this project.

Using Office 2003

1 Click Tools > Macro > Visual Basic Editor.

2 When the Visual Basic Editor opens, in the Project - VBAProject window,
double-click to expand VBAProject (mymagic.xls).

3 Expand the Modules folder and double-click the Matlab Macros module.

This opens the VB Code window with the code for this project.
Mapping a Macro to a GUI Button or Control (Optional)

To attach the macro to a GUI button, do the following:

1 Click Developer > Insert.

2 From the Form Controls menu, select the Button (Form Control) icon.
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Tip Hover your mouse over the Form Controls menu to see the various
control labels.

3 In the Assign Macros dialog box, select the macro you want to assign the
GUI button to, and click OK.

Ho-o- -
%)
Home Insert Page Layout Formulas Data Review Wiew

ﬁ = 3 Record Macra : 2 % erties @ MR @
=| =0 {F Use Relative References | 7 Gelview Code | - ) Expansion Packs =) Export | —t
visual Macros Insert Source Document
Basic I\ Macro Security A Run Dizlog “@} Refresh Data A
Code Controls XML Modify
[ Button 1 - 5|
A B G D E: E G H } il K L M
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Button1_Click
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Attaching a Macro to a Button
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For More Information

If you want to...

See...

e Perform basic MATLAB
Programmer tasks

¢ Understand how the deployment
products process your MATLAB
functions

¢ Understand how the deployment
products work together

e Explore guidelines about writing
deployable MATLAB code

“Write Deployable MATLAB Code”
on page 5-10

See more examples about building
add-ins and COM components

“Add-in and Macro Creation from
MATLAB Functions ” on page 6-5

Learn more about the MATLAB
Compiler Runtime (MCR)

“Working with the MCR” in the
MATLAB Compiler User’s Guide

Learn how to customize and
integrate the COM component you
built by modifying the Microsoft
Visual Basic code

“Code Your Microsoft® Visual Basic®
Application” on page 7-3

“Build and Integrate with Spectral
Analysis” on page 7-18




MATLAB Code Deployment

® “Application Deployment Products and the Compiler Apps” on page 5-2
* “Write Deployable MATLAB Code” on page 5-10

¢ “How the Deployment Products Process MATLAB Function Signatures”
on page 5-14

¢ “Load MATLAB Libraries using loadlibrary” on page 5-16

¢ “Use MATLAB Data Files (MAT Files) in Compiled Applications” on page
5-18
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Application Deployment Products and the Compiler Apps

In this section...

“What Is the Difference Between the Compiler Apps and the mcc Command
Line?” on page 5-2

“How Does MATLAB® Compiler™ Software Build My Application?” on
page 5-2

“Dependency Analysis Function” on page 5-5
“MEX-Files, DLLs, or Shared Libraries” on page 5-6
“Component Technology File (CTF Archive)” on page 5-6

What Is the Difference Between the Compiler Apps
and the mcc Command Line?

When you use one of the compiler apps, you perform any function you would
invoke using the MATLAB Compiler mcc command-line interface. The
compiler apps’ interactive menus and dialogs build mcc commands that are
customized to your specification. As such, your MATLAB code is processed
the same way as if you were compiling it using mcc.

Compiler app advantages include:

® You perform related deployment tasks with a single intuitive interface.
® You maintain related information in a convenient project file.

® Your project state persists between sessions.

® You load previously stored compiler projects from a prepopulated menu.

e Package applications for distribution.

How Does MATLAB Compiler Software Build My
Application?
To build an application, MATLAB Compiler software performs these tasks:

1 Parses command-line arguments and classifies by type the files you provide.
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2 Analyzes files for dependencies using a dependency analysis function.
Dependencies affect deployability and originate from functions called by
the file. Deployability is affected by:

¢ File type — MATLAB, Java, MEX, and so on.
® File location — MATLAB, MATLAB toolbox, user code, and so on.

For more information about how the compiler does dependency analysis,
see “Dependency Analysis Function” on page 5-5.
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4 Creates a CTF archive from the input files and their dependencies. For
more details about CTF archives see “Component Technology File (CTF
Archive)” on page 5-6.

5 Generates target-specific wrapper code. For example, a C main function
requires a very different wrapper than the wrapper for a Java interface
class.

6 Generates target-specific binary package. For library targets such as C++
shared libraries, Java packages, or .NET assemblies, the compiler will
invoke the required third-party compiler.

Dependency Analysis Function

MATLAB Compiler uses a dependency analysis function to determine the
list of necessary files to include in the generated package. Sometimes, this
process generates a large list of files, particularly when MATLAB object
classes exist in the compilation and the dependency analyzer cannot resolve
overloaded methods at compile time. Dependency analysis also processes
include/exclude files on each pass.

Tip To improve compile time performance and lessen application size, prune
the path with the mcc command’s -N and -p flags. You can also specify Files
required for your application in the compiler app.

The dependency analyzer searches for executable content such as:

e MATLAB files
e P-files

Note If the MATLAB file corresponding to the p-file is not available, the
dependency analysis will not be able to determine the p-file’s dependencies.

e Java classes and . jar files

e _fig files



5 maATLAB® Code Deployment

5-6

e MEX-files

The dependency analyzer does not search for data files of any kind. You must
manually include data files in the search.

MEX-Files, DLLs, or Shared Libraries

When you compile MATLAB functions containing MEX-files, ensure that
the dependency analyzer can find them. Doing so allows you to avoid many
common compilation problems. In particular, note that:

® Since the dependency analyzer cannot examine MEX-files, DLLs, or shared
libraries to determine their dependencies, explicitly include all executable
files these files require. To do so, use either the mcc -a option or the Files
required for your application to run field in the compiler app.

¢ If you have any doubts that the dependency analyzer can find a MATLAB
function called by a MEX-file, DLL, or shared library, then manually
include that function. To do so, use either the mcc -a option or the Files
required for your application to run field in the compiler app.

® Not all functions are compatible with MATLAB Compiler. Check the file
mccExcludedFiles.log after your build completes. This file lists all
functions called from your application that you cannot deploy.

Component Technology File (CTF Archive)

Each application or shared library you produce using MATLAB Compiler
has an embedded Component Technology File (CTF) archive. The archive
contains all the MATLAB based content (MATLAB files, MEX-files, and so
on) associated with the component. All MATLAB files in the CTF archive are
encrypted using the Advanced Encryption Standard (AES) cryptosystem.

If you choose to extract the CTF archive as a separate file, the files remain
encrypted. For more information on how to extract the CTF archive refer to
the references in the following table.
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Information on CTF Archive Embedding/Extraction and Component
Cache

Product Refer to

MATLAB Compiler “MCR Component Cache and CTF
Archive Embedding”

MATLAB Builder NE “MCR Component Cache and CTF
Archive Embedding”

MATLAB Builder JA “CTF Archive Embedding and
Extraction”

MATLAB Builder EX Using MCR Component Cache and
CTF Archive Embedding

5-7



5 maATLAB® Code Deployment

Generated Component (EXE, DLL, SO, eic)

Target-
Specific
Binary
Code

CTF Archive

Y

Encrypted
MATLAB Data

N
SR

Data File

—
SR

MEX-File

—_




Application Deployment Products and the Compiler Apps

Additional Details

Multiple CTF archives, such as those generated with COM, .NET, or Excel
components, can coexist in the same user application. You cannot, however,
mix and match the MATLAB files they contain. You cannot combine
encrypted and compressed MATLAB files from multiple CTF archives into
another CTF archive and distribute them.

All the MATLARB files from a given CTF archive associate with a unique
cryptographic key. MATLAB files with different keys, placed in the same
CTF archive, do not execute. If you want to generate another application
with a different mix of MATLAB files, recompile these MATLAB files into a
new CTF archive.

MATLAB Compiler deletes the CTF archive and generated binary following
a failed compilation, but only if these files did not exist before compilation
initiates. Run help mcc -K for more information.

Caution Release Engineers and Software Configuration Managers:
Do not use build procedures or processes that strip shared libraries on CTF
archives. If you do, you can possibly strip the CTF archive from the binary,
resulting in run-time errors for the driver application.
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Write Deployable MATLAB Code

In this section...

“Compiled Applications Do Not Process MATLAB Files at Runtime” on
page 5-10

“Do Not Rely on Changing Directory or Path to Control the Execution of
MATLAB Files” on page 5-11

“Use ismcc and isdeployed Functions To Execute Deployment-Specific Code
Paths” on page 5-12

“Gradually Refactor Applications That Depend on Noncompilable
Functions” on page 5-12

“Do Not Create or Use Nonconstant Static State Variables” on page 5-12

“Get Proper Licenses for Toolbox Functionality You Want to Deploy” on
page 5-13

Compiled Applications Do Not Process MATLAB Files
at Runtime

MATLAB Compiler secures your code against unauthorized changes.
Deployable MATLAB files are suspended or frozen at the time MATLAB
Compiler encrypts them—they do not change from that point onward. This
does not mean that you cannot deploy a flexible application—it means that
you must design your application with flexibility in mind. If you want the end
user to be able to choose between two different methods, for example, both
methods must be available in the built component.

The MCR only works on MATLAB code that was encrypted when the
component was built. Any function or process that dynamically generates
new MATLAB code will not work against the MCR.

Some MATLAB toolboxes, such as the Neural Network Toolbox™ product,
generate MATLAB code dynamically. Because the MCR only executes
encrypted MATLAB files, and the Neural Network Toolbox generates
unencrypted MATLAB files, some functions in the Neural Network Toolbox
cannot be deployed.
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Similarly, functions that need to examine the contents of a MATLAB function
file cannot be deployed. HELP, for example, is dynamic and not available in
deployed mode. You can use LOADLIBRARY in deployed mode if you provide
it with a MATLAB function prototype.

Instead of compiling the function that generates the MATLAB code and
attempting to deploy it, perform the following tasks:

1 Run the code once in MATLAB to obtain your generated function.

2 Compile the MATLAB code with MATLAB Compiler, including the
generated function.

Tip Another alternative to using EVAL or FEVAL is using anonymous function
handles.

If you require the ability to create MATLAB code for dynamic run time
processing, your end users must have an installed copy of MATLAB.

Do Not Rely on Changing Directory or Path to Control
the Execution of MATLAB Files

In general, good programming practices advise against redirecting a program
search path dynamically within the code. Many developers are prone to this
behavior since it mimics the actions they usually perform on the command
line. However, this can lead to problems when deploying code.

For example, in a deployed application, the MATLAB and Java paths are
fixed and cannot change. Therefore, any attempts to change these paths
(using the cd command or the addpath command) fails

If you find you cannot avoid placing addpath calls in your MATLAB code, use

ismcc and isdeployed. See “Use ismcc and isdeployed Functions To Execute
Deployment-Specific Code Paths” on page 5-12 for details.

5-11
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Use ismcc and isdeployed Functions To Execute
Deployment-Specific Code Paths

The isdeployed function allows you to specify which portion of your MATLAB
code is deployable, and which is not. Such specification minimizes your
compilation errors and helps create more efficient, maintainable code.

For example, you find it unavoidable to use addpath when writing your
startup.m. Using ismcc and isdeployed, you specify when and what is
compiled and executed.

Gradually Refactor Applications That Depend on
Noncompilable Functions

Over time, refactor, streamline, and modularize MATLAB code containing
non-compilable or non-deployable functions that use ismcc and isdeployed.
Your eventual goal is “graceful degradation” of non-deployable code. In
other words, the code must present the end user with as few obstacles to
deployment as possible until it is practically eliminated.

Partition your code into design-time and run time code sections:

® Design-time code is code that is currently evolving. Almost all code goes
through a phase of perpetual rewriting, debugging, and optimization. In
some toolboxes, such as the Neural Network Toolbox product, the code goes
through a period of self-training as it reacts to various data permutations
and patterns. Such code is almost never designed to be deployed.

® Run-time code, on the other hand, has solidified or become stable—it is in a
finished state and is ready to be deployed by the end user.

Consider creating a separate directory for code that is not meant to be
deployed or for code that calls undeployable code.

Do Not Create or Use Nonconstant Static State
Variables
Avoid using the following:

® Global variables in MATLAB code
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e Static variables in MEX-files

e Static variables in Java code

The state of these variables is persistent and shared with everything in the
process.

When deploying applications, using persistent variables can cause problems
because the MCR process runs in a single thread. You cannot load more than
one of these non-constant, static variables into the same process. In addition,
these static variables do not work well in multithreaded applications.

When programming with builder components, you should be aware that an
instance of the MCR is created for each instance of a new class. If the same
class is instantiated again using a different variable name, it is attached to
the MCR created by the previous instance of the same class. In short, if an
assembly contains n unique classes, there will be maximum of n instances
of MCRs created, each corresponding to one or more instances of one of the
classes.

If you must use static variables, bind them to instances. For example,
defining instance variables in a Java class is preferable to defining the
variable as static.

Note This guideline does not apply to MATLAB Builder EX. When
programming with Microsoft Excel, you can assign global variables to large
matrices that persist between calls.

Get Proper Licenses for Toolbox Functionality You
Want to Deploy

You must have a valid MathWorks® license for toolboxes you use to create
deployable components.

If you do not have a valid license for your toolbox, you cannot create a
deployable component with it.

5-13
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How the Deployment Products Process MATLAB Function

Signatures

In this section...

“MATLAB Function Signature” on page 5-14

“MATLAB Programming Basics” on page 5-14

MATLAB Function Signature

MATLAB supports multiple signatures for function calls.

The generic MATLAB function has the following structure:

function [Out1,0ut2,...,varargout]=foo(In1,In2,...,varargin)

To the left of the equal sign, the function specifies a set of explicit and optional
return arguments.

To the right of the equal sign, the function lists explicit input arguments
followed by one or more optional arguments.

All arguments represent a specific MATLAB type.

When the compiler or builder product processes your MATLAB code, it creates
several overloaded methods that implement the MATLAB functions. Each

of these overloaded methods corresponds to a call to the generic MATLAB
function with a specific number of input arguments.

In addition to these methods, builder creates another method that defines the
return values of the MATLAB function as an input argument. This method
simulates the feval external API interface in MATLAB.

MATLAB Programming Basics

Creating a Deployable MATLAB Function

Virtually any calculation that you can create in MATLAB can be deployed, if
it resides in a function. For example:
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> 1 + 1

cannot be deployed.

However, the following calculation:

function result = addSomeNumbers()
result = 1+1;
end

can be deployed because the calculation now resides in a function.
Taking Inputs into a Function

You typically pass inputs to a function. You can use primitive data type as an
input into a function.

To pass inputs, put them in parentheses. For example:

function result = addSomeNumbers(numberi, number2)
result = numberi + number2;
end

5-15
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Load MATLAB Libraries using loadlibrary

Note It is important to understand the difference between the following:

e MATLAB loadlibrary function — Loads shared library into MATLAB.

® QOperating system loadlibrary function — Loads specified Windows
or UNIX operating system module into the address space of the calling
process.

With MATLAB Compiler version 4.0 (R14) and later, you can use MATLAB
file prototypes as described below to load your library in a compiled
application. Loading libraries using H-file headers is not supported in
compiled applications. This behavior occurs when loadlibrary is compiled
with the header argument as in the statement:

loadlibrary(library, header)

In order to work around this issue, execute the following at the MATLAB
command prompt:

loadlibrary(library, header, 'mfilename', 'mylibrarymfile');

where mylibrarymfile is the name of a MATLAB file you would like to use
when loading this library. This step only needs to be performed once to
generate a MATLAB file for the library.

In the code that is to be compiled, you can now call loadlibrary with the
following syntax:

loadlibrary(library, @mylibrarymfile, 'alias', alias)

It is only required to add the prototype .m file and .d11 file to the CTF archive
of the deployed application. There is no need for .h files and C/C++ compilers
to be installed on the deployment machine if the prototype file is used.

Once the prototype file is generated, add the file to the CTF archive of the
application being compiled. You can do this with the -a option (if using the
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mcc command) or by dragging it under Other/Additional Files (as a helper
file) if using the Deployment Tool.

With MATLAB Compiler versions 4.0.1 (R14+) and later, generated MATLAB
files will automatically be included in the CTF file as part of the compilation
process. For MATLAB Compiler versions 4.0 (R14) and later, include your
library MATLAB file in the compilation with the -a option with mcc.

Restrictions on Using MATLAB Function loadlibrary
with MATLAB Compiler

Note the following limitations in regards to using loadlibrary with MATLAB
Compiler. For complete documentation and up to date restrictions on
loadlibrary, please reference the MATLAB documentation.

® You can not use loadlibrary inside of MATLAB to load a shared library
built with MATLAB Compiler.

e With MATLAB Compiler Version 3.0 (R13SP1) and earlier, you cannot
compile calls to loadlibrary because of general restrictions and limitations
of the product.

5-17
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Use MATLAB Data Files (MAT Files) in Compiled Applications

In this section...

“Explicitly Including MAT files Using the %#function Pragma” on page 5-18

“Load and Save Functions” on page 5-18

“MATLAB Objects” on page 5-21

Explicitly Including MAT files Using the %#function
Pragma

MATLAB Compiler excludes MAT files from “Dependency Analysis Function”
on page 5-5 by default.

If you want MATLAB Compiler to explicitly inspect data within a MAT file,
you need to specify the %#function pragma when writing your MATLAB code.

For example, if you are creating a solution with Neural Network Toolbox,
you need to use the %#function pragma within your GUI code to include a
dependency on the gmdistribution class, for instance.

Load and Save Functions

If your deployed application uses MATLAB data files (MAT-files), it is helpful
to code LOAD and SAVE functions to manipulate the data and store it for later
processing.

e Use isdeployed to determine if your code is running in or out of the
MATLAB workspace.

¢ Specify the data file by either using WHICH (to locate its full path name)
define it relative to the location of ctfroot.

e All MAT-files are unchanged after mcc runs. These files are not encrypted
when written to the CTF archive.

For more information about CTF archives, see “Component Technology File
(CTF Archive)” on page 5-6.

See the ctfroot reference page for more information about ctfroot.
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Use the following example as a template for manipulating your MATLAB
data inside, and outside, of MATLAB.

Using Load/Save Functions to Process MATLAB Data for
Deployed Applications
The following example specifies three MATLAB data files:

® user_data.mat

userdata\extra_data.mat

e ..\externdata\extern_data.mat

1 Navigate to matlab _root\extern\examples\compiler\Data Handling.
2 Compile ex_loadsave.m with the following mcc command:

mcc -mv ex_loadsave.m -a 'user_data.mat' -a
'.\userdata\extra_data.mat' -a
'..\externdata\extern_data.mat'

ex_loadsave.m.

function ex_loadsave

o0

This example shows how to work with the

o0

"load/save" functions on data files in

o°

deployed mode. There are three source data files

o0

in this example.

o0

user_data.mat

o0

userdata\extra_data.mat

o

..\externdata\extern_data.mat

o0

o°

Compile this example with the mcc command:

o°

mcc -m ex_loadsave.m -a 'user_data.mat' -a

o0

'.\userdata\extra_data.mat'

o0

-a '..\externdata\extern_data.mat'
All the folders under the current main MATLAB file directory will
be included as

o o°

o

relative path to ctfroot; All other folders will have the
folder
structure included in the ctf archive file from root of the

o

o°

5-19
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o°  o°

o°

o o o o°

o°

disk drive.

If a data file is outside of the main MATLAB file path,
the absolute path will be
included in ctf and extracted under ctfroot. For example:
Data file
"c:\$matlabroot\examples\externdata\extern_data.mat"
will be added into ctf and extracted to
"$ctfroot\$matlabroot\examples\externdata\extern_data.mat".

All mat/data files are unchanged after mcc runs. There is
no excryption on these user included data files. They are
included in the ctf archive.

The target data file is:
.\output\saved_data.mat
When writing the file to local disk, do not save any files
under ctfroot since it may be refreshed and deleted
when the application isnext started.

%==== load data file =====
if isdeployed

o°

In deployed mode, all file under CTFRoot in the path are loaded

o°

by full path name or relative to $ctfroot.

s LOADFILENAME1=which(fullfile(ctfroot,mfilename, 'user_data.mat'));

s LOADFILENAME2=which(fullfile(ctfroot, 'userdata', 'extra_data.mat'));
LOADFILENAME1=which(fullfile('user_data.mat'));
LOADFILENAME2=which(fullfile('extra_data.mat'));

% For external data file, full path will be added into ctf;

% you don't need specify the full path to find the file.
LOADFILENAME3=which(fullfile('extern_data.mat'));

°

°

else

srunning the code in MATLAB
LOADFILENAME1=fullfile(matlabroot, 'extern', 'examples’', 'compiler’',
‘Data_Handling', 'user_data.mat');
LOADFILENAME2=fullfile(matlabroot, 'extern’', 'examples’', 'compiler’',
'‘Data_Handling', 'userdata', 'extra_data.mat');
LOADFILENAME3=fullfile(matlabroot, 'extern', 'examples’', 'compiler’',
‘externdata’, 'extern_data.mat');

end
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%

s Load the data file from current working directory

disp(['Load A from : ',LOADFILENAME1]);

load (LOADFILENAME1, 'datal');
disp('A= ");
disp(datal);

% Load the data file from sub directory

disp(['Load B from : ',LOADFILENAME2]);
load (LOADFILENAME2, 'data2');

disp('B= ');

disp(data2);

disp(['Load extern data from :
load (LOADFILENAME3) ;
disp('ext_data= ');
disp(ext_data);

s Load extern data outside of current working directory
' ,LOADFILENAME3]);

%==== multiple the data matrix by 2 ==============

result = datatl*data2;
disp('A * B = ');
disp(result);

%==== save the new data to a new file ===========
SAVEPATH=strcat (pwd,filesep, 'output');

if ( ~isdir(SAVEPATH))
mkdir (SAVEPATH) ;
end

SAVEFILENAME=strcat (SAVEPATH,filesep, 'saved_data.mat');

disp([ 'Save the A * B result to :

save (SAVEFILENAME, 'result');

MATLAB Objects

' SAVEFILENAME]);

When working with MATLAB objects, remember to include the following

statement in your MAT file:

s#function class_constructor

5-21



5 maATLAB® Code Deployment

Using the %#function pragma in this manner forces the dependency analysis
to load needed class definitions, enabling the MCR to successfully load the
object.
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Microsoft Excel Add-in
Creation, Function
Execution, and Deployment

® “Supported Compilation Targets” on page 6-2

¢ “The Library Compiler and the Command Line Interface” on page 6-4
¢ “Add-in and Macro Creation from MATLAB Functions ” on page 6-5

¢ “Execute Add-in With the Function Wizard” on page 6-11
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Supported Compilation Targets

In this section...

“Microsoft® Excel® Add-in” on page 6-2

“What Are MATLAB® Builder™ EX Components and When Should You
Create Them?” on page 6-3

“MATLAB® Builder™ EX Limitations” on page 6-3

Microsoft Excel Add-in

Using MATLAB Builder EX and the Deployment Tool (deploytool or mcc),
you create deployable add-ins and Excel functions from MATLAB code that
runs in Microsoft Excel applications. The Deployment Tool and mcc support
the following function outputs:

* No outputs
® Figure (graphical) output
® Scalar output

Using the MATLAB Builder EX Function Wizard, you create Excel macros
that can be deployed as add-ins or workbooks.

MATLAB Builder EX supports multidimensional matrix output(s).

Migration Considerations for 32-bit and 64-bit Microsoft Excel

Add-ins created with MATLAB Builder are not compatible with versions of
Microsoft Excel that do not share the same bitness:

¢ Add-ins created with 64-bit versions MATLAB Builder EX are only
compatible with 64-bit versions of Microsoft Excel.

¢ Add-ins created with 32-bit versions MATLAB Builder EX are only
compatible with 32-bit versions of Microsoft Excel.
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What Are MATLAB Builder EX Components and When
Should You Create Them?

MATLAB Builder EX generates two primary artifacts from your MATLAB
code, using the Deployment Tool: a Microsoft Excel add-in and a COM
component.

Existing MATLAB functions can be integrated into new or existing
spreadsheet solutions, as add-ins, with the Function Wizard. You can also use
the Function Wizard to create and test add-ins for new MATLAB functions.

COM components created with either the Deployment Tool or the Function
Wizard (. bas files) can be integrated into existing Microsoft Visual Basic
applications.

MATLAB Builder EX Components are ideal solutions for deploying MATLAB
code to users of Microsoft Excel and large-scale enterprise financial
applications written in Microsoft Visual Basic.

MATLAB Builder EX Limitations

MATLAB objects are not supported as inputs or outputs for compiled or
deployed functions with MATLAB Builder EX.

6-3
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The Library Compiler and the Command Line Interface

In this section...

“Using the Library Compiler” on page 6-4

“Using the mcc Command Line Interface” on page 6-4

Using the Library Compiler

For a complete example of how to use the Library Compiler app, see “Create
a Microsoft® Excel® Add-In and COM Component from MATLAB Code” on
page 1-12. For information about how the graphical interface differs from the
command line interface, read “What Is the Difference Between the Compiler
Apps and the mcc Command Line?” on page 5-2 in “Write Deployable
MATLAB Code” on page 5-10.

Using the mcc Command Line Interface

As an alternative to using the Library Compiler, you can use the command
line to create your deployable executable, using the mcc command.
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Add-in and Macro Creation from MATLAB Functions

In this section...

“Create Add-ins and Macros with Single and Multiple Outputs” on page 6-5

“Work with Variable-Length Inputs and Outputs” on page 6-5

Create Add-ins and Macros with Single and Multiple
Outputs

The basic workflow for Microsoft Excel add-in and macro creation can be
found in “Create a Microsoft® Excel® Add-In and COM Component from
MATLAB Code” on page 1-12 and “Integrate an Add-In and COM Component
with Microsoft® Excel®” on page 1-18.

Work with Variable-Length Inputs and Outputs

This example shows you how to work with, and create macros from, functions
having variable-length inputs and outputs

Overview
myplot takes a single integer input and plots a line from 1 to that number.

mysum takes an input of varargin of type integer, adds all the numbers,
and returns the result.

myprimes takes a single integer input n and returns all the prime numbers
less than or equal to n.

The Microsoft Excel file, xImulti.x1ls, demonstrates these functions in
several ways.

Where Is the Example Code?

See “Example File Copying” on page 4-28 for information about accessing the
example code from within the product.
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Creating the Project

Use the following information as you work through this example using the
instructions in “Create a Microsoft® Excel® Add-In and COM Component
from MATLAB Code” on page 1-12:

Project Name x1multi
Class Name xlmulticlass
File to compile myplot.m

(in the x1multi folder of myprimes.m
myfiles\work) mysum.m

Adding a MATLAB Builder EX COM Function to Microsoft Excel

1 Start Microsoft Excel on your system.
2 Open the file myfiles\work\x1lmulti\xlmulti.xls.

The example appears as shown:
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A B c D E F G H | J K

|
Sample: myplot

In this simple example we are just plotting a line from 1 to whatever
number is supplied as an argument to the function in cell A7,

a

Sample: mysum

In the below example we are just adding up a series of numbers that
are explicitly stated.
55

In the below example we are just adding up a series of numbers that
are frorm a range of cells.
55 1 2 3 4 ] G 7 g a 10

In the below example, we are adding up 3 separate ranges of cells.
The ranges do not need to be the same size nor do all the cells in the range need to have data in them.

120 1 2 3 4 a 5] 7 g 9 10
1 2 3 4 a 5] g 9 10
1 2 3

In the below example, we are adding 10 to a range of cells.
16 1 2 3

a1} (R ENRE NN R N el el el el el el el e

Sample: myprimes

| 37 |The helow example runs the macro "myprimes” which

| 38 |has an initial range far 4 prime numbers bot will resize if

| 35 |the output is larger. Gradually increase the number in cell A42 and rerun the macra.
| 40 |CAUTION: Resizing will aver write any existing data in the target cells

Note If an Excel prompt says that this file contains macros, click Enable
Macros to run this example. See the Appendix B, “Troubleshooting” appendix
in this User’s Guide for details on enabling macros.
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Calling myplot

This illustration calls the function myplot with a value of 4. To execute the
function, make A7 (=myplot(4)) the active cell. Press F2 and then Enter.

Bl xlmultixls
A B c D E F G

Sample: myplot

In this simple example we are just plotting a line from 1 to whatever
number is supplied as an argument to the function in cell A7

ol

This procedure plots a line from 1 through 4 in a MATLAB Figure window.
This graphic can be manipulated similarly to the way one would manipulate
a figure in MATLAB. Some functionality, such as the ability to change line
style or color, 1s not available.

The calling cell contains 0 because the function does not return a value.

Calling mysum Four Different Ways
This illustration calls the function mysum in four different ways:

e The first (cell A14) takes the values 1 through 10, adds them, and returns
the result of 55 (=mysum(1,2,3,4,5,6,7,8,9,10)).

¢ The second (cell A19) takes a range object that is a range of cells
with the values 1 through 10, adds them, and returns the result of 55
(=mysum(B19:K19)).

¢ The third (cell A24) takes several range objects, adds them, and returns
the result of 120 (=mysum(B24:K24,B25:L25,B26:D26)). This illustration
demonstrates that the ranges do not need to be the same size and that all
the cells do not need a value.

¢ The fourth (cell A30) takes a combination of a range object and
explicitly stated values, adds them, and returns the result of 16
(=mysum(10,B30:D30)).
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Sample: mysum

[}

In the below example we are just adding up a series of numbers that
are explicitly stated.
55

In the below example we are just adding up a series of numbers that
are frorm a range of cells.
55 1 2 3 4 ] G 7 g a 10

In the below example, we are adding up 3 separate ranges of cells,
The ranges do not need to be the same size nor do all the cells in the range need to have data in thern.

120 1 2 3 4 a 5] 7 g 9 10
1 2 3 4 a 5] g 9 10
1 2 3

In the below example, we are adding 10 to a range of cells.
161 1 2 3

B S o o el el Bl el Bl el el el
S|~ || | kD = O 000~ M e L b —

This illustration runs when the Excel file is opened. To reactivate the
illustration, activate the appropriate cell. Then press F2 followed by Enter.

myprimes Macro

In this illustration, the macro myprimes calls the function myprimes.m with
an initial value of 10 in cell A42. The function returns all the prime numbers
less than 10 to cells B42 through E42.

»| Sample: myprimes

iThe below example runs the macro "myprimes” which

|38 |has an initial range for 4 prime numbers but will resize if

|39 |the output is larger. Gradually increase the number in cell A42 and rerun the macra.
|40 | CAUTION: Resizing will aver write any existing data in the target cells

41
142 107 3

To execute the macro, from the main Excel window (not the Visual Basic
Editor), open the Macro dialog box, by pressing the Alt and F8 keys
simultaneously, or by selecting Tools > Macro > Macros.

Select myprimes from the list and click Run.
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Sample: myprimes

[ERRREERN L)
om) =

[an]
=1

The below example runs the macro "myprimes" which

has an initial range for 4 prime numbers but will resize if

the output is larger. Gradually increase the number in cell A42 and rerun the macro.
CAUTION: Resizing will over write any existing data in the target cells

[ax}
o

[ax}
w0

o | | |
WM | =D

This function automatically resizes if the returned output is larger than the
output range specified. Change the value in cell A42 to a number larger than
10. Then rerun the macro. The output returns all prime numbers less than
the number you entered in cell A42.

Sample: myprimes

(SRR SRR ]
DM =

[an]
=1

The below example runs the macro "myprimes" which

has an initial range for 4 prime numbers but will resize if

the output is larger. Gradually increase the number in cell A42 and rerun the macro.
CAUTION: Resizing will over write any existing data in the target cells

[ax}
o

[ax}
w0

o |
—= |

5
S
(o]
(T3]
[a3]
:.I
o
=
@

H

Inspecting the Microsoft Visual Basic Code (Optional)

1 On the Microsoft Excel main window, select Tools > Macro > Visual Basic
Editor.

2 On the Microsoft Visual Basic, in the Project - VBAProject window,
double-click to expand VBAProject (xlmulti.xls)

3 Expand the Modules folder and double-click the Module1 module. This opens
the VB Code window with the code for this project.

For More Information

For more information about working with variable-length arguments, see
“Programming with Variable Arguments” on page 7-10.

6-10



Execute Add-in With the Function Wizard

Execute Add-in With the Function Wizard

In this section...

“Execute an Add-in to Validate Nongraphical Function Output” on page 6-11

“Execute a Graphical Function” on page 6-11

“Create Dialog Box and Error Message Macros” on page 6-15

Execute an Add-in to Validate Nongraphical Function
Output

If you have built your add-in and COM component using deploytool or mcc
and are ready to begin validating your non-graphical function’s output, see
“Executing Functions and Creating Macros Using the Function Wizard” on
page 4-2.

Functions Having Multiple Outputs

When working with functions having multiple outputs, simply define each
specific output range with the Argument Properties For y dialog box. See the
Argument Properties For y step in “Function Execution” on page 4-19 for
details.

Execute a Graphical Function

Execute a graphical function on a Microsoft Excel spreadsheet by doing the
following.

1 Install and start the Function Wizard using the procedures detailed in
“Installation of the Function Wizard” on page 4-29 and “Function Wizard
Start-Up” on page 4-5. Successfully completing each of these procedures
causes the Function Wizard Control Panel to display.
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Famide I
s |
2 Click Add.

3 Select a function with a graphical output, such as mysurf for example,
from the Functions for Class class_name box.

4 Click Add. The Function Properties dialog box appears.

5 Click Done. The Function Wizard Control Panel appears with mysurf
selected in the list of Active Functions.

Note Since mysurf.m does not have any inputs or outputs, there is no
need to specify Properties.
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Function Wizard Control Panel
L, ‘
— Setup Functions — Create Macros
Active Functions Inactive Functions

Macros will be created ko run the active functions, Ga ko Yiew

. tab -3 Macros to view or run a macra.
Add. ., ysurf

Macro Name
Edit. .. I

Stare Macra In

Up
| Bockl |
Dowin < Activate
Description

Delete Deactivate = I

Create Macro

[ Execute Functions

Active functions will be executed in the order specified above,

Execute

6 In the Execute Functions area of the Function Wizard Control Panel, click
Execute. The graphical output for mysurf appears in a separate window.
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6-14

Bl Figure 1 == ol =<~
File
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7 Test to ensure you can interact with the figure and that it is usable.

For example, try dragging the figure window, inserting color bars and
legends in the toolbar, and so on.

If you encounter problems working with the figure, consult the person who
created it (usually the MATLAB Programmer on page 4-25).

Create a Macro Using a Graphical Function
Once you are satisfied your graphical figure is usable, do the following to
create a macro to execute it at your convenience.
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Caution To create a macro, you must have already built your COM
component and add-in with MATLAB Builder EX.

For complete Function Wizard workflows, see “Executing Functions and
Creating Macros Using the Function Wizard” on page 4-2 and “End-to-End
Deployment of a MATLAB Function Using the Function Wizard” on page 4-24.

1 In the Function Wizard Control Panel, label the macro by entering mysurf
in the Macro Name field of the Create Macros area.

2 If desired, change the default value Book1 (for the default Excel sheet
name) in the Store Macro In field.

3 Click Create Macro.

4 See “Macro Execution” on page 4-52 for details on executing macros
with different versions of Microsoft Office. When the macro is Run, you
should see output similar to the Surf Peaks image in “Execute a Graphical
Function” on page 6-11 in this chapter.

Create Dialog Box and Error Message Macros

Create a macro that displays a dialog box using this workflow, which is useful
for error message presentation.

1 Install and start the Function Wizard using the procedures detailed in
“Installation of the Function Wizard” on page 4-29 and “Function Wizard
Start-Up” on page 4-5. Successfully completing each of these procedures
causes the Function Wizard Control Panel to display.
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_amom |

2 Click Add. The MATLAB Components dialog box appears.

| MATLAB Cormponents @.-
Availsble Components
Sedect a MATLAB Bulder EX Component

| wizcomp 1.0 |
Functions for Class wizclass

niryTnagic
mvysurf

Add I Cancel

3 Select a function that displays a graphical error message, such as myerror
for example, from the Functions for Class class_name box.

4 Click Add. The Function Properties dialog box appears.

5 Associate an input value of -1 with myerror.

a On the Inputs tab, click Properties. The Argument Properties for in
dialog box appears.

b Select Value and enter -1.
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¢ Click Done.

6 Define the output of myerror—any Excel spreadsheet cell, in this case.

a On the Outputs tab, click Properties. The Argument Properties For
x dialog box appears, where x is the name of the output variable you
are defining properties of.

b Select Range and enter and spreadsheet cell value, =C13, for example.

¢ Click Done. The Function Wizard Control Panel appears with myerror
selected in the list of Active Functions.

Tip If you have functions besides myerror listed in the Active
Functions list that you don’t want to execute when you test myerror,
deactivate these functions by selecting them and clicking Deactivate.

7 Click Execute. The following will display.

Micrasoft Excel =

Error in function ryerror: Error using ==3> myerror at 3
Negative input not expected
Errorin =3 myerror.m at line 3

(-

Create a Macro That Displays an Error Message or Dialog Box
Create a macro to display your error message on demand.

1 In the Function Wizard Control Panel, label the macro by entering myerror
in the Macro Name field of the Create Macros area.

2 If desired, change the default value Book1 (for the default Excel sheet
name) in the Store Macro In field.

3 Click Create Macro.

4 See “Macro Execution” on page 4-52 for details on executing macros with
different versions of Microsoft Office.
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Microsoft Excel Add-in
Integration

® “Overview of the Integration Process ” on page 7-2
® “Code Your Microsoft® Visual Basic® Application” on page 7-3
e “Build and Integrate with Spectral Analysis” on page 7-18

¢ “For More Information” on page 7-35
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Overview of the Integration Process

Each MATLAB Builder EX component is built as a COM object that you can
access from Microsoft Excel through Microsoft Visual Basic for Applications
(VBA). This topic provides general information on how to integrate the
MATLAB Builder EX components into Excel using the VBA programming
environment.

It assumes you have the skill set of a Microsoft® Excel® Developer on page 7-3
and have a working knowledge of VBA.

This section is not intended to teach you to program in Visual Basic. Refer
to the VBA documentation provided with Excel for general programming
information.

For a comprehensive example of building and integrating a COM component
using Visual Basic programming, see “Build and Integrate with Spectral
Analysis” on page 7-18.
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Code Your Microsoft Visual Basic Application

In this section...

“When to Use a Formula Function or a Subroutine” on page 7-3

“Initializing MATLAB® Builder™ EX Libraries with Microsoft® Excel®”
on page 7-4

“Creating an Instance of a Class” on page 7-5
“Calling the Methods of a Class Instance” on page 7-8
“Programming with Variable Arguments” on page 7-10

“Modifying Flags” on page 7-12

“Handling Errors During a Method Call” on page 7-17

Microsoft Excel Developer

Role Knowledge Base Responsibilities
‘ e Little to no MATLAB experience | ® Creates Microsoft Excel add-ins or
® Moderate to little IT experience i?;?leget golutlon S dloployedl
Microsoft L . code
Excel . gXpelr Lat 'f"“ld“:ig Mlcr‘(’f‘}’lﬂ o Integrates deployed MATLAB Figures
developer soﬁfﬁcioils “Ins and spreadsheet with Microsoft Excel add-ins or

spreadsheet solutions
® Minimal access to IT systems

® Varying knowledge of VBA or
COM

When to Use a Formula Function or a Subroutine

VBA provides two basic procedure types: functions and subroutines.
You access a VBA function directly from a cell in a worksheet as a formula

function. Use function procedures when the original MATLAB function takes
one or more inputs and returns zero outputs.
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You access a subroutine as a general macro. Use a subroutine procedure
when the original MATLAB function returns an array of values or multiple
outputs because you need to map these outputs into multiple cells/ranges
in the worksheet.

When you create a component, MATLAB Builder EX produces a VBA module
(.bas file). This file contains simple call wrappers, each implemented as a
function procedure for each method of the class.

Initializing MATLAB Builder EX Libraries with
Microsoft Excel

Before you use any MATLAB Builder EX component, initialize the supporting
libraries with the current instance of Microsoft Excel. Do this once for an
Excel session that uses the MATLAB Builder EX components.

To do this initialization, call the utility library function MWInitApplication,
which is a member of the MWUtil class. This class is part of the MWComUtil
library. See “Class MWUtil” on page 10-3 .

One way to add this initialization code into a VBA module is to provide

a subroutine that does the initialization once, and simply exits for all
subsequent calls. The following Microsoft Visual Basic code sample initializes
the libraries with the current instance of Excel. A global variable of type
Object named MCLUtil holds an instance of the MWUtil class, and another
global variable of type Boolean named bModuleInitialized stores the
status of the initialization process. The private subroutine InitModule ()
creates an instance of the MWComUtil class and calls the MWInitApplication
method with an argument of Application. Once this function succeeds, all
subsequent calls exit without reinitializing.

Dim MCLUtil As Object
Dim bModulelInitialized As Boolean

Private Sub InitModule()
If Not bModuleInitialized Then
On Error GoTo Handle_Error
If MCLUtil Is Nothing Then
Set MCLUtil = CreateObject("MWComUtil.MWUtil")
End If
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Call MCLUtil.MWInitApplication(Application)
bModuleInitialized = True
Exit Sub
Handle_Error:
bModuleInitialized = False
End If
End Sub

This code is similar to the default initialization code generated in the VBA
module created when the component is built. Each function that uses
MATLAB Builder EX components can include a call to InitModule at the
beginning to ensure that the initialization always gets performed as needed.

Creating an Instance of a Class

® “Overview” on page 7-5

e “CreateObject Function” on page 7-5

e “New Operator” on page 7-6

e “How the MCR Is Shared Among Classes” on page 7-7

Overview

Before calling a class method (compiled MATLAB function), you must
create an instance of the class that contains the method. VBA provides two
techniques for doing this:

® CreateObject function

® New operator

CreateObject Function

This method uses the Microsoft Visual Basic application programming
interface (API) CreateObject function to create an instance of the class.
Microsoft refers to calling CreateObject as late binding and using new as
early binding.

To use this method, declare a variable of type Object using Dim to hold
a reference to the class instance and call CreateObject using the class
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programmatic identifier (ProgID) as an argument, as shown in the next
example:

Function foo(x1 As Variant, x2 As Variant) As Variant
Dim aClass As Object

On Error Goto Handle_Error
Set aClass = CreateObject("mycomponent.myclass.1_0")
' (call some methods on aClass)
Exit Function
Handle_Error:
foo = Err.Description
End Function

New Operator

This method uses the Visual Basic New operator on a variable explicitly
dimensioned as the class to be created. Before using this method, you must
reference the type library containing the class in the current VBA project. Do
this by selecting the Tools menu from the Visual Basic Editor, and then
selecting References to display the Available References list. From this
list, select the necessary type library.

The following example illustrates using the New operator to create a class
instance. It assumes that you have selected mycomponent 1.0 Type
Library from the Available References list before calling this function.

Function foo(x1 As Variant, x2 As Variant) As Variant
Dim aClass As mycomponent.myclass

On Error Goto Handle_Error
Set aClass = New mycomponent.myclass
" (call some methods on aClass)
Exit Function
Handle_Error:
foo = Err.Description
End Function

In this example, the class instance can be dimensioned as simply myclass.
The full declaration in the form <component-name>.<class-name> guards
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against name collisions that can occur if other libraries in the current project
contain types named myclass.

Using both CreateObject and New produce a dimensioned class instance.
The first method does not require a reference to the type library in the VBA
project; the second results in faster code execution. The second method has the
added advantage of enabling the Auto-List-Members and Auto-Quick-Info
capabilities of the Microsoft Visual Basic editor to work with your classes.
The default function wrappers created with each built component all use

the first method for object creation.

In the previous two examples, the class instance used to make the method
call was a local variable of the procedure. This creates and destroys a new
class instance for each call. An alternative approach is to declare one single
module-scoped class instance that is reused by all function calls, as in the
initialization code of the previous example.

The following example illustrates this technique with the second method:

Dim aClass As mycomponent.myclass

Function foo(x1 As Variant, x2 As Variant) As Variant
On Error Goto Handle_Error
If aClass Is Nothing Then
Set aClass = New mycomponent.myclass
End If
" (call some methods on aClass)
Exit Function
Handle_Error:
foo = Err.Description
End Function

How the MCR Is Shared Among Classes

MATLAB Builder EX creates a single MATLAB Compiler Runtime (MCR)
when the first Microsoft COM class is instantiated in an application. This
MCR is reused and shared among all subsequent class instances within the
component, resulting in more efficient memory usage and eliminating the
MCR startup cost in each subsequent class instantiation.
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All class instances share a single MATLAB workspace and share global
variables in the MATLAB files used to build the component. This makes
properties of a COM class behave as static properties instead of instance-wise
properties.

Calling the Methods of a Class Instance

After you have created a class instance, you can call the class methods to
access the compiled MATLAB functions. MATLAB Builder EX applies a
standard mapping from the original MATLAB function syntax to the method’s
argument list. See “Referencing Utility Classes” on page 10-2 for a detailed
description of the mapping from MATLAB functions to COM class method
calls.

When a method has output arguments, the first argument is always nargout,
which 1s of type Long. This input parameter passes the normal MATLAB
nargout parameter to the compiled function and specifies how many outputs
are requested. Methods that do not have output arguments do not pass

a nargout argument. Following nargout are the output parameters listed

in the same order as they appear on the left side of the original MATLAB
function. Next come the input parameters listed in the same order as they
appear on the right side of the original MATLAB function. All input and
output arguments are typed as Variant, the default Visual Basic data type.

The Variant type can hold any of the basic VBA types, arrays of any type,
and object references. See “Data Conversion Rules ” on page A-2 for a detailed
description of how to convert Variant types of any basic type to and from
MATLAB data types. In general, you can supply any Visual Basic type as an
argument to a class method, with the exception of Visual Basic UDTs. You
can also pass Microsoft Excel Range objects directly as input and output
arguments.

When you pass a simple Variant type as an output parameter, the called
method allocates the received data and frees the original contents of the
Variant. In this case it is sufficient to dimension each output argument as
a single Variant. When an object type (like an Excel Range) is passed as an
output parameter, the object reference is passed in both directions, and the
object’s Value property receives the data.



Code Your Microsoft® Visual Basic® Application

The following examples illustrate the process of passing input and output
parameters from VBA to the MATLAB Builder EX component class methods.

The first example is a formula function that takes two inputs and returns one
output. This function dispatches the call to a class method that corresponds to
a MATLAB function of the form function y = foo(x1,x2).

Function foo(x1 As Variant, x2 As Variant) As Variant
Dim aClass As Object
Dim y As Variant

On Error Goto Handle_Error
Set aClass = New mycomponent.myclass
aClass = CreateObject("mycomponent.myclass.1_0")
Call aClass.foo(1,y,x1,x2)
foo =y
Exit Function
Handle_Error:
foo = Err.Description
End Function

The second example rewrites the same function as a subroutine and uses
Excel ranges for input and output.

Sub foo(Rout As Range, Rin1 As Range, Rin2 As Range)
Dim aClass As Object

On Error Goto Handle_Error
aClass = CreateObject("mycomponent.myclass.1_0")
Call aClass.foo(1,Rout,Rin1,Rin2)
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub
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Programming with Variable Arguments

Processing varargin and varargout Arguments

When varargin and/or varargout are present in the MATLAB function that
you are using for the Excel component, these parameters are added to the
argument list of the class method as the last input/output parameters in the
list. You can pass multiple arguments as a varargin array by creating a
Variant array, assigning each element of the array to the respective input
argument.

The following example creates a varargin array to call a method resulting
from a MATLAB function of the form y = foo(varargin):

Function foo(x1 As Variant, x2 As Variant, x3 As Variant, _
x4 As Variant, x5 As Variant) As Variant
Dim aClass As Object
Dim v As Variant
Dim y As Variant
Dim MCLUtil As Object

On Error GoTo Handle_Error
set aClass = CreateObject("mycomponent.myclass.1_0")
Set MCLUtil = CreateObject("MWComUtil.MWUtil")
Call MCLUtil.MwPack(v, x1, x2, x3, x4, x5)
Call aClass.foo(1, y, V)
foo =y
Exit Function
Handle_Error:
foo = Err.Description
End Function

The MWUtil class included in the MWComUtil utility library provides the
MWPack helper function to create varargin parameters. See for more details.

The next example processes a varargout parameter into three separate Excel
Ranges. This function uses the MWUnpack function in the utility library. The
MATLAB function used is varargout = foo(x1,x2).

Sub foo(Rout1 As Range, Rout2 As Range, Rout3 As Range, _
Rin1 As Range, Rin2 As Range)
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Dim aClass As Object
Dim aUtil As Object
Dim v As Variant

On Error Goto Handle_ Error
aUtil = CreateObject("MWComUtil.MWUtil")
aClass = CreateObject("mycomponent.myclass.1_0")
Call aClass.foo(3,v,Rin1,Rin2)
Call aUtil.MwUnpack(v,0,True,Rout1,Rout2,Rout3)
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub

Passing an Empty varargin from Microsoft Visual Basic Code

In MATLAB, varargin inputs to functions are optional, and may be present
or omitted from the function call. However, from Microsoft Visual Basic,
function signatures are more strict—if varargin is present among the
MATLAB function inputs, the VBA call must include varargin, even if you
want it to be empty. To pass in an empty varargin, pass the Null variant,
which is converted to an empty MATLAB cell array when passed.

Passing an Empty varargin from VBA Code. The following example
illustrates how to pass the null variant in order to pass an empty varargin:

Function foo(x1 As Variant, x2 As Variant, x3 As Variant, _
x4 As Variant, x5 As Variant) As Variant
Dim aClass As Object
Dim v(1 To 5) As Variant
Dim y As Variant

On Error Goto Handle_Error

v(1) = x1
v(2) = x2
v(3) = x3
v(4) = x4
v(5) = x5

aClass = CreateObject("mycomponent.myclass.1_0")
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'Call aClass.foo(1,y,V)
Call aClass.foo(1,y,Null)

foo =y

Exit Function
Handle_Error:

foo = Err.Description
End Function

For More Information

For more information about working with variable-length arguments, see
“Work with Variable-Length Inputs and Outputs” on page 6-5.

Modifying Flags

* “Overview” on page 7-12
e “Array Formatting Flags” on page 7-13

e “Data Conversion Flags” on page 7-15

Overview

Each MATLAB Builder EX component exposes a single read/write property
named MWFlags of type MWFlags. The MWFlags property consists of two sets of
constants: array formatting flags and data conversion flags. Array formatting
flags affect the transformation of arrays, whereas data conversion flags deal
with type conversions of individual array elements.

The data conversion flags change selected behaviors of the data conversion
process from Variants to MATLAB types and vice versa. By default, the
MATLAB Builder EX components allow setting data conversion flags at

the class level through the MWFlags class property. This holds true for all
Visual Basic types, with the exception of the MATLAB Builder EX MWStruct,
MWField, MWComplex, MWSparse, and MWArg types. Each of these types exposes
its own MWFlags property and ignores the properties of the class whose method
is being called. The MWArg class is supplied specifically for the case when a
particular argument needs different settings from the default class properties.
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This section provides a general discussion of how to set these flags and what
they do. See “Class MWFlags” for a detailed discussion of the MWFlags type,
as well as additional code samples.

Array Formatting Flags

Array formatting flags guide the data conversion to produce either a MATLAB
cell array or matrix from general Variant data on input or to produce an array
of Variants or a single Variant containing an array of a basic type on output.

The following examples assume that you have referenced the MWComUtil
library in the current project by selecting Tools > References and selecting
MWComUtil 7.5 Type Library from the list:

Sub foo( )
Dim aClass As mycomponent.myclass
Dim vari(1 To 2, 1 To 2), var2 As Variant
Dim x(1 To 2, 1 To 2) As Double
Dim y1,y2 As Variant

On Error Goto Handle_Error

vari(1,1) = 11#
vari(1,2) = 12#
vari(2,1) = 21#
vari(2,2) = 22#
x(1,1) = 11
x(1,2) =12
x(2,1) = 21
x(2,2) = 22
var2 = x

Set aClass = New mycomponent.myclass
Call aClass.foo(1,y1,var1)
Call aClass.foo(1,y2,var2)
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub
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In addition, these examples assume you have referenced the COM object
created with Builder EX (mycomponent) as mentioned in “New Operator”
on page 7-6.

Here, two Variant variables, var1 and var2 are constructed with the same
numerical data, but internally they are structured differently: vari is a
2-by-2 array of Variants with each element containing a 1-by-1 Double, while
var2is a 1-by-1 Variant containing a 2-by-2 array of Doubles.

In MATLAB Builder EX , when using the default settings, both of these
arrays will be converted to 2-by-2 arrays of doubles. This does not follow the
general convention listed in COM VARIANT to the MATLAB Conversion
Rules. According to these rules, vari1 converts to a 2-by-2 cell array with
each cell occupied by a 1-by-1 double, and var2 converts directly to a 2-by-2
double matrix.

The two arrays both convert to double matrices because the default value for
the InputArrayFormat flag is mwArrayFormatMatrix. The InputArrayFormat
flag controls how arrays of these two types are handled. This default is used
because array data originating from Excel ranges is always in the form of an
array of Variants (like var1 of the previous example), and MATLAB functions
most often deal with matrix arguments.

But what if you want a cell array? In this case, you set the InputArrayFormat
flag to mwArrayFormatCell. Do this by adding the following line after creating
the class and before the method call:

aClass.MWFlags.ArrayFormatFlags.InputArrayFormat =
mwArrayFormatCell

Setting this flag presents all array input to the compiled MATLAB function as
cell arrays.

Similarly, you can manipulate the format of output arguments using the
OutputArrayFormat flag. You can also modify array output with the
AutoResizeOutput and TransposeOutput flags.

AutoResizeOutput is used for Excel Range objects passed directly as output
parameters. When this flag is set, the target range automatically resizes to fit
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the resulting array. If this flag is not set, the target range must be at least as
large as the output array or the data is truncated.

The TransposeOutput flag transposes all array output. This flag is useful
when dealing with MATLAB functions that output one-dimensional arrays.
By default, MATLAB realizes one-dimensional arrays as 1-by-n matrices (row
vectors) that become rows in an Excel worksheet.

Tip If your MATLAB function is specifically returning a row vector, for
example, ensure you assign a similar row vector of cells in Excel.

You may prefer worksheet columns from row vector output. This example
auto-resizes and transposes an output range:

Sub foo(Rout As Range, Rin As Range )
Dim aClass As mycomponent.myclass

On Error Goto Handle_Error
Set aClass = New mycomponent.myclass
aClass.MWFlags.ArrayFormatFlags.AutoResizeOutput = True
aClass.MWFlags.ArrayFormatFlags.TransposeOutput = True
Call aClass.foo(1,Rout,Rin)
Exit Sub

Handle_Error:
MsgBox (Err.Description)

End Sub

Data Conversion Flags

Data conversion flags deal with type conversions of individual array elements.
The two data conversion flags, CoerceNumericToType and InputDateFormat,
govern how numeric and date types are converted from VBA to MATLAB.
Consider the example:

Sub foo( )
Dim aClass As mycomponent.myclass
Dim vari, var2 As Variant
Dim y As Variant

7-15



7 Microsoft® Excel® Add-in Integration

7-16

On Error Goto Handle Error
vari = 1
var2 = 2#
Set aClass = New mycomponent.myclass
Call aClass.foo(1,y,varti,var2)
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub

This example converts var1i of type Variant/Integer to an int16 and var2 of
type Variant/Double to a double.

If the original MATLAB function expects doubles for both arguments, this
code might cause an error. One solution is to assign a double to vari, but this
may not be possible or desirable. In such a case set the CoerceNumericToType
flag to mwTypeDouble, causing the data converter to convert all numeric input
to double. In the previous example, place the following line after creating the
class and before calling the methods:

aClass.MWFlags.DataConversionFlags.CoerceNumericToType =
mwTypeDouble

The InputDateFormat flag controls how the VBA Date type is converted.
This example sends the current date and time as an input argument and
converts it to a string:

Sub foo( )
Dim aClass As mycomponent.myclass
Dim today As Date
Dim y As Variant

On Error Goto Handle_Error

today = Now

Set aClass = New mycomponent.myclass

aClass. MWFlags.DataConversionFlags.InputDateFormat =
mwDateFormatString

Call aClass.foo(1,y,today)

Exit Sub
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Handle_Error:
MsgBox (Err.Description)
End Sub

Handling Errors During a Method Call

Errors that occur while creating a class instance or during a class method
create an exception in the current procedure. Microsoft Visual Basic provides
an exception handling capability through the On Error Goto <label>
statement, in which the program execution jumps to <label> when an error
occurs. (<label> must be located in the same procedure as the On Error
Goto statement). All errors are handled this way, including errors within
the original MATLAB code. An exception creates a Visual Basic ErrObject
object in the current context in a variable called Err. (See the Visual Basic for
Applications documentation for a detailed discussion on VBA error handling.)
All of the examples in this section illustrate the typical error trapping logic
used in function call wrappers for MATLAB Builder EX components.
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Build and Integrate with Spectral Analysis

In this section...

“Overview” on page 7-18

“Building the Component” on page 7-19

“Integrating the Component Using VBA” on page 7-20
“Testing the Add-in” on page 7-29

“Packaging and Distributing the Add-in” on page 7-32
“Installing the Add-in” on page 7-34

Overview

This example illustrates the creation of a comprehensive Excel add-in to
perform spectral analysis. It requires knowledge of Visual Basic forms and
controls, as well as Excel workbook events. See the VBA documentation for a
complete discussion of these topics.

The example creates an Excel add-in that performs a fast Fourier transform
(FFT) on an input data set located in a designated worksheet range. The
function returns the FFT results, an array of frequency points, and the power
spectral density of the input data. It places these results into ranges you
indicate in the current worksheet. You can also optionally plot the power
spectral density.

You develop the function so that you can invoke it from the Excel Tools menu
and can select input and output ranges through a GUI.

Creating the add-in requires four basic steps:

1 Build a standalone COM component from the MATLAB code.

2 Implement the necessary VBA code to collect input and dispatch the calls
to your component.

3 Create the GUI.
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4 Create an Excel add-in and package all necessary components for
application deployment.

Building the Component

Your component will have one class with two methods:

e computefft — computes the FFT and power spectral density of the input
data and computes a vector of frequency points based on the length of the
data entered and the sampling interval

® plotfft — performs the same operations as computefft, but also plots the
input data and the power spectral density in a MATLAB Figure window

Note The MATLAB code for these two functions resides in two MATLAB
files, computefft.m and plotfft.m.

The code for computefft.m:

function [fftdata, freq, powerspect] =
computefft(data, interval)
if (isempty(data))
fftdata = [1];
freq = [1;
powerspect = [];
return;
end
if (interval <= 0)
error('Sampling interval must be greater than zero');
return;
end
fftdata = fft(data);
freq = (0:length(fftdata)-1)/(length(fftdata)*interval);
powerspect = abs(fftdata)/(sqrt(length(fftdata)));

The code for plotfft.m.m:

function [fftdata, freq, powerspect] = plotfft(data, interval)
[fftdata, freq, powerspect] = computefft(data, interval);
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len = length(fftdata);
if (len <= 0)

return;
end
t = O:interval: (len-1)*interval;
subplot(2,1,1), plot(t, data)
xlabel('Time'), grid on
title('Time domain signal')
subplot(2,1,2), plot(freq(i1:1len/2), powerspect(1:1len/2))
xlabel('Frequency (Hz)'), grid on
title('Power spectral density')

Build the COM component using the Library Compiler app and the following
settings.To proceed with the actual building of the component:

Setting Value

Component name Fourier

Class name Fourier

Project folder The name of your work folder followed by the
component name

Show verbose Selected

output

See the instructions in “Create a Microsoft® Excel® Add-In and COM
Component from MATLAB Code” on page 1-12 for more information.

Where Is the Example Code?

See “Example File Copying” on page 4-28 for information about accessing the
example code from within the product.

Integrating the Component Using VBA

Having built your component, you can implement the necessary VBA code to
integrate it into Excel.
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Note To use Fourier.xla directly in the folder x1spectral (see “Example
File Copying” on page 4-28) add references to Fourier 1.0 Type Library
and MWComUtil 7.X Type Library.

Selecting the Libraries
To open Excel and select the libraries you need to develop the add-in:

Start Excel on your system.
From the Excel main menu, select Tools > Macro > Visual Basic Editor.

When the Visual Basic Editor starts, select Tools > References to open the
Project References dialog box.

Select Fourier 1.0 Type Library and MWComUtil 7.x Type Library from
the list.

Creating the Main VB Code Module for the Application. The add-in
requires some initialization code and some global variables to hold the
application’s state between function invocations. To achieve this, implement a
Visual Basic code module to manage these tasks:

Right-click the VBAProject item in the project window and select
Insert > Module.

A new module appears under Modules in the VBA Project.
In the module’s property page, set the Name property to FourierMain.

Enter the following code in the FourierMain module:

' FourierMain - Main module stores global state of controls

and provides initialization code

Public theFourier As Fourier.Fourier 'Global instance of Fourier object
Public theFFTData As MWComplex 'Global instance of MWComplex to accept FFT
Public InputData As Range 'Input data range

Public Interval As Double 'Sampling interval
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Public Frequency As Range 'Output frequency data range

Public PowerSpect As Range 'Output power spectral density range
Public bPlot As Boolean 'Holds the state of plot flag

Public theUtil As MWUtil 'Global instance of MWUtil object
Public bInitialized As Boolean 'Module-is-initialized flag

Private Sub LoadFourier()
'Initializes globals and Loads the Spectral Analysis form
Dim MainForm As frmFourier
On Error GoTo Handle_Error
Call InitApp
Set MainForm = New frmFourier
Call MainForm.Show
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub

Private Sub InitApp()
'Initializes classes and libraries. Executes once
'for a given session of Excel
If bInitialized Then Exit Sub
On Error GoTo Handle_Error
If theUtil Is Nothing Then
Set theUtil = New MWUtil
Call theUtil.MWInitApplication(Application)
End If
If theFourier Is Nothing Then
Set theFourier = New Fourier.Fourierclass
End If
If theFFTData Is Nothing Then
Set theFFTData = New MWComplex
End If
bInitialized = True
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub
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Creating the Visual Basic Form

The next step in the integration process develops a user interface for your

add-in using the Visual Basic Editor. To create a new user form and populate

it with the necessary controls:

Right-click VBAProject in the VBA project window and select
Insert > UserForm.

A new form appears under Forms in the VBA project window.

In the form’s property page, set the Name property to frmFourier and the
Caption property to Spectral Analysis.

Add a series of controls to the blank form to complete the dialog box, as
summarized in the following table:

Controls Needed for Spectral Analysis Example

Control Type

Control Name

Properties

Purpose

CheckBox chkPlot Caption = Plot Plots input
time domain data and power
signal and spectral density.
power spectral
density

CommandButton btnOK Caption = OK Executes the
Default = True fl.mCt.lon et

dismisses the
dialog box.

CommandButton btnCancel Caption =Cancel | Dismisses

_ the dialog
Cemeel = thave box without
executing the
function.

Frame Frame1 Caption = Input | Groups all input
Data controls.

Frame Frame2 Caption =0utput | Groups all

Data

output controls.
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Controls Needed for Spectral Analysis Example (Continued)

Control Type Control Name | Properties Purpose
Label Labeld Caption = Input | Labels the
Data: RefEdit for
input data.
TextBox edtSample Not applicable Not applicable
Label Label?2 Caption = Labels the
Sampling TextBox for
Interval sampling
interval.
Label Label3 Caption = Labels the
Frequency: RefEdit for
frequency
output.
Label Label4d Caption = FFT - | Labels the
Real Part: RefEdit for real
part of FFT.
Label Label5 Caption = FFT Labels the
- Imaginary RefEdit for
Part: imaginary part
of FFT.
Label Label6 Caption = Labels the
Power Spectral | RefEdit for
Density power spectral
density.
RefEdit refedtInput Not applicable Selects range for
input data.
RefEdit refedtFreq Not applicable Selects output
range for
frequency points.
RefEdit refedtReal Not applicable Selects output

range for real
part of FFT of
input data.

7-24



Build and Integrate with Spectral Analysis

Controls Needed for Spectral Analysis Example (Continued)

Control Type Control Name | Properties Purpose
RefEdit refedtImag Not applicable Selects output
range for

imaginary part
of FFT of input
data.

RefEdit refedtPowSpect | Not applicable Selects output

range for power
spectral density
of input data.

4 When the form and controls are complete, right-click the form and select
View Code.

The following code listing shows the code to implement. Notice that this
code references the control and variable names listed in Controls Needed for
Spectral Analysis Example on page 7-23. If you used different names for
any of the controls or any global variable, change this code to reflect those
differences.

'frmFourier Event handlers
Private Sub UserForm_Activate()
'UserForm Activate event handler. This function gets called before
'showing the form, and initializes all controls with values stored
"in global variables.
On Error GoTo Handle_Error
If theFourier Is Nothing Or theFFTData Is Nothing Then Exit Sub
'Initialize controls with current state
If Not InputData Is Nothing Then
refedtInput.Text = InputData.Address
End If
edtSample.Text = Format(Interval)
If Not Frequency Is Nothing Then
refedtFreq.Text = Frequency.Address
End If
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If Not IsEmpty (theFFTData.Real) Then
If IsObject(theFFTData.Real) And TypeOf theFFTData.Real Is Range Then
refedtReal.Text = theFFTData.Real.Address
End If
End If
If Not IsEmpty (theFFTData.Imag) Then
If IsObject(theFFTData.Imag) And TypeOf theFFTData.Imag Is Range Then
refedtImag.Text = theFFTData.Imag.Address
End If
End If
If Not PowerSpect Is Nothing Then
refedtPowSpect.Text = PowerSpect.Address
End If
chkPlot.Value = bPlot
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub

Private Sub btnCancel_Click()
'Cancel button click event handler. Exits form without computing fft
'or updating variables.
Unload Me
End Sub
Private Sub btnOK_Click()
'OK button click event handler. Updates state of all variables from controls
'and executes the computefft or plotfft method.
Dim R As Range

If theFourier Is Nothing Or theFFTData Is Nothing Then GoTo Exit_Form

On Error Resume Next

'Process inputs

Set R = Range(refedtInput.Text)

If Err <> 0 Then
MsgBox ("Invalid range entered for Input Data")
Exit Sub

End If

Set InputData = R

Interval = CDbl(edtSample.Text)

If Err <> 0 Or Interval <= 0 Then
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MsgBox ("Sampling interval must be greater than zero")
Exit Sub
End If
'Process Outputs
Set R = Range(refedtFreq.Text)
If Err = 0 Then
Set Frequency = R
End If
Set R = Range(refedtReal.Text)
If Err = 0 Then
theFFTData.Real = R
End If
Set R = Range(refedtImag.Text)
If Err = 0 Then
theFFTData.Imag = R
End If
Set R = Range(refedtPowSpect.Text)
If Err = 0 Then
Set PowerSpect = R
End If
bPlot = chkPlot.Value
‘Compute the fft and optionally plot power spectral density
If bPlot Then
Call theFourier.plotfft(3, theFFTData, Frequency, PowerSpect, _
Inputbata, Interval)
Else
Call theFourier.computefft (3, theFFTData, Frequency, PowerSpect, _
InputbData, Interval)
End If
GoTo Exit_Form
Handle_Error:
MsgBox (Err.Description)
Exit_Form:
Unload Me
End Sub

Adding the Spectral Analysis Menu ltem to Excel

The last step in the integration process adds a menu item to Excel so that you
can open the tool from the Excel Tools menu. To do this, add event handlers
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for the workbook’s AddinInstall and AddinUninstall events that install
and uninstall menu items. The menu item calls the LoadFourier function
in the FourierMain module.

To implement the menu item:

1 Right-click the ThisWorkbook item in the VBA project window and select
View Code.

2 Place the following code into ThisWorkbook.

Private Sub Workbook_ AddinInstall()

'Called when Addin is installed
Call AddFourierMenuItem

End Sub

Private Sub Workbook_AddinUninstall()

'Called when Addin is uninstalled
Call RemoveFourierMenuItem

End Sub

Private Sub AddFourierMenuItem()
Dim ToolsMenu As CommandBarPopup
Dim NewMenuItem As CommandBarButton

'Remove if already exists

Call RemoveFourierMenuItem

'Find Tools menu

Set ToolsMenu = Application.CommandBars(1).FindControl(ID:=30007)
If ToolsMenu Is Nothing Then Exit Sub

'Add Spectral Analysis menu item

Set NewMenuItem = ToolsMenu.Controls.Add(Type:=msoControlButton)

NewMenuItem.Caption = "Spectral Analysis..."
NewMenuItem.OnAction = "LoadFourier"
End Sub

Private Sub RemoveFourierMenuItem()
Dim CmdBar As CommandBar

Dim Ctrl As CommandBarControl

On Error Resume Next
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'Find tools menu and remove Spectral Analysis menu item
Set CmdBar = Application.CommandBars(1)

Set Ctrl = CmdBar.FindControl(ID:=30007)

Call Ctrl.Controls("Spectral Analysis...").Delete

End Sub

Save the add-in into the <project-folder>\for_testing folder that Library
Compiler created when building the project.

<project-folder> refers to the project folder that Library Compiler used
to save the Fourier project.

Name the add-in Spectral Analysis.

a From the Excel main menu, select File > Properties.

b When the Workbook Properties dialog box appears, click the Summary
tab, and enter Spectral Analysis as the workbook title.

¢ Click OK to save the edits.
d From the Excel main menu, select File > Save As.

e When the Save As dialog box appears, select Microsoft Excel Add-In
(*.xla) as the file type, and browse to <project-folder>\for_testing.

f Enter Fourier.xla as the file name and click Save to save the add-in.

Testing the Add-in

Before distributing the add-in, test it with a sample problem.

Spectral analysis is commonly used to find the frequency components of a
signal buried in a noisy time domain signal. In this example you will create a
data representation of a signal containing two distinct components and add
to it a random component. This data along with the output will be stored in
columns of an Excel worksheet, and you will plot the time-domain signal
along with the power spectral density.

Creating the Test Problem
Follow these steps to create the test problem:
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Start a new session of Excel with a blank workbook.
From the main menu, select Tools > Add-Ins.
When the Add-Ins dialog box appears, click Browse.

Browse to the <project-folder>\for_testing folder, select Fourier.xla,
and click OK.

The Spectral Analysis add-in appears in the available Add-Ins list and is
selected.

Click OK to load the add-in.

This add-in installs a menu item under the Excel Tools menu. You can display
the Spectral Analysis GUI by selecting Tools > Spectral Analysis. Before
invoking the add-in, create some data, in this case a signal with components
at 15 and 40 Hz. Sample the signal for 10 seconds at a sampling rate of 0.01 s.
Put the time points into column A and the signal points into column B.

Creating the Data

To create the data:

Enter 0 for cell Al in the current worksheet.

Click cell A2 and type the formula "= A1 + 0.01".

Click and hold the lower-right corner of cell A2 and drag the formula down
the column to cell A1001. This procedure fills the range A1:A1001 with the
interval O to 10 incremented by 0.01.

Click cell B1 and type the following formula
"= SIN(2*PI()*15*A1) + SIN(2*PI()*40*A1) + RAND()"

Repeat the drag procedure to copy this formula to all cells in the range
B1:B1001.

Running the Test
Using the column of data (column B), test the add-in as follows:
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Select Tools > Spectral Analysis from the main menu.
Click the Input Data box.

Select the B1:B1001 range from the worksheet, or type this address into the
Input Data field.

In the Sampling Interval field, type 0.01.
Select Plot time domain signal and power spectral density.

Enter C1:C1001 for frequency output, and likewise enter D1:D1001, E1:E1001,
and F1:F1001 for the FFT real and imaginary parts, and spectral density.

Click OK to run the analysis.

The next figure shows the output.
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The power spectral density reveals the two signals at 15 and 40 Hz.

Packaging and Distributing the Add-in

As a final step, package the add-in, the COM component, and all supporting
libraries into a self-extracting executable. This package can be installed onto
other computers that need to use the Spectral Analysis add-in.

1 On the Main File section of the tool strip choose one of the two options
described in the following table.
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Option

What Does This Option Do?

When Should 1 Use This
Option?

Runtime downloaded from
web

The MCR installer downloads
the MCR from the Mathwork’s
Web site.

®* You have a large number
of end users who deploy
applications frequently

®* Your users have
internet/network access

® Resources such as disk
space, performance,
and processing time are
significant concerns for your
organization

Runtime included in
package

The MCR is included in the
generated installer. The MCR
installer uses the included
MCR.

® You have a limited number
of end users who deploy
a small number of
applications at sporadic
intervals

¢ Your users have no
internet/network access

® Resources such as disk
space, performance, and
processing time are not
significant concerns

Note Distributing the
MCR with the application
requires more resources.

For more information about the role the MCR plays in the deployment
process, see “Distributing MATLAB Code Using the MATLAB Compiler
Runtime (MCR)” on page 8-2.

2 Add others files you feel may be useful to end users.
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To package additional files or folders, add them to the Files installed
with your application field. See “Specify Files to Install with the
Application” on page 2-8.

3 Click Package.

Installing the Add-in

To install this add-in onto another computer, copy the Fourier_pkg.exe
package to that machine, run it from a command prompt, and follow the
instructions in the readme. txt file that is automatically generated with your
packaged output.



For More Information

For More Information

For more information about...

See...

Functions available through
MATLAB Builder EX

Function reference in MATLAB
Builder EX documentation

Utility functions you can use to
customize COM components created
with MATLAB Builder EX

“Referencing Utility Classes” on
page 10-2
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¢ “Distribute Your Add-Ins and COM Components to End Users” on page 8-2
¢ “Deploying Your Microsoft® Visual Basic® Application” on page 8-5

¢ “For More Information” on page 8-17
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Distribute Your Add-Ins and COM Components to End
Users

Distributing MATLAB Code Using the MATLAB
Compiler Runtime (MCR)

On target computers without MATLAB, install the MCR, if it is not already
present on the deployment machine.

Install MATLAB Compiler Runtime (MCR)

The MATLAB Compiler Runtime (MCR) 1s an execution engine made up of
the same shared libraries MATLAB uses to enable execution of MATLAB files
on systems without an installed version of MATLAB.

The MATLAB Compiler Runtime (MCR) is now available for downloading
from the Web to simplify the distribution of your applications or components
created with the MATLAB Compiler. Download the MCR from the MATLAB
Compiler Runtime product page.

The MCR installer does the following:

1 Installs the MCR (if not already installed on the target machine)

2 Installs the component assembly in the folder from which the installer is
run

3 Copies the MWArray assembly to the Global Assembly Cache (GAC), as
part of installing the MCR

MCR Prerequisites

1 Since installing the MCR requires write access to the system registry,
ensure you have administrator privileges to run the MCR Installer.

2 The version of the MCR that runs your application on the target computer
must be compatible with the version of MATLAB Compiler that built the
component.
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3 Do not install the MCR in MATLAB installation directories.

4 The MCR installer requires approximately 2 GB of disk space.

Add the MCR Installer to the Installer

This example shows how to include the MCR in the generated installer, using
one of the compiler apps. The generated installer contains all files needed

to run the standalone application or shared library built with MATLAB

Compiler and properly lays they out on a target system.

1 On the Packaging Options section of the compiler interface, select one or
both of the following options:

¢ Runtime downloaded from web — This option builds an installer
that invokes the MCR installer from the MathWorks Web site.

¢ Runtime included in package — The option includes the MCR
installer into the generated installer.

2 Click Package.

3 Distribute the installer as needed.

Install the MCR
This example shows how to install the MATLAB Compiler Runtime (MCR)

on a system.

If you are given an installer containing the compiled artifacts, then the MCR
1s installed along with the application or shared library. If you are given
just the raw binary files, download the MCR installer from the Web and run

the installer.
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Note If you are running on a platform other than Windows, set the system
paths on the target machine. Setting the paths enables your application to
find the MCR.

Windows paths are set automatically. On Linux and Mac, you can use the
run script to set paths. See “Using MATLAB Compiler on Mac or Linux” for
detailed information on performing all deployment tasks specifically with
UNIX variants such as Linux and Mac.
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Deploying Your Microsoft Visual Basic Application

In this section...
“Calling Compiled MATLAB Functions from Microsoft® Excel®” on page 8-5

“Improving Data Access Using the MCR User Data Interface, COM
Components, and MATLAB® Builder™ EX” on page 8-7

“MCR Component Cache and CTF Archive Embedding” on page 8-13
“MCR Run-Time Options” on page 8-16

Calling Compiled MATLAB Functions from Microsoft
Excel

In order to call compiled MATLAB functions from within a Microsoft Excel
spreadsheet, perform the following from the Development and Deployment
machines, as specified.

Note In order for a function to be called using the Microsoft Excel function
syntax (=myfunction(input)), the MATLAB function must return a single
scalar output argument.

Perform the following steps on the Development machine:

1 Create the following MATLAB functions in three separate files named
doubleit.m, incrementit.m, and powerit.m, respectively:

function output = doubleit(input)
output = input * 2;

function output = incrementit(inputi, input2)
output = inputil + input2;

function output = powerit(inputi, input2)
output = power(inputi1, input2);

2 Start the Library Compiler.
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3 Use the following information as you work through this example using the
instructions in “Create a Microsoft® Excel® Add-In and COM Component
from MATLAB Code” on page 1-12:

Application Name myexcelfunctions

Class Name myexcelfunctionsclass

Exported Functions doubleit.m incrementit.m
powerit.m

Perform the following steps on the Deployment machine:

1 Copy the contents of for_redistribution files only to the deployment
machine(s). Copy the file to a standard place for use with Microsoft
Excel, such as Office Installation_ folder\Library\MATLAB
where Office Installation folder is a folder such as C:\Program
Files\Microsoft Office\OFFICE11.

2 Install the MATLAB Compiler Runtime.

3 Register myexcelfunctions_1_0.d1l.

Caution You need to re-register your DLL file if you move it following its
creation. Unlike DLL files, Excel files can be moved anywhere at anytime.

4 Start Microsoft Excel. The spreadsheet Book1 should be open by default.

5 In Excel, select Tools > Visual Basic Editor. The Microsoft Visual Basic
Editor starts.

6 In the Microsoft Visual Basic Editor, select File > Import File.

7 Browse to myexcelfunctions.bas and click Open. In the Project Explorer,
Modulel appears under the Modules node beneath VBAProject
(Book1).

8 In the Microsoft Visual Basic Editor, select View > Microsoft Excel. You
can now use the doubleit, incrementit, and powerit functions in your
Book1 spreadsheet.
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9 Test the functions, by doing the following:
a Enter =doubleit(2.5) in cell Al.
b Enter =incrementit(11,17) in cell A2.

¢ Enter =powerit(7,2) in cell A3.
You should see values 5, 28, and 49 in cells A1, A2, and A3 respectively.

10 To use the doubleit, powerit, and incrementit functions in all your new
Microsoft Excel spreadsheets, do the following:

a Select File > Save As.

b Change the Save as type option to .xIlt (Template).

¢ Browse to the Office_Installation_folder\XLSTART folder.

d Save the file as Office_Installation_folder\XLSTART\Book.xL1t.

Note Your Microsoft Excel Macro Security level must be set at Medium
or Low to save this template.

Where Is the Example Code?

See “Example File Copying” on page 4-28 for information about accessing the
example code from within the product.

Improving Data Access Using the MCR User Data
Interface, COM Components, and MATLAB Builder EX

e “Overview” on page 8-7

® “Supplying Run-Time Profile Information for Parallel Computing Toolbox
Applications” on page 8-8

Overview

This feature provides a lightweight interface for easily accessing MCR data.
It allows data to be shared between an MCR instance, the MATLAB code
running on that MCR, and the wrapper code that created the MCR. Through
calls to the MCR User Data interface API, you access MCR data by creating
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a per-MCR-instance associative array of mxArrays, consisting of a mapping
from string keys to mxArray values. Reasons for doing this include, but are
not limited to:

® You need to supply run-time profile information to a client running
an application created with the Parallel Computing Toolbox. Profile
information may be supplied (and change) on a per-execution basis. For
example, two instances of the same application may run simultaneously
with different profiles.

® You want to initialize the MCR with constant values that can be accessed
by all your MATLAB applications.

* You want to set up a global workspace — a global variable or variables that
MATLAB and your client can access.

® You want to store the state of any variable or group of variables.

MATLAB Builder EX supports per-MCR instance state access through an
object-oriented API. Unlike MATLAB Compiler, access to per-MCR instance
state is optional, rather than on by default. You can access this state by
adding setmcruserdata.m and getmcruserdata.m to your deployment project
or by specifying them on the command line. Alternately, you use a helper
function to call these methods, as shown in “Supplying Run-Time Profile
Information for Parallel Computing Toolbox Applications” on page 8-8.

For more information, see the MATLAB Compiler User’s Guide.

Supplying Run-Time Profile Information for Parallel Computing
Toolbox Applications

Following is a complete example of how you can use the MCR User Data
Interface as a mechanism to specify a profile for Parallel Computing Toolbox
applications.

Note Standalone executables and shared libraries generated from MATLAB
Compiler for parallel applications can now launch up to twelve local workers
without MATLAB Distributed Computing Server™.,
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Step 1: Write Your Parallel Computing Toolbox™ Code.

1 Compile sample pct.min MATLAB.
This example code uses the cluster defined in the default profile.
The output assumes that the default profile is local.

function speedup = sample_pct (n)

warning off all;

tic

if(ischar(n))
n=str2double(n);

end

for ii = 1:n
(cov(sin(magic(n)+rand(n,n))));

end

time1 =toc;

parpool;

tic

parfor ii = 1:n
(cov(sin(magic(n)+rand(n,n))));

end

time2 =toc;

disp([ 'Normal loop times: ' num2str(time1l)
',parallel loop time: ' num2str(time2) 1);

disp(['parallel speedup: ' num2str(1/(time2/timel))

' times faster than normal']);
delete(gcp);
disp('done');
speedup = (timel/time2);

2 Run the code as follows after changing the default profile to local, if
needed.

a = sample_pct(200)

3 Verify that you get the following results;

Starting matlabpool using the 'local'’
profile ... connected to 4 labs.



8 Distribution to End Users

8-10

Normal loop times: 1.4625, parallel loop time: 0.82891
parallel speedup: 1.7643 times faster than normal
Sending a stop signal to all the labs ... stopped.
done
a:

1.7643

Step 2: Set the Parallel Computing Toolbox Profile. In order to compile
MATLAB code to a COM component and utilize the Parallel Computing
Toolbox, the mcruserdata must be set directly from MATLAB. There is no API
available to access the MCRUserdata as there is for C and C++ applications
built with MATLAB Compiler.

To set the mcruserdata from MATLAB, create an init function in your COM
class. This is a separate MATLAB function that uses setmcruserdata to

set the Parallel Computing Toolbox profile once. You then call your other
functions to utilize the Parallel Computing Toolbox functions.

Create the following init function:

function init_sample_pct
% Set the Parallel Profile:
if (isdeployed)
[profile] = uigetfile('*.settings');
% let the USER select file
setmcruserdata('ParallelProfile',[profile]);
end

Step 3: Compile Your Function with the Deployment Tool or the
Command Line. You can compile your function from the command line by
entering the following:

mcc -B 'cexcel:exPctComp,exPctClass,1.0' init_sample_pct.m sample_pct.m
Alternately, you can use the Deployment Tool as follows:

1 Follow the steps in “Create a Microsoft® Excel® Add-In and COM
Component from MATLAB Code” on page 1-12 to compile your application.

When the compilation finishes, a new folder (with the same name as the
project) is created.
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Project Name exPctComp
Class Name exPctClass
File to compile sample_pct.m and

init_sample_pct.m

Note If you are using the GPU feature of Parallel Computing Toolbox, you
need to manually add the PTX and CU files.

If you are using a Deployment Tool project, click Add files/directories
on the Build tab.

If you are using the mcc command, use the -a option.

2 To deploy the compiled application, copy the
for_redistribution files only folder, which contains the following,
to your end users.

® exPctComp.dll
e VBA module (.bas file)
e MCR installer

e Cluster profile

Note The end-user’s target machine must have access to the cluster.

Step 4: Modify the generated VBA Driver Application (the BAS File).
After registering the COM DLL on the deployment machine and importing
the BAS file into Excel, modify the generated BAS file code as needed.

Dim MCLUtil As Object
Dim bModuleInitialized As Boolean
Dim exPctClass As Object

Private Sub InitModule()
If Not bModuleInitialized Then
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On Error GoTo Handle Error
If MCLUtil Is Nothing Then
Set MCLUtil = CreateObject("MWComUtil.MWUtil7.10")

End If
Call MCLUtil.MWInitApplication(Application)
bModuleInitialized = True
Exit Sub

Handle_Error:
bModuleInitialized = False

End If
End Sub

Function init_sample_pct() As Variant

On Error GoTo Handle_Error
Call InitModule
If exPctClass Is Nothing Then
Set exPctClass = CreateObject("exPctComp.exPctClass.1_0")
End If
Call exPctClass.init _sample pct
init_sample_pct = Empty

Exit Function
Handle_Error:
init_sample_pct = "Error in " &
Err.Source & ": " & Err.Description
End Function

Function sample pct(Optional pelle As Variant) As Variant
Dim speedup As Variant

On Error GoTo Handle_Error
Call InitModule
If exPctClass Is Nothing Then
Set exPctClass = CreateObject("exPctComp.exPctClass.1_0")
End If
Call exPctClass.sample pct(1, speedup, pelle)
sample pct = speedup
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Exit Function
Handle_Error:
sample pct = "Error in " & Err.Source
& ": " & Err.Description
End Function

The output is as follows:

B4 - I | =sample_pct{C3)
| Bookl.xlsm
& B C B} E E

0 =-init_sample_pct()
430

Speedup I 2.D1365?_|<—sam ple_pct(C3)

MCR Component Cache and CTF Archive Embedding

® “Overriding Default Behavior” on page 8-15
* “For More Information” on page 8-15

CTF data is automatically embedded directly in MATLAB Builder EX
components by default and extracted to a temporary folder.

Automatic embedding enables usage of MCR Component Cache features
through environment variables.

These variables allow you to specify the following:

¢ Define the default location where you want the CTF archive to be
automatically extracted

e Add diagnostic error printing options that can be used when automatically
extracting the CTF, for troubleshooting purposes

® Tuning the MCR component cache size for performance reasons.

8-13



8 Distribution to End Users

8-14

Use the following environment variables to change these settings.

Environment Variable

Purpose

Notes

MCR_CACHE_ROOT

When set to the location of
where you want the CTF
archive to be extracted, this
variable overrides the default
per-user component cache
location.

Does not apply

MCR_CACHE_VERBOSE

When set to any value, this
variable prints logging details
about the component cache
for diagnostic reasons. This
can be very helpful if problems
are encountered during CTF
archive extraction.

Logging details are turned off
by default (for example, when
this variable has no value).

MCR_CACHE_SIZE

When set, this variable
overrides the default
component cache size.

The initial limit for this
variable is 32M (megabytes).
This may, however, be changed
after you have set the variable
the first time. Edit the file
.max_size, which resides in
the file designated by running
the mcrcachedir command,
with the desired cache size
limit.

You can override this automatic embedding and extraction behavior by
compiling with the -C option. See “Overriding Default Behavior” on page
8-15 for details.
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Note If you run mcc specifying conflicting wrapper and target types, the CTF
will not be embedded into the generated component. For example, if you run:

mcc -W lib:myLib -T link:exe test.m test.c

the generated test.exe will not have the CTF embedded in it, as if you had
specified a -C option to the command line.

Caution Do not extract the files within the.ctf file and place them
individually under version control. Since the . ctf file contains interdependent
MATLAB functions and data, the files within it must be accessed only by
accessing the .ctf file. For best results, place the entire .ctf file under
version control.

Overriding Default Behavior

To extract the CTF archive in a manner prior to R2008b, alongside the
compiled COM component, compile using the option “-C Do Not Embed CTF
Archive by Default”.

You can also implement this override by checking the appropriate Option in
the Deployment Tool.

You might want to use this option to troubleshoot problems with the CTF
archive, for example, as the log and diagnostic messages are much more
visible.

For More Information

For more information about the CTF archive, see “Component Technology File
(CTF Archive)” on page 5-6.

8-15



8 Distribution to End Users

8-16

MCR Run-Time Options

What MCR Options are Supported by MATLAB Builder EX?

e -logfile — Creates a named log file.

How Do | Specify MCR Options?

If You Compiled the Add-In in MATLAB or used mcc. If you are building
your add-in using the MATLAB Library Compiler, select Create log file
under Additional Runtime Settings.

If you are building your add-in using mcc, simply specify -logfile with the
mcc -R command

If You Created a Function From Scratch Using the Function Wizard. If
you created a function from scratch using the Function Wizard, and want to
specify MCR options, you have to manually modify the .bas file code.

You do this by invoking the following MWUtil API calls, detailed with
examples in “Class MWUtil” on page 10-3:

® Sub MWInitApplicationWithMCROptions (pApp As Object,
[mcrOptionList])
® Function IsMCRJVMEnabled() As Boolean

® Function IsMCRInitialized() As Boolean



For More Information

For More Information

For more information about... See...

Functions available through Function Reference pages in
MATLAB Builder EX MATLAB Builder EX documentation
Utility functions you can use to “Referencing Utility Classes” on
customize COM components created | page 10-2

with MATLAB Builder EX
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Purpose Query system registry about component created with MATLAB Builder
EX
Syntax info = componentinfo

info = componentinfo(component_name)

info = componentinfo(component_name, major_revision_number)

info = componentinfo(component_name, major_revision_number,
minor_revision_number)

Arguments component_name The MATLAB string providing the
name of a MATLAB Builder EX
component. Names are case sensitive.
If this argument is not supplied, the
function returns information on all
installed components.

major_revision_number Component major revision number.
If this argument is not supplied, the
function returns information on all
major revisions.

minor_revision_number Component minor revision number.
Default value is 0.

Description info = componentinfo returns information for all components
installed on the system.

info = componentinfo(component name) returns information for all
revisions of component_name.

info = componentinfo(component_name, major_revision_number)
returns information for the most recent minor revision corresponding to
major_revision_number of component_name.

info = componentinfo(component_name, major_revision_number,
minor_revision_number) returns information for the specific major
and minor version of component_name.
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Registry
Information

The return value is an array of structures representing all the registry
and type information needed to load and use the component.

When you supply a component name, major_revision number and
minor_revision_number are interpreted as shown below.

Value | Information Returned

>0 Information on a specific major and minor revision

0 Information on the most recent revision.
When omitted, minor_revision_number is assumed to be
equal to 0.

<0 Information on all versions

Note Although properties and events may appear in the output for
componentinfo, they are not supported by builder components.

The information about a component has the fields shown in the
following table.

Registry Information Returned by componentinfo

Field Description

Name Component name.

TypelLib Component type library.

LIBID Component type library GUID.
MajorRev Major version number .
MinorRev Minor version number.
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Registry Information Returned by componentinfo (Continued)

Field Description

FileName Type library file name and path. Since all the MATLAB
Builder EX components have the type library bound into the
DLL, this file name is the same as the DLL name and path.

Interfaces An array of structures defining all interface definitions in
the type library. Each structure contains two fields:

® Name - Interface name.

e TID - Interface GUID.
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Registry Information Returned by componentinfo (Continued)

CoClasses

An array of structures defining all COM
classes in the component. Each structure
contains these fields:

® Name - Class name.
e CLSID - GUID of the class.
® ProgID - Version-dependent program ID.

® VerIndProgID - Version-independent
program ID.

® InprocServer32 - Full name and path to
component DLL.

¢ Methods - A structure containing function
prototypes of all class methods defined for
this interface. This structure contains four
fields:

IDL - An array of Interface Description
Language function prototypes.

= M - An array of MATLAB function
prototypes.

C - An array of C-language function
prototypes.

= VB - An array of VBA function
prototypes.

® Properties - A cell array containing the
names of all class properties.

¢ Events - A structure containing function
prototypes of all events defined for this
class. This structure contains four fields:
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Registry Information Returned by componentinfo (Continued)

(Continued)
= IDL - An array of Interface Description
Language function prototypes.
= M - An array of MATLAB function
prototypes.
= C - An array of C-language function
prototypes.
= VB - An array of VBA function
prototypes.
Examples Function Call Returns
Info = componentinfo Information for all installed
components.
Info = Information for all revisions
componentinfo('mycomponent"') of mycomponent.
Info = Information for revision 1.0
componentinfo('mycomponent',1,0) | of mycomponent.
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Purpose
Syntax

Description

Input
Arguments

Compile and package functions for external deployment
deploytool [-win32] [[[-build] | [-project]]project name]

deploytool opens the MATLAB Compiler app.

deploytool project name opens the MATLAB Compiler app with
the project preloaded.

deploytool -build project_name runs the MATLAB Compiler to
build the specified project. The installer is not generated.

deploytool -package project_name runs the MATLAB Compiler to
build and package the specified project. The installer is generated.

deploytool -win32 instructs the compiler to build a 32-bit application
on a 64-bit system when the following are true:

® You use the same MATLAB installation root (matlabroot) for both
32-bit and 64-bit versions of MATLAB.

® You are running from a Windows command line (not a MATLAB
command line).
project_name - name of the project to be compiled

Specify the name of a previously saved MATLAB Compiler project. The
project must be on the current path.
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Purpose
Syntax

Description

Input
Arguments

Build and package functions for use in external applications
libraryCompiler [-win32] [[[-build] | [-project]]project name]

libraryCompiler opens the MATLAB shared library compiler for the
creation of a new compiler project

libraryCompiler project_name opens the MATLAB shared library
compiler app with the project preloaded.

libraryCompiler -build project_name runs the MATLAB shared
library compiler to build the specified project. The installer is not
generated.

libraryCompiler -package project name runs the MATLAB shared
library compiler to build and package the specified project. The installer
is generated.

libraryCompiler -win32 instructs the compiler to build a 32-bit
application on a 64-bit system when you use the same MATLAB
installation root (matlabroot) for both 32-bit and 64-bit versions of
MATLAB.

project_name - name of the project to be compiled

Specify the name of a previously saved MATLAB Compiler project. The
project must be on the current path.
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Purpose

Syntax

Compile MATLAB functions for deployment

mcc {-e} | {-m} [-a filename]... [-B filename[:arg]...] [-C] [-d outFolder]
[-f filename] [-g] [-I directory]... [-K] [-M string] [-N] [-o filename]
[-p path]... [[R option] [-v] [-w option[:msg]] [-win32] [-Y filename]
mfilename

mcc -1 [-a filename]... [-B filenamel.arg]...] [-C] [-d outFolder] [-f
filename] [-g] [-I1 directory]... [-K] [-M string] [-N] [-o filename]
[-p path]... [[R option] [-v] [-w option[:msg]] [-win32] [-Y filename]
mfilename...

mcc -c [-a filename]... [-B filename[:arg]...] [-C] [-d outFolder] [-f
filename] [-g] [-I directory]... [-K] [-M string] [-N] [-o filename]
[-p path]... [[R option] [-v] [-w option[:msg]] [-win32] [-Y filename]
mfilename...

mcc -W cpplib:component_name -T link:lib [-a filename]... [-B
filenamel:arg]...] [-C] [-d outFolder] [-f filename] [-g] [[ I directory]...
[-K] [-M string] [-N] [-o filename] [-p path]... [[R option] [-S] [-v] [-w
option[:msg]] [-win32] [-Y filename] mfilename...

mcc -W dotnet:component _name,[className], [framework version],
security,remote_type -Tlink:lib [-a filename]... [-B filenamel[:arg]...]
[-C] [-d outFolder] [-f filename] [-I directory]... [[K] [-M string] [-N]
[-p path]... [-R option] [-S] [-v] [-w option[:msg]] [-win32] [-Y filename]
mfilename... [class{className:[mfilename]...}]...

mcc -W excel:component_name,[className], [version] -T link:lib [-a
filename]... [-b] [-B filename[:arg]...] [-C] [-d outFolder] [-f filename]
[-Idirectory]... [[K] [-M string] [-N] [-p path]... [[R option] [-u] [-V]
[-w option[:msg]] [-win32] [-Y filename] mfilename...

mcc -W 'java:packageName,[className]' [-a filename]... [-b]
[-B filenamel:arg]...] [-C] [-d outFolder] [-f filename] [-1
directory]... [-K] [-M string] [-N] [-p path]... [-R option]
[-S] [-v] [-w option[:msg]] [-win32] [-Y filenamem] filename...
[class{className:[mTfilename]...}]...
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Description

mcc -W CTF:.component_name [-a filename]... [-b] [-B filename[:arg]...]
[-d outFolder] [-f filename] [-1 directory]... [-K] [-M string] [-N] [-p
path]... [[R option] [-S] [-v] [-w option[:msg]] [-win32] [-Y filenamem]
filename... [class{className:[mfilename]...}]...

mcc -?

mcc -m mfilename compiles the function into a standalone application.

This is equivalent to -W main -T link:exe.

mcc -e mfilename compiles the function into a standalone application
that does not open an MS-DOS® command window.

This is equivalent to -W WinMain -T link:exe.

mcc -1 mfilename... compiles the listed functions into a C shared
library and generates C wrapper code for integration with other
applications.

This is equivalent to -W 1lib:1ibname -T link:1lib.

mcc -¢ mfilename... generates C wrapper code for the listed
functions.

This is equivalent to -W 1ib:1ibname -T codegen.

mcc -W cpplib:component_name -T link:1lib mfilename...
compiles the listed functions into a C++ shared library and generates
C++ wrapper code for integration with other applications.

mcc -W
dotnet:component_name,className,framework_version,security,
remote_type -T link:lib mfilename... creates a .NET

component from the specified files.
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component_name — Specifies the name of the component
and its namespace, which is a period-separated list, such as
companyname.groupname.component.

className — Specifies the name of the .NET class to be created.

framework version — Specifies the version of the Microsoft .NET
Framework you want to use to compile the component. Specify either:

= 0.0 — Use the latest supported version on the target machine.

= version_major.version_minor — Use a specific version of the
framework.

Features are often version-specific. Consult the documentation
for the feature you are implementing to get the Microsoft .NET
Framework version requirements.

security — Specifies whether the component to be created is a
private assembly or a shared assembly.

= To create a private assembly, specify Private.

= To create a shared assembly, specify the full path to the encryption
key file used to sign the assembly.

remote_type — Specifies the remoting type of the component. Values
are remote and local.

By default, the compiler generates a single class with a method for each
function specified on the command line. You can instruct the compiler
to create multiple classes using class{className:mfilename...}....
className specifies the name of the class to create using mfilename.

mcc -W excel:component_name,className, version -T link:1lib
mfilename... creates a Microsoft Excel component from the specified
files.

e component _name — Specifies the name of the component

and its namespace, which is a period-separated list, such as
companyname.groupname.component.
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® className — Specifies the name of the class to be created. If you
do not specify the class name, mcc uses the component_name as the
default.

® version — Specifies the version of the component specified as
major.minor.

major — Specifies the major version number. If you do not specify
a version number, mcc uses the latest version.

minor — Specifies the minor version number. If you do not specify
a version number, mcc uses the latest version.

mcc -W 'java:packageName,className' mfilename... creates a
Java package from the specified files.

® packageName — Specifies the name of the Java package
and its namespace, which is a period-separated list, such as
companyname.groupname.component.

® className — Specifies the name of the class to be created. If you do
not specify the class name, mcc uses the last item in packageName.

By default, the compiler generates a single class with a method for each
function specified on the command line. You can instruct the compiler
to create multiple classes using class{className:mfilename...}....
className specifies the name of the class to create using mfilename.

mcc -W CTF:component_name instructs the compiler to create a
deployable CTF archive that is deployable in a MATLAB Production
Server instance.

mcc -? displays help.

Tip You can issue the mcc command either from the MATLAB
command prompt or the DOS or UNIX® command line.

9-12



mcc

Options

-a Add to Archive
Add a file to the CTF archive using

-a filename

to specify a file to be directly added to the CTF archive. Multiple -a
options are permitted. MATLAB Compiler looks for these files on the
MATLAB path, so specifying the full path name is optional. These files
are not passed to mbuild, so you can include files such as data files.

If only a folder name is included with the -a option, the entire contents
of that folder are added recursively to the CTF archive. For example:

mcc -m hello.m -a ./testdir

In this example, testdir is a folder in the current working folder. All
files in testdir, as well as all files in subfolders of testdir, are added
to the CTF archive, and the folder subtree in testdir is preserved in
the CTF archive.

If a wildcard pattern is included in the file name, only the files in
the folder that match the pattern are added to the CTF archive and
subfolders of the given path are not processed recursively. For example:

mcc -m hello.m -a ./testdir/*

In this example, all files in . /testdir are added to the CTF archive and
subfolders under . /testdir are not processed recursively.

mcc -m hello.m -a ./testdir/*.m

In this example, all files with the extension .m under ./testdir are
added to the CTF archive and subfolders of . /testdir are not processed
recursively.

All files added to the CTF archive using -a (including those that match
a wildcard pattern or appear under a folder specified using -a) that do
not appear on the MATLAB path at the time of compilation causes

a path entry to be added to the deployed application’s run-time path
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so that they appear on the path when the deployed application or
component executes.

When files are included, the absolute path for the DLL and header files
is changed. The files are placed in the .\exe_mcr\ folder when the CTF
file is expanded. The file is not placed in the local folder. This folder

1s created from the CTF file the first time the EXE file is executed.
The isdeployed function is provided to help you accommodate this
difference in deployed mode.

The -a switch also creates a .auth file for authorization purposes.
It ensures that the executable looks for the DLL- and H-files in the
exe_mcr\exe folder.

Caution

If you use the -a flag to include a file that is not on the MATLAB path,
the folder containing the file is added to the MATLAB dependency
analysis path. As a result, other files from that folder might be included
in the compiled application.

Note Currently, * is the only supported wildcard.

Note If the -a flag is used to include custom Java classes, standalone
applications work without any need to change the classpath as long
as the Java class is not a member of a package. The same applies for
JAR files. However, if the class being added is a member of a package,
the MATLAB code needs to make an appropriate call to javaaddpath to
update the classpath with the parent folder of the package.
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-b Generate Excel Compatible Formula Function

Generate a Visual Basic file (. bas) containing the Microsoft Excel
Formula Function interface to the COM object generated by MATLAB
Compiler. When imported into the workbook Visual Basic code, this
code allows the MATLAB function to be seen as a cell formula function.
This option requires MATLAB Builder EX.

-B Specify Bundle File

Replace the file on the mcc command line with the contents of the
specified file. Use

-B filename[:<a1>,<a2>,...,<an>]

The bundle file filename should contain only mcc command-line
options and corresponding arguments and/or other file names. The file
might contain other -B options. A bundle file can include replacement
parameters for Compiler options that accept names and version
numbers. See “Using Bundle Files to Build MATLAB Code” for a list of
the bundle files included with MATLAB Compiler.

-C Do Not Embed CTF Archive by Default

Override automatically embedding the CTF archive in C/C++ and
main/Winmain shared libraries and standalone binaries by default.

-d Specified Folder for Output

Place output in a specified folder. Use

-d outFolder

to direct the generated files to outFolder.

-f Specified Options File
Override the default options file with the specified options file. Use

-f filename
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to specify filename as the options file when calling mbuild. This
option lets you use different ANSI compilers for different invocations of
MATLAB Compiler. This option is a direct pass-through to mbuild.

-g Generate Debugging Information

Include debugging symbol information for the C/C++ code generated
by MATLAB Compiler. It also causes mbuild to pass appropriate
debugging flags to the system C/C++ compiler. The debug option

lets you backtrace up to the point where you can identify if the
failure occurred in the initialization of MCR, the function call, or the
termination routine. This option does not let you debug your MATLAB
files with a C/C++ debugger.

-G Debug Only
Same as -g.
-1 Add Folder to Include Path

Add a new folder path to the list of included folders. Each -I option
adds a folder to the beginning of the list of paths to search. For example,

-I <directoryi1> -I <directory2>

sets up the search path so that directory1 is searched first for
MATLAB files, followed by directory2. This option is important for
standalone compilation where the MATLAB path is not available.

-K Preserve Partial Output Files

Direct mcc to not delete output files if the compilation ends prematurely,
due to error.

The default behavior of mcc is to dispose of any partial output if the
command fails to execute successfully.

-M Direct Pass Through

Define compile-time options. Use

-M string
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to pass string directly to mbuild. This provides a useful mechanism for
defining compile-time options, e.g., -M "-Dmacro=value".

Note Multiple -M options do not accumulate; only the rightmost -M
option is used.

-N Clear Path

Passing -N effectively clears the path of all folders except the following
core folders (this list is subject to change over time):

® matlabroot\toolbox\matlab
e matlabroot\toolbox\local
® matlabroot\toolbox\compiler\deploy

It also retains all subfolders of the above list that appear on the
MATLAB path at compile time. Including -N on the command line lets
you replace folders from the original path, while retaining the relative
ordering of the included folders. All subfolders of the included folders
that appear on the original path are also included. In addition, the -N
option retains all folders that you included on the path that are not
under matlabroot\toolbox.

-o Specify Output Name

Specify the name of the final executable (standalone applications only).
Use

-0 outputfile

to name the final executable output of MATLAB Compiler. A suitable,
possibly platform-dependent, extension is added to the specified name
(e.g., .exe for Windows standalone applications).
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-p Add Folder to Path

Use in conjunction with the required option -N to add specific folders
(and subfolders) under matlabroot\toolbox to the compilation
MATLAB path in an order sensitive way. Use the syntax

-N -p directory

where directory is the folder to be included. If directory is not an
absolute path, it is assumed to be under the current working folder. The
rules for how these folders are included follow.

e If a folder is included with -p that is on the original MATLAB path,
the folder and all its subfolders that appear on the original path are
added to the compilation path in an order-sensitive context.

e If a folder is included with -p that is not on the original MATLAB
path, that folder is not included in the compilation. (You can use
-1 to add 1it.)

If a path is added with the -I option while this feature is active (-N has
been passed) and it is already on the MATLAB path, it is added in the
order-sensitive context as if it were included with -p. Otherwise, the
folder is added to the head of the path, as it normally would be with -1I.

-R Run-Time

Provides MCR run-time options. The syntax is as follows:

-R option

Option Description

-logfile Specify a log file name.
filename

-nodisplay Suppress the MATLAB nodisplay run-time warning.

-nojvm Do not use the Java Virtual Machine (JVM).
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Option Description

-startmsg Customizable user message displayed at MCR
initialization time.

-completemsg | Customizable user message displayed when MCR
initialization is complete.

Note Not all -R options are available for all mcc targets.

Caution

When running on Mac OS X, if -nodisplay is used as one of the
options included in mclInitializeApplication, then the call to
mclInitializeApplication must occur before calling mc1RunMain.

-S Create Singleton MCR Context

The standard behavior for the MCR is that every instance of a

class gets its own runtime context. This runtime context includes a
global MATLAB workspace for variables such as the path and a base
workspace for each function in the class. If multiple instances of a class
are created, each instance gets an independent context. This ensures
that changes made to the global, or base, workspace in one instance of
the class does not effect other instances of the same class.

In a singleton MCR, all instances of a class share the runtime context.
If multiple instances of a class are created, the use the runtime context
created by the first instance. This saves start up time and some
resources. However, any changes made to the global workspace or the
base workspace by one instance impacts all of the class instances. For
example, if instancel creates a global variable A in a singleton MCR,
the instance2 will be able to use variable A.
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-T Specify Target Stage

Specify the output target phase and type.

Use the syntax -T target to define the output type. Target values

are as follow.

Target

Description

compile:exe

Generate a C/C++ wrapper file
plus compile C/C++ files to object
form suitable for linking into a
standalone application.

compile:1lib

Generate a C/C++ wrapper file
plus compile C/C++ files to object
form suitable for linking into a
shared library/DLL.

link:exe Same as compile:exe plus links
object files into a standalone
application.

link:1lib Same as compile:1lib plus

links object files into a shared
library/DLL.

-u Register COM Component for the Current User

Register COM component for the current user only on the development
machine. The argument applies only for generic COM component and

Microsoft Excel add-in targets only.

-v Verbose

Display the compilation steps, including:

The invocation of mbuild

MATLAB Compiler version number
The source file names as they are processed

The names of the generated output files as they are created
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The -v option passes the -v option to mbuild and displays information

about mbuild.

-w Warning Messages

Display warning messages. Use the syntax

-w option [:<msg>]

to control the display of warnings. This table lists the syntaxes.

Syntax Description

-w list Generate a table that maps <string> to
warning message for use with enable,
disable, and error. “Warning Messages”,
lists the same information.

-w enable Enable complete warnings.

-w Disable specific warnings associated with

disable[:<string>]

<string>. “Warning Messages”, lists
the <string> values. Omit the optional
<string> to apply the disable action to
all warnings.

-w enable[:<string>]

Enable specific warnings associated with
<string>. “Warning Messages”, lists

the <string> values. Omit the optional
<string> to apply the enable action to all
warnings.

-w error[:<string>]

Treat specific warnings associated with
<string> as an error. Omit the optional
<string> to apply the error action to all
warnings.
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Syntax Description
-w off[:<string>] Turn warnings off for specific error
[<filename>] messages defined by <string>. You can

also narrow scope by specifying warnings
be turned off when generated by specific

<filename>s.
-w on[:<string>] Turn warnings on for specific error
[<filename>] messages defined by <string>. You can

also narrow scope by specifying warnings
be turned on when generated by specific
<filename>s.

It is also possible to turn warnings on or off in your MATLAB code.

For example, to turn warnings off for deployed applications (specified
using isdeployed) in your startup.m, you write:

if isdeployed
warning off
end

To turn warnings on for deployed applications, you write:

if isdeployed
warning on
end

-win32 Run in 32-Bit Mode

Use this option to build a 32-bit application on a 64-bit system only
when the following are true:

® You have a 32-bit installation of MATLAB.

® You use the same MATLAB installation root (matlabroot) for both
32-bit and 64-bit versions of MATLAB.
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® You are running from a Windows command line.

-Y License File
Use

-Y license.lic

to override the default license file with the specified argument.

9-23



productionServerCompiler

9-24

Purpose

Syntax

Description

Input
Arguments

Build and package functions for use with MATLAB Production Server

productionServerCompiler [-win32] [[[-build] |
[-project]]project _name]

productionServerCompiler opens the MATLAB compiler for the
creation of a new compiler project

productionServerCompiler project name opens the MATLAB
compiler with the project preloaded.

productionServerCompiler -build project_name runs the MATLAB
compiler to build the specified project. The installer is not generated.

productionServerCompiler -package project_name runs the
MATLAB compiler to build and package the specified project. The
installer is generated.

productionServerCompiler -win32 instructs the compiler to build a
32-bit application on a 64-bit system when you use the same MATLAB
installation root (matlabroot) for both 32-bit and 64-bit versions of
MATLAB.

project_name - name of the project to be compiled

Specify the name of a previously saved MATLAB Compiler project. The
project must be on the current path.



Utility Library for Microsoft
COM Components

e “Referencing Utility Classes” on page 10-2
e “Class MWUtil” on page 10-3

e “Class MWFlags” on page 10-14

e “Class MWStruct” on page 10-21

® “Class MWField” on page 10-29

e “Class MWComplex” on page 10-31

® “Class MWSparse” on page 10-34

e “Class MWArg” on page 10-38

¢ “Enum mwArrayFormat” on page 10-40

e “Enum mwDataType” on page 10-41

¢ “Enum mwDateFormat” on page 10-42



1 0 Utility Library for Microsoff® COM Components

10-2

Referencing Utility Classes

This section describes the MWComUtil library. This library is freely
distributable and includes several functions used in array processing, as well
as type definitions used in data conversion. This library is contained in the
file mwcomutil.dll. It must be registered once on each machine that uses
Microsoft COM components created by MATLAB Builder EX.

Register the MWComUtil library at the DOS command prompt with the
command:

mwregsvr mwcomutil.dll

The MWComUtil library includes seven classes and three enumerated types.
Before using these types, you must make explicit references to the MWComUtil
type libraries in the Microsoft Visual Basic IDE. To do this select Tools >
References from the main menu of the Visual Basic Editor. The References
dialog box appears with a scrollable list of available type libraries. From this
list, select MWComUtil 1.0 Type Library and click OK.

Note You must specify the full path of the component when calling mwregsvr,
or make the call from the folder in which the component resides.
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Class MWUiil

The MWUtil class contains a set of static utility methods used in array
processing and application initialization. This class is implemented internally
as a singleton (only one global instance of this class per instance of Microsoft
Excel). It is most efficient to declare one variable of this type in global scope
within each module that uses it. The methods of MWUtil are:

In this section...
“Sub MWInitApplication(pApp As Object)” on page 10-3

“Sub MWInitApplicationWithMCROptions(pApp As Object,
[mcrOptionList])” on page 10-5

“Function IsMCRJVMEnabled() As Boolean” on page 10-7
“Function IsMCRInitialized() As Boolean” on page 10-7
“Sub MWPack(pVarArg, [Var0], [Varl], ... ,[Var31])” on page 10-7

“Sub MWUnpack(VarArg, [nStartAt As Long], [bAutoResize As Boolean =
False], [pVar0], [pVarl], ..., [pVar31])” on page 10-9

“Sub MWDate2VariantDate(pVar)” on page 10-11

The function prototypes use Visual Basic syntax.

Sub MWinitApplication(pApp As Object)

Initializes the library with the current instance of Microsoft Excel.

Parameters
Argument Type Description
pApp Object A valid reference to
the current Excel
application

Return Value
None.
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Remarks

This function must be called once for each session of Excel that uses COM
components created by MATLAB Builder NE. An error is generated if a
method call is made to a member class of any MATLAB Builder NE COM
component, and the library has not been initialized.

Example

This Visual Basic sample initializes the MWComUtil library with the current
instance of Excel. A global variable of type Object named MCLUtil holds an
instance of the MWUtil class, and another global variable of type Boolean
named bModuleInitialized stores the status of the initialization process.
The private subroutine InitModule () creates an instance of the MWComUtil
class and calls the MWInitApplication method with an argument of
Application. Once this function succeeds, all subsequent calls exit without
recreating the object.

Dim MCLUtil As Object
Dim bModulelInitialized As Boolean

Private Sub InitModule()
If Not bModuleInitialized Then
On Error GoTo Handle_Error
If MCLUtil Is Nothing Then
Set MCLUtil = CreateObject("MWComUtil.MWUtil")
End If
Call MCLUtil.MWInitApplication(Application)
bModuleInitialized = True
Exit Sub
Handle_Error:
bModuleInitialized = False
End If
End Sub
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Note If you are developing concurrently with multiple versions of MATLAB
and MWComUtil.d11, for example, using this syntax:

Set MCLUtil = CreateObject("MWComUtil.MWUtil")

requires you to recompile your COM modules every time you upgrade. To
avoid this, make your call to the MWUtil module version-specific, for example:

Set MCLUtil = CreateObject("MWComUtil.MWUtilx.x")

where x. x 1s the specific version number.

Sub MWInitApplicationWithMCROptions(pApp As
Object, [mcrOptionlList])

Start MCR with MCR options. Similar to mclInitializeApplication used
in C/C++ shared libraries.

Parameters
Argument Type Description
pApp Object A valid reference only

when called from an
Excel application

Non Excel COM clients
pass in Empty.

Return Value
None.

Remarks

Call this function to pass in MCR options (nojvm, logfile, etc.). Call this
function once per process (since the MCR can only be initialized once).
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Example

This Visual Basic sample initializes the MWComUtil library with the current
instance of Excel. A global variable of type Object named MCLUtil holds an
instance of the MWUtil class, and another global variable of type Boolean
named bModuleInitialized stores the status of the initialization process.
The private subroutine InitModule () creates an instance of the MWComUtil
class and calls the MWInitApplicationWithMCROptions method with an
argument of Application and a string array that contains the options. Once
this function succeeds, all subsequent calls exit without recreating the object.
When this function successfully executes, the MCR starts up with no JVM
and a logfile named logfile.txt.

Dim MCLUtil As Object
Dim bModuleInitialized As Boolean

Private Sub InitModule()
If Not bModuleInitialized Then
On Error GoTo Handle Error
If MCLUtil Is Nothing Then
Set MCLUtil = CreateObject("MWComUtil.MWUtil")

End If
Dim mcrOptions(1 To 3) as String
mcrOptions(1) = "-nojvm"

mcrOptions(2) "-logfile"
mcrOptions(3) = "logfile.txt"
Call MCLUtil.MWInitApplicationWithMCROptions(Application, mcrOption
bModuleInitialized = True
Exit Sub
Handle_Error:
bModuleInitialized = False
End If
End Sub

Note If you are not using Excel, pass in Empty instead of Application to
MWInitApplicationWithMCROptions
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Function IsMCRJVMEnabled() As Boolean

Returns true if MCR is launched with JVM; otherwise returns false.

Parameters
None.

Return Value
Boolean

Function IsMCRInitialized() As Boolean

Returns true if MCR is initialized; otherwise returns true

Parameters
None.

Return Value
Boolean

Sub MWPack(pVarArg, [Var0], [Varl], ... ,[Var31])

Packs a variable length list of Variant arguments into a single Variant
array. This function is typically used for creating a varargin cell from a list
of separate inputs. Each input in the list is added to the array only if it is not
empty or missing. (In Visual Basic, a missing parameter is denoted by a
Variant type of vbError with a value of &H80020004.)
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Parameters
Argument Type Description
pVarArg Variant Receives the resulting
array
[var0], [Vari], ... |Variant Optional list of

Variants to pack into
the array. From O to
32 arguments can be
passed.

Return Value
None.

Remarks
This function always frees the contents of pvarArg before processing the list.

Example

This example uses MWPack in a formula function to produce a varargin cell to
pass as an input parameter to a method compiled from a MATLAB function
with the signature

function y = mysum(varargin)
y = sum([varargin{:}1);

The function returns the sum of the elements in varargin. Assume that this
function is a method of a class named myclass that is included in a component
named mycomponent with a version of 1.0. The Visual Basic function allows
up to 10 inputs, and returns the result y. If an error occurs, the function
returns the error string. This function assumes that MWInitApplication
has been previously called.

Function mysum(Optional VO As Variant,
Optional V1 As Variant,
Optional V2 As Variant,
Optional V3 As Variant,
Optional V4 As Variant,
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Dim
Dim
Dim
Dim

Optional V5 As Variant, _
Optional V6 As Variant, _
Optional V7 As Variant, _
Optional V8 As Variant, _
Optional V9 As Variant) As Variant

y As Variant

varargin As Variant

aClass As Object

aUtil As Object

On Error Goto Handle Error

Set aClass = CreateObject("mycomponent.myclass.1_0")

Set aUtil = CreateObject("MWComUtil.MWUtil")

Call auUtil.MwPack(varargin,Vvo,v1i,v2,v3,v4,V5,V6,V7,V8,V9)
Call aClass.mysum(1, y, varargin)

mysum =y

Exit Function

Handle_Error:

End

mysum = Err.Description
Function

Sub MWUnpack(VarArg, [nStartAt As Long],
[bAutoResize As Boolean = False], [pVar0], [pVarl],
e [pVar31])

Unpacks an array of Variants into individual Variant arguments. This
function provides the reverse functionality of MWPack and is typically used to
process a varargout cell into individual Variants.

Parameters

Argument Type Description

VarArg Variant Input array of Variants
to be processed

nStartAt Long Optional starting
index (zero-based)
in the array to begin
processing. Default = 0.
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Argument Type Description

bAutoResize Boolean Optional auto-resize
flag. If this flag is
True, any Excel range
output arguments

are resized to fit the
dimensions of the
Variant to be copied.
The resizing process is
applied relative to the
upper left corner of the
supplied range. Default
= False.

[pvar0],[pVari], Variant Optional list of

. Variants to receive the
array items contained
in VarArg. From O to
32 arguments can be
passed.

Return Value
None.

Remarks

This function can process a Variant array in one single call or through
multiple calls using the nStartAt parameter.

Example
This example uses MWUnpack to process a varargout cell into several Excel

ranges, while auto-resizing each range. The varargout parameter is supplied
from a method that has been compiled from the MATLAB function.

function varargout = randvectors
for i=1:nargout
varargout{i} = rand(i,1);
end
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This function produces a sequence of nargout random column vectors, with
the length of the ith vector equal to i. Assume that this function is included in
a class named myclass that is included in a component named mycomponent
with a version of 1.0. The Visual Basic subroutine takes no arguments and
places the results into Excel columns starting at A1, B1, C1, and D1. If an
error occurs, a message box displays the error text. This function assumes
that MWInitApplication has been previously called.

Sub GenVectors()
Dim aClass As Object
Dim auUtil As Object
Dim v As Variant
Dim R1 As Range
Dim R2 As Range
Dim R3 As Range
Dim R4 As Range

On Error GoTo Handle_Error
Set aClass = CreateObject("mycomponent.myclass.1_0")
Set aUtil = CreateObject("MWComUtil.MWUtil")
Set R1 = Range("A1")
Set R2 Range("B1")
Set R3 Range("C1")
Set R4 = Range("D1")
Call aClass.randvectors(4, v)
Call aUtil.MwUnpack(v,0,True,R1,R2,R3,R4)
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub

Sub MWDate2VariantDate(pVar)

Converts output dates from MATLAB to Variant dates.
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Parameters
Argument Type Description
pvar Variant Variant to be converted

Return Value
None.

Remarks

MATLAB handles dates as double-precision floating-point numbers with
0.0 representing 0/0/00 00:00:00. By default, numeric dates that are output
parameters from compiled MATLAB functions are passed as Doubles that
need to be decremented by the COM date bias as well as coerced to COM
dates. The MWDate2VariantDate method performs this transformation and
additionally converts dates in string form to COM date types.

Example

This example uses MWDate2VariantDate to process numeric dates returned
from a method compiled from the following MATLAB function.

function x = getdates(n, inc)
y = now,;
for i=1:n
X(i,1) =y + (i-1)*inc;
end

This function produces an n-length column vector of numeric values
representing dates starting from the current date and time with each element
incremented by inc days. Assume that this function is included in a class
named myclass that is included in a component named mycomponent with

a version of 1.0. The subroutine takes an Excel range and a Double as
inputs and places the generated dates into the supplied range. If an error
occurs, a message box displays the error text. This function assumes that
MWInitApplication has been previously called.

Sub GenDates(R As Range, inc As Double)
Dim aClass As Object
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Dim auUtil As Object

On Error GoTo Handle Error
Set aClass = CreateObject("mycomponent.myclass.1_0")
Set aUtil = CreateObject("MWComUtil.MWUtil")
Call aClass.getdates(1, R, R.Rows.Count, inc)
Call autil.MwDate2VariantDate(R)
Exit Sub
Handle_Error:
MsgBox (Err.Description)
End Sub
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The MWFlags class contains a set of array formatting and data conversion
flags (See “Data Conversion Rules” for more information on conversion
between MATLAB and COM Automation types.) All MATLAB Builder NE
COM components contain a reference to an MWFlags object that can modify
data conversion rules at the object level. This class contains these properties
and method:

In this section...

“Property ArrayFormatFlags As MWArrayFormatFlags” on page 10-14

“Property DataConversionFlags As MWDataConversionFlags” on page
10-17

“Sub Clone(ppFlags As MWFlags)” on page 10-20

Property ArrayFormatFlags As MWArrayFormatFlags

The ArrayFormatFlags property controls array formatting (as a matrix
or a cell array) and the application of these rules to nested arrays. The
MWArrayFormatFlags class is a noncreatable class accessed through an
MWFlags class instance. This class contains six properties:

® “Property InputArrayFormat As mwArrayFormat” on page 10-14

® “Property InputArrayIndFlag As Long” on page 10-15

® “Property OutputArrayFormat As mwArrayFormat” on page 10-15

* “Property OutputArrayIndFlag As Long” on page 10-16

* “Property AutoResizeOutput As Boolean” on page 10-16

® “Property TransposeOutput As Boolean” on page 10-17

Property InputArrayFormat As mwArrayFormat

This property of type mwArrayFormat controls the formatting of arrays passed
as input parameters to .NET Builder class methods. The default value is
mwArrayFormatMatrix. The behaviors indicated by this flag are listed in

the next table.
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Array Formatting Rules for Input Arrays

Value Behavior

mwArrayFormatAsIs Converts arrays according to the
default conversion rules listed in
“Data Conversion Rules”.

mwArrayFormatCell Coerces all arrays into cell arrays.
Input scalar or numeric array
arguments are converted to cell
arrays with each cell containing a
scalar value for the respective index.

mwArrayFormatMatrix Coerces all arrays into matrices.
When an input argument is
encountered that is an array of
Variants (the default behavior is
to convert it to a cell array), the
data converter converts this array
to a matrix if each Variant is
single valued, and all elements are
homogeneous and of a numeric type.
If this conversion is not possible,
creates a cell array.

Property InputArrayindFlag As Long

This property governs the level at which to apply the rule set by the
InputArrayFormat property for nested arrays (an array of Variants is passed
and each element of the array is an array itself). It is not necessary to modify
this flag for varargin parameters. The data conversion code automatically
increments the value of this flag by 1 for varargin cells, thus applying the
InputArrayFormat flag to each cell of a varargin parameter. The default
value is 0.

Property OutputArrayFormat As mwArrayFormat

This property of type mwArrayFormat controls the formatting of arrays passed
as output parameters to MATLAB Builder NE class methods. The default
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value is mwArrayFormatAsIs. The behaviors indicated by this flag are listed
in the next table.

Array Formatting Rules for Output Arrays

Value Behavior

mwArrayFormatAsIs Converts arrays according to the
default conversion rules listed in
“Data Conversion Rules”.

mwArrayFormatMatrix Coerces all arrays into matrices.
When an output cell array argument
is encountered (the default behavior
converts it to an array of Variants),
the data converter converts this
array to a Variant that contains a
simple numeric array if each cell is
single valued, and all elements are
homogeneous and of a numeric type.
If this conversion is not possible, an
array of Variants is created.

mwArrayFormatCell Coerces all output arrays into
arrays of Variants. Output scalar
or numeric array arguments are
converted to arrays of Variants,
each Variant containing a scalar
value for the respective index.

Property OutputArrayindFlag As Long

This property is similar to the InputArrayIndFalg property, as it governs the
level at which to apply the rule set by the OutputArrayFormat property for
nested arrays. As with the input case, this flag is automatically incremented
by 1 for a varargout parameter. The default value of this flag is 0.

Property AutoResizeOutput As Boolean

This flag applies to Excel ranges only. When the target output from a method
call is a range of cells in an Excel worksheet, and the output array size and
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shape is not known at the time of the call, setting this flag to True instructs
the data conversion code to resize each Excel range to fit the output array.
Resizing is applied relative to the upper left corner of each supplied range.
The default value for this flag is False.

Property TransposeOutput As Boolean

Setting this flag to True transposes the output arguments. This flag is
useful when processing an output parameter from a method call on a COM
component, where the MATLAB function returns outputs as row vectors,
and you desire to place the data into columns. The default value for this
flag is False.

Property DataConversionFlags As
MWDataConversionFlags

The DataConversionFlags property controls how input variables are
processed when type coercion is needed. The MWDataConversionFlags class
1s a noncreatable class accessed through an MWFlags class instance. This
class contains these properties:

* “Property CoerceNumericToType As mwDataType” on page 10-17
* “PropertyDateBias As Long” on page 10-18

® “Property InputDateFormat As mwDateFormat” on page 10-19

* “PropertyOutputAsDate As Boolean” on page 10-19

e “ReplaceMissing As mwReplaceMissingData” on page 10-19

Property CoerceNumericToType As mwDataType

This property converts all numeric input arguments to one specific MATLAB
type. This flag is useful is when variables maintained within the Visual Basic
code are different types, e.g., Long, Integer, etc., and all variables passed

to the compiled MATLAB code must be doubles. The default value for this
property is mwTypeDefault, which uses the default rules in “Data Conversion
Rules”.

10-17



1 0 Utility Library for Microsoff® COM Components

10-18

PropertyDateBias As Long

This property sets the date bias for performing COM to MATLAB numeric
date conversions. The default value of this property is 693960, representing
the difference between the COM Date type and MATLAB numeric dates.
This flag allows existing MATLAB code that already performs the increment
of numeric dates by 693960 to be used unchanged with COM components
created by MATLAB Builder NE. To process dates with such code, set this
property to 0.

This example uses data conversion flags to reshape the output from a
method compiled from a MATLAB function that produces an output vector of
unknown length.

function p = myprimes(n)
if length(n)~=1, error('N must be a scalar'); end
if n <2, p = zeros(1,0); return, end

p =1:2:n;
q = length(p);
p(1) = 2;

for k = 3:2:sqrt(n)
if p((k+1)/2)
P(((k*k+1)/2):k:iq) = 0;
end
end

p = (p(p>0));

This function produces a row vector of all the prime numbers between 0 and
n. Assume that this function is included in a class named myclass that

is included in a component named mycomponent with a version of 1.0. The
subroutine takes an Excel range and a Double as inputs, and places the
generated prime numbers into the supplied range. The MATLAB function
produces a row vector, although you want the output in column format. It also
produces an unknown number of outputs, and you do not want to truncate
any output. To handle these issues, set the TransposeOutput flag and the
AutoResizeOutput flag to True. In previous examples, the Visual Basic
CreateObject function creates the necessary classes. This example uses an
explicit type declaration for the aClass variable. As with previous examples,
this function assumes that MWInitApplication has been previously called.

Sub GenPrimes(R As Range, n As Double)
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Dim aClass As mycomponent.myclass

On Error GoTo Handle Error
Set aClass = New mycomponent.myclass
aClass.MWFlags.ArrayFormatFlags.AutoResizeQOutput = True
aClass.MWFlags.ArrayFormatFlags.TransposeOutput = True
Call aClass.myprimes(1, R, n)
Exit Sub

Handle_Error:
MsgBox (Err.Description)

End Sub

Property InputDateFormat As mwDateFormat

This property converts dates passed as input parameters to method calls
on .NET Builder classes. The default value is mwDateFormatNumeric. The
behaviors indicated by this flag are shown in the following table.

Conversion Rules for Input Dates

Value Behavior

mwDateFormatNumeric Convert dates to numeric values as
indicated by the rule listed in “Data
Conversion Rules”.

mwDateFormatString Convert input dates to strings

PropertyOutputAsDate As Boolean

This property processes an output argument as a date. By default, numeric
dates that are output parameters from compiled MATLAB functions are
passed as Doubles that need to be decremented by the COM date bias
(693960) as well as coerced to COM dates. Set this flag to True to convert all
output values of type Double.

ReplaceMissing As mwReplaceMissingData
This property is an enumeration and can have two possible values:
mwReplaceNaN and mwReplaceZero.
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To treat empty cells referenced by input parameters as zeros, set the value to
mwReplaceZero. To treat empty cells referenced by input parameters as NaNs
(Not a Number), set the value to mwReplaceNaN.

By default, the value i1s mwReplaceZero.

Sub Clone(ppFlags As MWFlags)

Creates a copy of an MWFlags object.

Parameters
Argument Type Description
ppFlags MWFlags Reference to an

uninitialized MWFlags
object that receives the

copy

Return Value
None

Remarks

Clone allocates a new MWFlags object and creates a deep copy of the object’s
contents. Call this function when a separate object is required instead of a
shared copy of an existing object reference.
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Class MWStruct

The MWStruct class passes or receives a Struct type to or from a compiled
class method. This class contains seven properties/methods:

In this section...

“Sub Initialize([varDims], [varFieldNames])” on page 10-21
“Property Item([i0], [i1], ..., [131]) As MWField” on page 10-23
“Property NumberOfFields As Long” on page 10-25
“Property NumberOfDims As Long” on page 10-26

“Property Dims As Variant” on page 10-26

“Property FieldNames As Variant” on page 10-26

“Sub Clone(ppStruct As MWStruct)” on page 10-27

Sub Initialize([varDims], [varFieldNames])

This method allocates a structure array with a specified number and size of
dimensions and a specified list of field names.

Parameters

Argument Type Description

varDims Variant Optional array of
dimensions

varFieldNames Variant Optional array of field
names

Return Value
None.
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Remarks

When created, an MWStruct object has a dimensionality of 1-by-1 and no
fields. The Initialize method dimensions the array and adds a set of named
fields to each element. Each time you call Initialize on the same object, it
is redimensioned. If you do not supply the varDims argument, the existing
number and size of the array’s dimensions unchanged. If you do not supply
the varFieldNames argument, the existing list of fields is not changed.
Calling Initialize with no arguments leaves the array unchanged.

Example
The following Visual Basic code illustrates use of the Initialize method
to dimension struct arrays.

Sub foo ()
Dim x As MWStruct
Dim y As MWStruct

On Error Goto Handle_Error

'Create 1X1 struct arrays with no fields for x, and y
Set x = new MWStruct

Set y = new MWStruct

'Initialize x to be 2X2 with fields "red", "green",

' and "blue"

Call x.Initialize(Array(2,2), Array("red", "green", "blue"))
'Initialize y to be 1X5 with fields "name" and "age"

Call y.Initialize(5, Array("'name", "age"))

'Re-dimension x to be 3X3 with the same field names
Call x.Initialize(Array(3,3))

'Add a new field to y
Call y.Initialize(, Array("name", "age", "salary"))

Exit Sub
Handle_Error:

MsgBox (Err.Description)
End Sub
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Property Iltem([iO], [i1], ..., [(31]) As MWField

The Item property is the default property of the MWStruct class. This property
is used to set/get the value of a field at a particular index in the structure
array.

Parameters

Argument Type Description

i0,it, ..., i31 Variant Optional index
arguments. Between 0
and 32 index arguments
can be entered. To
reference an element
of the array, specify all
indexes as well as the
field name.

Remarks

When accessing a named field through this property, you must supply all
dimensions of the requested field as well as the field name. This property
always returns a single field value, and generates a bad index error if you
provide an invalid or incomplete index list. Index arguments have four basic
formats:

¢ Field name only
This format may be used only in the case of a 1-by-1 structure array and
returns the named field’s value. For example:

x("red") = 0.2
x("green") = 0.4
X("blue") = 0.6

In this example, the name of the Item property was neglected. This is
possible since the Item property is the default property of the MWStruct

class. In this case the two statements are equivalent:

x.Item("red") = 0.2

10-23



1 0 Utility Library for Microsoff® COM Components

10-24

x("red") = 0.2
¢ Single index and field name

This format accesses array elements through a single subscripting notation. A
single numeric index n followed by the field name returns the named field on
the nth array element, navigating the array linearly in column-major order.
For example, consider a 2-by-2 array of structures with fields "red", "green"
,and "blue" stored in a variable x. These two statements are equivalent:

y = x(2, "red")
y x(2, 1, "red")

e All indices and field name

This format accesses an array element of an multidimensional array by
specifying n indices. These statements access all four of the elements of the
array in the previous example:

For I From 1 To 2
For J From 1 To 2
r(I, J) = x(I, J, "red")
g(I, J) = x(I, J, "green")
b(I, J) x(I, J, "blue")

Next
Next

¢ Array of indices and field name

This format accesses an array element by passing an array of indices and a
field name. The next example rewrites the previous example using an index
array:

Dim Index(1 To 2) As Integer

For I From 1 To 2
Index(1) =1
For J From 1 To 2
Index(2) = J
r(I, Jd) = x(Index, "red")
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g(I, J) = x(Index, "green")
X(Index, "blue")

o
—_
—
[
-~
1l

Next

With these four formats, the Item property provides a very flexible indexing
mechanism for structure arrays. Also note:

You can combine the last two indexing formats. Several index arguments
supplied in either scalar or array format are concatenated to form one
index set. The combining stops when the number of dimensions has been
reached. For example:

Dim Index1(1 To 2) As Integer
Dim Index2(1 To 2) As Integer

Index1(1) = 1
Index1(2) = 1
Index2(1) = 3
Index2(2) = 2
X(Index1, Index2, 2, "red") = 0.5

The last statement resolves to

x(1, 1, 3, 2, 2, "red") = 0.5

The field name must be the last index in the list. The following statement
produces an error:

y = x("blue", 1, 2)

Field names are case sensitive.

Property NumberOfFields As Long

The read-only NumberOfFields property returns the number of fields in the
structure array.
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Property NumberOfDims As Long

The read-only Number0fDims property returns the number of dimensions in
the struct array.

Property Dims As Variant

The read-only Dims property returns an array of length NumberOfDims that
contains the size of each dimension of the struct array.

Property FieldNames As Variant

The read-only FieldNames property returns an array of length
NumberOfFields that contains the field names of the elements of the structure
array.

Example

The next Visual Basic code sample illustrates how to access a two-dimensional
structure array’s fields when the field names and dimension sizes are not
known in advance.

Sub foo ()
Dim x As MWStruct
Dim Dims as Variant
Dim FieldNames As Variant

On Error Goto Handle_Error

'... Call a method that returns an MWStruct in x
Dims = x.Dims
FieldNames = x.FieldNames
For I From 1 To Dims(1)
For J From 1 To Dims(2)
For K From 1 To x.NumberOfFields
y = x(I,J,FieldNames(K))
" ... Do something with y
Next
Next
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Next
Exit Sub
Handle_Error:

MsgBox (Err.Description)
End Sub

Sub Clone(ppStruct As MWStruct)

Creates a copy of an MWStruct object.

Parameters
Argument Type Description
ppStruct MWStruct Reference to an

uninitialized MWStruct
object to receive the

copy

Return Value
None

Remarks

Clone allocates a new MWStruct object and creates a deep copy of the object’s
contents. Call this function when a separate object is required instead of a
shared copy of an existing object reference.

Example
The following Visual Basic example illustrates the difference between
assignment and Clone for MWStruct objects.

Sub foo ()
Dim x1 As MWStruct
Dim x2 As MWStruct
Dim x3 As MWStruct

On Error Goto Handle_Error
Set x1 = new MWStruct
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x1("name") = "John Smith"
x1("age") = 35

'Set reference of x1 to x2

Set x2 = x1

'Create new object for x3 and copy contents of x1 into it
Call x1.Clone(x3)

'x2's "age" field 1is

'also modified 'x3's "age" field unchanged

x1("age") = 50

Exit Sub
Handle_Error:

MsgBox (Err.Description)
End Sub
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Class MWField

The MWField class holds a single field reference in an MWStruct object. This
class is noncreatable and contains four properties/methods:

In this section...

“Property Name As String” on page 10-29
“Property Value As Variant” on page 10-29
“Property MWFlags As MWFlags” on page 10-29
“Sub Clone(ppField As MWField)” on page 10-29

Property Name As String
The name of the field (read only).

Property Value As Variant

Stores the field’s value (read/write). The Value property is the default
property of the MWField class. The value of a field can be any type that is
coercible to a Variant, as well as object types.

Property MWFlags As MWFlags

Stores a reference to an MWFlags object. This property sets or gets the array
formatting and data conversion flags for a particular field. Each field in a
structure has its own MWFlags property. This property overrides the value of
any flags set on the object whose methods are called.

Sub Clone(ppField As MWField)

Creates a copy of an MWField object.
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Parameters
Argument Type Description
ppField MWField Reference to an

uninitialized MWField
object to receive the

copy

Return Value
None.

Remarks

Clone allocates a new MWField object and creates a deep copy of the object’s
contents. Call this function when a separate object is required instead of a
shared copy of an existing object reference.



Class MWComplex

Class MWComplex

The MWComplex class passes or receives a complex numeric array into or from
a compiled class method. This class contains four properties/methods:

In this section...

“Property Real As Variant” on page 10-31

“Property Imag As Variant” on page 10-31

“Property MWFlags As MWFlags” on page 10-32

“Sub Clone(ppComplex As MWComplex)” on page 10-32

Property Real As Variant

Stores the real part of a complex array (read/write). The Real property is the
default property of the MWComplex class. The value of this property can be any
type coercible to a Variant, as well as object types, with the restriction that
the underlying array must resolve to a numeric matrix (no cell data allowed).
Valid Visual Basic numeric types for complex arrays include Byte, Integer,
Long, Single, Double, Currency, and Variant/vbDecimal.

Property Imag As Variant

Stores the imaginary part of a complex array (read/write). The Imag property
is optional and can be Empty for a pure real array. If the Imag property is not
empty and the size and type of the underlying array do not match the size
and type of the Real property’s array, an error results when the object is
used in a method call.

Example
The following Visual Basic code creates a complex array with the following
entries:

X = [ 141 1+21
2+i 2+21 ]
Sub foo()
Dim x As MWComplex
Dim rval(1 To 2, 1 To 2) As Double
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Dim ival(1 To 2, 1 To 2) As Double

On Error Goto Handle Error
For I =1 To 2
For Jd =1 To 2
rval(I,d) =
ival(I,J)

|
C H

Next
Next
Set x = new MWComplex
x.Real = rval
x.Imag = ival

Exit Sub
Handle_Error:

MsgBox (Err.Description)
End Sub

Property MWFlags As MWFlags

Stores a reference to an MWFlags object. This property sets or gets the array
formatting and data conversion flags for a particular complex array. Each
MWComplex object has its own MWFlags property. This property overrides the
value of any flags set on the object whose methods are called.

Sub Clone(ppComplex As MWComplex)

Creates a copy of an MWComplex object.

Parameters
Argument Type Description
ppComplex MWComplex Reference to

an uninitialized
MWComplex object to
receive the copy
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Return Value
None

Remarks

Clone allocates a new MWComplex object and creates a deep copy of the object’s
contents. Call this function when a separate object is required instead of a
shared copy of an existing object reference.
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The MWSparse class passes or receives a two-dimensional sparse numeric array
into or from a compiled class method. This class has seven properties/methods:

In this section...

“Property NumRows As Long” on page 10-34
“Property NumColumns As Long” on page 10-34
“Property RowIndex As Variant” on page 10-34
“Property ColumnIndex As Variant” on page 10-35
“Property Array As Variant” on page 10-35
“Property MWFlags As MWFlags” on page 10-35
“Sub Clone(ppSparse As MWSparse)” on page 10-35

Property NumRows As Long

Stores the row dimension for the array. The value of NumRows must be
nonnegative. If the value is zero, the row index is taken from the maximum
of the values in the RowIndex array.

Property NumColumns As Long

Stores the column dimension for the array. The value of NumColumns must be
nonnegative. If the value is zero, the row index is taken from the maximum of
the values in the ColumnIndex array.

Property Rowlindex As Variant

Stores the array of row indices of the nonzero elements of the array. The
value of this property can be any type coercible to a Variant, as well as object
types, with the restriction that the underlying array must resolve to or be
coercible to a numeric matrix of type Long. If the value of NumRows is nonzero
and any row index is greater than NumRows, a bad-index error occurs. An error
also results if the number of elements in the RowIndex array does not match
the number of elements in the Array property’s underlying array.
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Property Columnindex As Variant

Stores the array of column indices of the nonzero elements of the array. The
value of this property can be any type coercible to a Variant, as well as object
types, with the restriction that the underlying array must resolve to or be
coercible to a numeric matrix of type Long. If the value of NumColumns is
nonzero and any column index is greater than NumColumns, a bad-index error
occurs. An error also results if the number of elements in the ColumnIndex
array does not match the number of elements in the Array property’s
underlying array.

Property Array As Variant

Stores the nonzero array values of the sparse array. The value of this
property can be any type coercible to a Variant, as well as object types, with
the restriction that the underlying array must resolve to or be coercible to a
numeric matrix of type Double or Boolean.

Property MWFlags As MWFlags

Stores a reference to an MWFlags object. This property sets or gets the array
formatting and data conversion flags for a particular sparse array. Each
MWSparse object has its own MWFlags property. This property overrides the
value of any flags set on the object whose methods are called.

Sub Clone(ppSparse As MWSparse)

Creates a copy of an MWSparse object.

Parameters
Argument Type Description
ppSparse MWSparse Reference to an

uninitialized MWSparse
object to receive the

copy
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Return Value
None.

Remarks

Clone allocates a new MWSparse object and creates a deep copy of the object’s
contents. Call this function when a separate object is required instead of a
shared copy of an existing object reference.

Example

The following Visual Basic sample creates a 5-by-5 tridiagonal sparse array
with the following entries:

X=12 -1 0 0
-1 2 -1 0 0
0 -1 -1 0
0O 0 -1 2 -1
00 -1 2]
Sub foo()

Dim x As MWSparse

Dim rows(1 To 13) As Long
Dim cols(1 To 13) As Long
Dim vals(1 To 13) As Double
Dim I As Long, K As Long

On Error GoTo Handle Error
K =1

In = 1

In = 1

)
)
)
+
)
) =1
) 2
+
)
)
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vals(K) = -1
K=K+ 1

Next

rows(K) =5

cols(K) =5

vals(K) = 2

Set x = New MWSparse

X.NumRows = 5
.NumColumns = 5
.RowIndex = rows
.ColumnIndex = cols
.Array = vals

Exit Sub
Handle_Error:

MsgBox (Err.Description)
End Sub
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Class MWArg
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The MWArg class passes a generic argument into a compiled class method. This
class passes an argument for which the data conversion flags are changed for
that one argument. This class has three properties/methods:

In this section...

“Property Value As Variant” on page 10-38
“Property MWFlags As MWFlags” on page 10-38

“Sub Clone(ppArg As MWArg)” on page 10-38

Property Value As Variant

The Value property stores the actual argument to pass. Any type that can be
passed to a compiled method is valid for this property.

Property MWFlags As MWFlags

Stores a reference to an MWFlags object. This property sets or gets the array
formatting and data conversion flags for a particular argument. Each MWArg
object has its own MWFlags property. This property overrides the value of any
flags set on the object whose methods are called.

Sub Clone(ppArg As MWArg)

Creates a copy of an MWArg object.

Parameters
Argument Type Description
ppPArg MWArg Reference to an

uninitialized MWArg
object to receive the

copy
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Return Value
None.

Remarks

Clone allocates a new MWArg object and creates a deep copy of the object’s
contents. Call this function when a separate object is required instead of a
shared copy of an existing object reference.
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Enum mwArrayFormat

The mwArrayFormat enumeration is a set of constants that denote an array
formatting rule for data conversion.

mwArrayFormat Values

Constant Numeric Value Description

mwArrayFormatAsIs 0 Do not reformat the
array.

mwArrayFormatMatrix | 1 Format the array as a
matrix.

mwArrayFormatCell 2 Format the array as a
cell array.
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Enum mwDataType

The mwDataType enumeration is a set of constants that denote a MATLAB
numeric type.

mwDataType Values

Constant Numeric Value MATLAB Type
mwTypeDefault 0 Not applicable
mwTypelLogical 3 logical
mwTypeChar 4 char
mwTypeDouble 6 double
mwTypeSingle 7 single
mwTypelInt8 8 int8
mwTypeUint8 9 uint8
mwTypeInt16 10 int16
mwTypeUint16 11 uint16
mwTypeInt32 12 int32
mwTypeUint32 13 uint32
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Enum mwDateFormat

The mwDateFormat enumeration is a set of constants that denote a formatting

rule for dates.

mwDateFormat Values

Constant Numeric Value Description

mwDateFormatNumeric | O Format dates as
numeric values

mwDateFormatString 1 Format dates as strings
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e “Data Conversion Rules ” on page A-2
* “Array Formatting Flags” on page A-12

e “Data Conversion Flags” on page A-14
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Data Conversion Rules

This topic describes the data conversion rules for the MATLAB Builder EX
components. These components are dual interface Microsoft COM objects that
support data types compatible with Automation.

Note Automation (formerly called OLE Automation) is a technology that
allows software packages to expose their unique features to scripting tools
and other applications. Automation uses the Component Object Model (COM),
but may be implemented independently from other OLE features, such as
in-place activation.

When a method is invoked on a MATLAB Builder EX component, the
input parameters are converted to the MATLAB internal array format and
passed to the compiled MATLAB function. When the function exits, the
output parameters are converted from the MATLAB internal array format
to COM Automation types.

The COM client passes all input and output arguments in the compiled
MATLAB functions as type VARIANT. The COM VARIANT type is a union of
several simple data types. A type VARIANT variable can store a variable of any
of the simple types, as well as arrays of any of these values.

The Win32 application program interface (API) provides many functions for
creating and manipulating VARIANTs in C/C++, and Visual Basic provides
native language support for this type.

Note This discussion of data refers to both VARIANT and Variant data types.
VARIANT is the C++ name and Variant is the corresponding data type in
Visual Basic.

See the Visual Studio® documentation for definitions and API support for
COM VARIANTs. VARIANT variables are self describing and store their type
code as an internal field of the structure.
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The following table lists the VARIANT type codes supported by the MATLAB
Builder EX components.

VARIANT Type Codes Supported

VARIANT Type Code | C/C++ Type variant Type | Visual Definition
(C/C++) Code BasicType
(Visual Basic)

VT_EMPTY VvbEmpty Uninitialized
VARIANT

VT_IA char Signed one-byte
character

VT _UIAT unsigned char | vbByte Byte Unsigned one-byte
character

VT_I2 short vbInteger Integer Signed two-byte
integer

VT _UI2 unsigned — — Unsigned two-byte

short integer

VT 14 long vbLong Long Signed four-byte
integer

VT UI4 unsigned long | — — Unsigned four-byte
integer

VT_R4 float vbSingle Single IEEE® four-byte
floating-point value

VT _R8 double vbDouble Double IEEE eight-byte
floating-point value

VT_CY cy* vbCurrency Currency | Currency value
(64-bit integer, scaled
by 10,000)

VT_BSTR BSTR* vbString String String value

VT_ERROR SCODE™ vbError — An HRESULT (signed

four-byte integer
representing a COM
error code)
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VARIANT Type Codes Supported (Continued)

VARIANT Type Code
(C/C++)

C/C++ Type

Variant Type
Code
(Visual Basic)

Visual
BasicType

Definition

VT_DATE

DATE*

vbDate

Date

Eight-byte floating
point value
representing date
and time

VT_INT

int

Signed integer;
equivalent to type
int

VT_UINT

unsigned int

Unsigned integer;
equivalent to type
unsigned int

VT_DECIMAL

DECIMAL*

vbDecimal

96-bit (12-byte)
unsigned integer,
scaled by a variable
power of 10

VT_BOOL

VARIANT_BOOL*

vbBoolean

Boolean

Two-byte Boolean
value (OxFFFF =
True; 0x0000 = False)

VT_DISPATCH

IDispatch*

vbObject

Object

IDispatch* pointer
to an object

VT_VARIANT

VARIANT*

vbVariant

Variant

VARIANT (can only be
specified if combined
with VT_BYREF or
VT_ARRAY)

<anything>|VT_ARRAY

Bitwise combine
VT_ARRAY with any
basic type to declare
as an array
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VARIANT Type Codes Supported (Continued)

VARIANT Type Code

(C/C++)

C/C++ Type

Variant Type
Code
(Visual Basic)

Visual

BasicType

Definition

<anything>|VT_BYREF | — —

Bitwise combine
VT_BYREF with any
basic type to declare
as a reference to a
value

* Denotes Windows-specific type. Not part of standard C/C++.

MATLAB to COM VARIANT Conversion Rules

The following table lists the rules for converting from MATLAB to COM.

MATLAB Data VARIANT Type for VARIANT Type for
Type Scalar Data Array Data Comments
cell A 1-by-1 cell array A multidimensional
converts to a single cell array converts
VARIANT with a type to a VARIANT of type
conforming to the VT_VARIANT |VT_ARRAY
conversion rule for the | with the type of
MATLAB data type of | each array member
the cell contents. conforming to the
conversion rule for the
MATLAB data type of
the corresponding cell.
structure VT_DISPATCH VT_DISPATCH A MATLAB struct

array is converted to
an MWStruct object.
(See “Class MW Struct”)
This object is passed as
a VT_DISPATCH type.
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MATLAB to COM VARIANT Conversion Rules (Continued)

MATLAB Data VARIANT Type for VARIANT Type for
Type Scalar Data Array Data Comments
char A 1-by-1 char matrix A 1-by-L char matrix is | Arrays of strings are
converts to a VARIANT assumed to represent not supported as char
of type VT_BSTR with a string of length Lin matrices. To pass an
string length = 1. MATLAB. This case array of strings, use
converts to a VARIANT | a cell array of 1-by-L
of type VT_BSTR with a | char matrices.
string length = L.. char
matrices of more than
one row, or of a higher
dimensionality convert
to a VARIANT of type
VT_BSTR|VT_ARRAY.
Each string in the
converted array
is of length 1 and
corresponds to each
character in the
original matrix.
sparse VT_DISPATCH VT_DISPATCH A MATLAB sparse
array is converted to an
MWSparse object. (See
“Class MWSparse”)
This object is passed as
a VT_DISPATCH type.
double A real 1-by-1 double A real Complex arrays are
matrix converts to multidimensional passed to and from

a VARIANT of type
VT_R8. A complex
1-by-1 double matrix
converts to a VARIANT
of type VT_DISPATCH.

double matrix converts
to a VARIANT of type
VT_R8|VT_ARRAY.

A complex
multidimensional
double matrix converts
to a VARIANT of type
VT_DISPATCH.

compiled MATLAB
functions using the
MWComplex class. (See
“Class MWComplex” on
page 10-31)
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MATLAB to COM VARIANT Conversion Rules (Continued)

MATLAB Data VARIANT Type for VARIANT Type for
Type Scalar Data Array Data Comments
single A real 1-by-1 single A real Complex arrays are
matrix converts to a multidimensional passed to and from
VARIANT of type VT_R4. | single matrix converts | compiled MATLAB
A complex 1-by-1 single | to a VARIANT of type functions using the
matrix converts to VT_R4|VT_ARRAY. MWComplex class. (See
a VARIANT of type A complex “Class MW Complex” on
VT_DISPATCH. multidimensional page 10-31)
single matrix converts
to a VARIANT of type
VT_DISPATCH.
int8 A real 1-by-1 int8 A real Complex arrays are
matrix converts to a multidimensional int8 | passed to and from
VARIANT of type VT_I1. | matrix converts to compiled MATLAB
A complex 1-by-1 int8 | a VARIANT of type functions using the
matrix converts to VT_I1|VT_ARRAY. MWComplex class. (See
a VARIANT of type A complex “Class MWComplex” on
VT_DISPATCH. multidimensional int8 | page 10-31)
matrix converts to
a VARIANT of type
VT_DISPATCH.
uint8 A real 1-by-1 uint8 A real Complex arrays are
matrix converts to multidimensional passed to and from

a VARIANT of type

VT _UI1. A complex
1-by-1 uint8 matrix
converts to a VARIANT
of type VT_DISPATCH.

uint8 matrix converts
to a VARIANT of type
VT_UI1|VT_ARRAY.A
complex
multidimensional
uint8 matrix converts
to a VARIANT of type
VT_DISPATCH.

compiled MATLAB
functions using the
MWComplex class. (See
“Class MWComplex” on
page 10-31)
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MATLAB to COM VARIANT Conversion Rules (Continued)

MATLAB Data VARIANT Type for VARIANT Type for
Type Scalar Data Array Data Comments
int16 A real 1-by-1 int16 A real Complex arrays are
matrix converts to a multidimensional passed to and from
VARIANT of type VT_I2. | int16 matrix converts | compiled MATLAB
A complex 1-by-1 int16 | to a VARIANT of type functions using the
matrix converts to VT_I2|VT_ARRAY. MWComplex class. (See
a VARIANT of type A complex “Class MW Complex” on
VT_DISPATCH. multidimensional page 10-31)
int16 matrix converts
to a VARIANT of type
VT_DISPATCH.
uinti16 A real 1-by-1 uint16 A real Complex arrays are
matrix converts to multidimensional passed to and from
a VARIANT of type uint16 matrix converts | compiled MATLAB
VT_UI2. A complex to a VARIANT of type functions using the
1-by-1 uint16 matrix VT_UI2|VT_ARRAY. MWComplex class. (See
converts to a VARIANT | A complex “Class MWComplex” on
of type VT_DISPATCH. multidimensional page 10-31)
uint16 matrix converts
to a VARIANT of type
VT_DISPATCH.
int32 A 1-by-1 int32 matrix | A multidimensional Complex arrays are

converts to a VARIANT of
type VT_I4. A complex
1-by-1 int32 matrix
converts to a VARIANT
of type VT_DISPATCH.

int32 matrix converts
to a VARIANT of type
VT_I4|VT_ARRAY.

A complex
multidimensional
int32 matrix converts
to a VARIANT of type
VT_DISPATCH.

passed to and from
compiled MATLAB
functions using the
MWComplex class. (See
“Class MWComplex” on
page 10-31)




Data Conversion Rules

MATLAB to COM VARIANT Conversion Rules (Continued)

MATLAB Data VARIANT Type for VARIANT Type for
Type Scalar Data Array Data Comments
uint32 A 1-by-1 uint32 matrix | A multidimensional Complex arrays are

converts to a VARIANT of | uint32 matrix converts | passed to and from
type VT_UI4. A complex | to a VARIANT of type compiled MATLAB

1-by-1 uint32 matrix VT_UI4|VT_ARRAY. functions using the
converts to a VARIANT | A complex MWComplex class. (See
of type VT_DISPATCH. multidimensional “Class MWComplex” on

uint32 matrix converts | page 10-31)
to a VARIANT of type
VT_DISPATCH.

Function handle VT_EMPTY VT_EMPTY Not supported
Java class VT_EMPTY VT_EMPTY Not supported
User class VT_EMPTY VT_EMPTY Not supported
logical VT_Bool VT_Bool|VT_ARRAY

The following table lists the rules for conversion from COM to MATLAB.

COM VARIANT to MATLAB Conversion Rules

MATLAB Data Type
(scalar or array
VARIANT Type data) Comments
VT_EMPTY Not applicable Empty array created.
VT_If int8
VT_UTH uints
VT_I2 int16
VT_UI2 uint16
VT_14 int32
VT_UI4 uint32
VT_R4 single
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COM VARIANT to MATLAB Conversion Rules (Continued)

MATLAB Data Type
(scalar or array

VARIANT Type data) Comments

VT_R8 double

VT_CY double

VT_BSTR char A VARIANT of type VT_BSTR converts to a
1-by-LL MATLAB char array, where L =
the length of the string to be converted.
A VARIANT of type VT_BSTR|VT_ARRAY
converts to a MATLAB cell array of 1-by-L
char arrays.

VT_ERROR int32

VT_DATE double 1. VARIANT dates are stored as doubles
starting at midnight Dec. 31, 1899. The
MATLAB dates are stored as doubles
starting at 0/0/00 00:00:00. Therefore, a
VARIANT date of 0.0 maps to a MATLAB
numeric date of 693960.0. VARIANT dates
are converted to MATLAB double types
and incremented by 693960.0.
2. VARIANT dates can be optionally
converted to strings. See “Data Conversion
Flags” on page A-14 for more information
on type coercion.

VT_INT int32

VT_UINT uint32

VT_DECIMAL double

VT_BOOL logical
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COM VARIANT to MATLAB Conversion Rules (Continued)

MATLAB Data Type
(scalar or array
VARIANT Type data) Comments

VT_DISPATCH (varies) IDispatch* pointers are treated within
the context of what they point to. Objects
must be supported types with known data
extraction and conversion rules, or expose
a generic Value property that points to a
single VARIANT type. Data extracted from
an object 1s converted based upon the rules
for the particular VARIANT obtained.

Currently, support exists for Excel Range
objects as well as the MATLAB Builder
EX types MWStruct, MWComplex, MWSparse,
and MWArg.

<anything>|VT_BYREF (varies) Pointers to any of the basic types are
processed according to the rules for what
they point to. The resulting MATLAB
array contains a deep copy of the values.

<anything>|VT_ARRAY (varies) Multidimensional VARIANT arrays convert
to multidimensional MATLAB arrays, each
element converted according to the rules for
the basic types. Multidimensional VARIANT
arrays of type VT_VARIANT |VT_ARRAY
convert to multidimensional cell arrays,
each cell converted according to the rules
for that specific type.
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Array Formatting Flags

The MATLAB Builder EX components have flags that control how array data
is formatted in both directions. Generally, you should develop client code that
matches the intended inputs and outputs of the MATLAB functions with the
corresponding methods on the compiled COM objects, in accordance with the
rules listed in MATLAB® to COM VARIANT Conversion Rules on page A-5
and COM VARIANT to MATLAB® Conversion Rules on page A-9. In some
cases this is not possible, for example, when existing MATLAB code is used in
conjunction with a third-party product like Excel.

The following table shows the array formatting flags.

Array Formatting Flags

Flag

Description

InputArrayFormat

Defines the array formatting rule used on input arrays.
An input array is a VARIANT array, created by the
client, sent as an input parameter to a method call on a
compiled COM object.

Valid values for this flag are mwArrayFormatAsIs,
mwArrayFormatMatrix, and mwArrayFormatCell.

mwArrayFormatAsIs passes the array unchanged.

mwArrayFormatMatrix (default) formats all arrays

as matrices. When the input VARIANT is of type
VT_ARRAY| type, where type is any numeric type,
this flag has no effect. When the input VARIANT is of
type VT_VARIANT|VT_ARRAY, VARIANTs in the array are
examined. If they are single-valued and homogeneous
in type, a MATLAB matrix of the appropriate type is
produced instead of a cell array.

mwArrayFormatCell interprets all arrays as MATLAB
cell arrays.

InputArrayIndFlag

Sets the input array indirection level used with the
InputArrayFormat flag (applicable only to nested arrays,
1.e., VARIANT arrays of VARIANTs, which themselves are
arrays). The default value for this flag is zero, which
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Array Formatting Flags (Continued)

Description

applies the InputArrayFormat flag to the outermost
array. When this flag is greater than zero, e.g., equal
to N, the formatting rule attempts to apply itself to the
Nth level of nesting.

OutputArrayFormat

Defines the array formatting rule used on output arrays.
An output array is a MATLAB array, created by the
compiled COM object, sent as an output parameter
from a method call to the client. The values for this
flag, mwArrayFormatAsIs, mwArrayFormatMatrix, and
mwArrayFormatCell, cause the same behavior as the
corresponding InputArrayFormat flag values.

OutputArrayIndFlag

(Applies to nested cell arrays only.) Output array
indirection level used with the OutputArrayFormat flag.
This flag works exactly like InputArrayIndFlag.

AutoResizeOutput

(Applies to Excel ranges only.) When the target output
from a method call is a range of cells in an Excel
worksheet and the output array size and shape is not
known at the time of the call, set this flag to True to
resize each Excel range to fit the output array.

TransposeOutput

Set this flag to True to transpose the output arguments.
Useful when calling a MATLAB Builder EX component
from Excel where the MATLAB function returns outputs
as row vectors, and you want the data in columns.
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Data Conversion Flags

In this section...

“CoerceNumericToType” on page A-14
“InputDateFormat” on page A-15
“OutputAsDate As Boolean” on page A-16

“DateBias As Long” on page A-16

CoerceNumericToType

This flag tells the data converter to convert all numeric VARIANT data to one
specific MATLAB type.

VARIANT type codes affected by this flag are
VT_I1
VT_UT1
VT_I2
VT_UI2
VT_14
VT_UI4
VT_R4
VT_R8
VT_CY
VT_DECIMAL

VT_INT
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VT_UINT
VT_ERROR
VT_BOOL
VT_DATE

Valid values for this flag are
mwTypeDefault
mwTypeChar
mwTypeDouble
mwTypeSingle
mwTypeLogical
mwTypeInt8
mwTypeUint8
mwTypeInti16
mwTypeUint16
mwTypeInt32

mwTypeUint32

The default for this flag, mwTypeDefault, converts numeric data according to

the rules listed in “Data Conversion Rules ” on page A-2.

InputDateFormat

This flag tells the data converter how to convert VARIANT dates to the
MATLAB dates. Valid values for this flag are mwDateFormatNumeric
(default) and mwDateFormatString. The default converts VARIANT dates
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according to the rule listed in VARIANT Type Codes Supported on page
A-3. The mwDateFormatString flag converts a VARIANT date to its string
representation. This flag only affects VARIANT type code VT_DATE.

OutputAsDate As Boolean

This flag instructs the data converter to process an output argument as a
date. By default, numeric dates that are output parameters from compiled
MATLAB functions are passed as Doubles that need to be decremented by
the COM date bias (693960) as well as coerced to COM dates. Set this flag to
True to convert all output values of type Double.

DateBias As Long

This flag sets the date bias for performing COM to the MATLAB numeric date
conversions. The default value of this property is 693960, which represents
the difference between the COM Date type and the MATLAB numeric dates.
This flag allows existing MATLAB code that already performs the increment
of numeric dates by 693960 to be used unchanged with the MATLAB Builder
EX components. To process dates with such code, set this property to 0.
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Errors and Solutions

B-2

In this section...

“MATLAB® Builder™ EX Errors and Suggested Solutions” on page B-3
“Required Locations to Develop and Use Components” on page B-6

“Microsoft® Excel® Errors and Suggested Solutions” on page B-7

“Function Wizard Problems” on page B-9

This appendix provides a table showing errors you may encounter using
MATLAB Builder EX, probable causes for these errors, and suggested
solutions.

Note MATLAB Builder EX uses MATLAB Compiler to generate components.
This means that you might see diagnostic messages from MATLAB Compiler.
See the MATLAB Compiler documentation for more information about those
messages.




Errors and Solutions

MATLAB Builder EX Errors and Suggested Solutions

Message

Probable Cause

Suggested Solution

MBUILD.BAT: Error: The
chosen compiler does

not support building COM
objects.

The chosen compiler
does not support
building COM objects.

Rerun mbuild -setup -client
mbuild com and choose a supported
compiler.

Error in

component_name.class_name:

Error getting data
conversion flags.

Usually caused by
mwcomutil.dll not
being registered.

Open a DOS window, change
folders to matlabroot\bin\win32
(matlabroot represents the location
of MATLAB on your system), and
run the command

mwregsvr mwcomutil.dll.

See “Add-in and COM Component
Registration” on page 1-19 for full
details.

Error in VBAProject:
ActiveX component can't
create object.

e Project DLL is not
registered.

® An incompatible
MATLAB DLL exists
somewhere on the
system path.

If the DLL is not registered,
open a DOS window, change
folders to <projectdir>\distrib
(<projectdir> represents the
location of your project files), and
run the command:

mwregsvr <projectdll>.dll.

See “Add-in and COM Component
Registration” on page 1-19 for full
details.

Error in VBAProject:
Automation error The
specified module could
not be found.

This usually occurs if
MATLAB is not on the
system path. This error
message occurs if you
have more than one
version of MATLAB on
your system path.

Anytime you have multiple versions
of MATLAB, ensure that the newest
version of MATLAB appears on
your path first. You can verify that
the newest version of MATLAB is
on the path first by typing path

at the DOS prompt. See the table
“Required Locations to Develop and
Use Components” on page B-6.
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(Continued)
Message Probable Cause Suggested Solution
LoadLibrary You may get this See the table “Required Locations to

("component_name.d11l")
failed - The specified
module could not be
found.

Develop and Use Components” on
page B-6.

error message while
registering the project
DLL from the DOS
prompt. This usually
occurs if MATLAB is not
on the system path.

Cannot recompile the M
file xxxx because it is

Rename the MATLAB file, choosing
a name that does not duplicate the

The name you have
chosen for your

already in the library
libmmfile.mlib.

MATLARB file duplicates
the name of a MATLAB

file already in the library
of precompiled MATLAB
files.

name of a MATLAB file already in
the library of precompiled MATLAB
files.

Arguments may only be

defaulted at the end of

an argument list.

You have modified the
VB script generated for
MATLAB Builder EX
and have not provided
one or more arguments
used in the modified
script.

Provide a value for any argument
that requires an explicit value.
Arguments that accept defaults
appear at the end of the argument
list.

Unable to use accessibility

screen-readers or assistive

technologies, such as JAWS®,

Required files
JavaAccessBridge.dll
and
WindowsAccessBridge.dl
no longer added
automatically to your
Windows path.

Add the following DLLs to your
Windows path:

yYavaAccessBridge.dll
WindowsAccessBridge.dll




Errors and Solutions

(Continued)
Message Probable Cause Suggested Solution
Error in This is a generic See “Deployment Target

class.method.version

message, but is
sometimes seen when
there are conflicts in
architecture versions of
MATLAB and Microsoft
Excel.

Architectures and Compatibility” on
page 1-8 for detailed information.

Error:

Error IMWDispatchDriver
"Method Load of object
IMWDispatchDriver failed"

Different versions of
MCR and MATLAB
results in the
IMWDispatchDriver
error.

Check for the current versions of
MATLAB and MCR. Verify the
MATLAB version by typing the
MATLAB path in DOS prompt. If
the versions do not match update
and install the new version of MCR
that matches the current MATLAB
version.

Error in VBA project:
Method xxx of object
‘IClass1' failed

Multiple versions of
MATLAB running on
the system results in
this error.

Register the mwcomutil.dll and
mwcommgr.dll registry files.
Open a DOS window, cd to
matlabroot\bin\win64 or win
32(matlabroot represents the
location of MATLAB on your
system), and run the command
mwregsvr mwcomutil.dll
mwregsvr mwcommgr.dll
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Required Locations to Develop and Use Components

Component

Development Machine

Target Machine

MCR

Make sure that
matlabroot\bin\win32
appears on your system
path ahead of any other
MATLAB installations.
(matlabroot is your root
MATLAB folder.)

Verify that
mer_root\ver\runtime\win32
appears on your system path.
(mcr_root is your root MCR
folder.)
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Microsoft Excel Errors and Suggested Solutions

Message

Probable Cause

Suggested Solution

The macros in this project are
disabled. Please refer to the online
help or documentation of the host
application to determine how to
enable macros.

Note: Wording may vary
depending upon the version of
Excel you are running.

The macro security for
Excel is set to High.

Set Excel macro security to
Medium on the Security Level
tab by doing the following:

¢ For Microsoft Office 2003:

1 Click

Tools > Macro > Security.

2 For Security Level, select
Medium.

e For Microsoft Office 2007:

1 Click the 2007 Office button
on the Microsoft Office
Cin
ribbon ().
2 Click Excel Options >
Trust Center > Trust

Center Settings > Macro
Settings.

3 In Developer Macro
Settings, select Trust
access to the VBA project
object model.

e For Microsoft Office 2010:

1 Click File > Options >
Trust Center > Trust
Center Settings > Macro
Settings.
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(Continued)

Message

Probable Cause

Suggested Solution

2 In Developer Macro
Settings, select Trust
access to the VBA project
object model.




Errors and Solutions

Function Wizard Problems

Problem

Probable Cause

Suggested Solution

The Function Wizard Help
does not appear.

The Function Wizard Help
file (m1function.chm) is
not in the same folder as
the Function Wizard add-in
(mlfunction.xla).

Copy the Help file
(mlfunction.chm) into the
same folder as the add-in.

The Function Wizard did not
automatically import your
.bas file, and you have to
create your macro manually

You get an error when trying
to create a macro with the
Function Wizard

The Function Wizard has
malfunctioned with an
unspecified error

1 Open Excel

2 Do one of the following:

¢ If you use Microsoft
Office 2007 or 2010, click
Developer > Macros.

¢ If you use Microsoft
Office 2003, click Tools >
Macros > Macro.
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(Continued)

Problem

Probable Cause

Suggested Solution

Tip You may need to enable
the Developer menu item
before performing this step.
To do this:

Click the 2007 Office
button on the Microsoft
Ca
Office ribbon ()
or, in Office 2010, click
File to display the Office
Backstage View.

Click Excel Options.

In the Top Options
for Working With
Excel area, select Show
Developer tab in the
Ribbon.

3 From the Visual Basic
Editor, select File > Import
and select the created
VBA file from the
<project_dir>\distrib
folder.




Errors and Solutions

(Continued)

Problem

Probable Cause

Suggested Solution

The message Failed to
start MATLAB appears instead
of Starting MATLAB... when
MATLAB is invoked by the
Function Wizard.

This message may appear
if you manually terminate
the MATLAB session that is
invoked from the Function
Wizard. As a result, you can
no longer use the wizard’s
MATLAB-related features in
your current Excel session.

Save your work and restart
Microsoft Excel.

When I use CTRL + arrow
keys to select ranges with the
Function Wizard, once I select
a function and begin to select
the function inputs, keyboard
navigation no longer works in
excel.

This behavior results from a
bug in Microsoft Excel.

If you must use arrow keys

to select ranges, apply

the following fix from

the Microsoft Web site:
http://support.microsoft.com/kb/291110
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A

Add-in — A Microsoft Excel add-in is an executable piece of code that can be
actively integrated into a Microsoft Excel application. Add-ins are front-ends
for COM components, usually written in some form of Microsoft Visual Basic.

Application program interface (API) — A set of classes, methods, and
interfaces that is used to develop software applications. Typically an API is
used to provide access to specific functionality. See MWArray.

Application — An end user-system into which a deployed functions or
solution is ultimately integrated. Typically, the end goal for the Deployment
customer is integration of a deployed MATLAB function into a larger
enterprise environment application. The deployment products prepare

the MATLAB function for integration by wrapping MATLAB code with
enterprise-compatible source code, such as C, C++, C# (NET), F#, and Java
code.

Assembly — An executable bundle of code, especially in .NET. For example,
after building a deployable .NET component with MATLAB Builder NE,
the .NET developer integrates the resulting .NET assembly into a larger
enterprise C# application. See Executable.

B

Binary — See Executable.

Boxed Types — Data types used to wrap opaque C structures.

Build — See Compile.

C

Class — A user-defined type used in C++, C#, and Java, among other
object-oriented languages, that is a prototype for an object in an object-oriented
language. It is analogous to a derived type in a procedural language. A class

is a set of objects which share a common structure and behavior. Classes
relate in a class hierarchy. One class is a specialization (a subclass) of another



Deployment Product Terms

(one of its superclasses) or comprises other classes. Some classes use other
classes in a client-server relationship. Abstract classes have no members, and
concrete classes have one or more members. Differs from a MATLAB class

Compile — In MATLAB Compiler terminology, to compile a component
involves generating a binary that wraps around MATLAB code, enabling it to
execute in various computing environments. For example, when MATLAB
code builds with MATLAB Builder JA, a Java wrapper provides Java code
that enables the MATLAB code to execute in a Java environment.

COM component — In MATLAB Builder EX, the executable back-end code
behind a Microsoft Excel add-in. In MATLAB Builder NE, an executable
component, to be integrated with Microsoft COM applications.

Component — In MATLAB, a generic term used to describe the wrappered
MATLAB code produced by MATLAB Compiler. You can plug these
self-contained bundles of code you plug into various computing environments.
The wrapper enables the compatibility between the computing environment
and your code.

Console application — Any application that is executed from a system
command prompt window.

CTF archive (Component Technology File) — The Component Technology File
(CTF) archive is embedded by default in each generated binary by MATLAB
Compiler. It houses the deployable package. All MATLAB-based content in
the CTF archive uses the Advanced Encryption Standard (AES) cryptosystem.
See “Additional Details” in the MATLAB Compiler documentation.

D

Data Marshaling — Data conversion, usually from one type to another.
Unless a MATLAB deployment customer is using type-safe interfaces, data
marshaling—as from mathematical data types to MathWorks data types such
as represented by the MWArray API—must be performed manually, often

at great cost.

Deploy — The act of integrating a component into a larger-scale computing
environment, usually to an enterprise application, and often to end users.
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DLL — Dynamic link library. Microsoft’s implementation of the shared
library concept for Windows. Using DLLs is much preferred over the previous
technology of static (or non-dynamic) libraries, which had to be manually
linked and updated.

E
Empties — Arrays of zero (0) dimensions.

Executable — An executable bundle of code, made up of binary bits (zeros and
ones) and sometimes called a binary.

F

Fields — For this definition in the context of MATLAB Data Structures, see
Structs.

Fields and Properties — In the context of NET, Fields are specialized classes
used to hold data. Properties allow users to access class variables as if they
were accessing member fields directly, while actually implementing that
access through a class method.

H

Helper files — Files that support the main file or the file that calls all
supporting functions. Add resources that depend upon the function that
calls the supporting function to the Shared Resources and Helper Files
section of the Deployment Tool GUI. Other examples of supporting files or
resources include:

¢ Functions called using eval (or variants of eval)
¢ Functions not on the MATLAB path
® Code you want to remain private

® Code from other programs that you want to compile and link into the
main file
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Integration — Combining a deployed component’s functionality with
functionality that currently exists in an enterprise application. For example,
a customer creates a mathematical model to forecast trends in certain
commodities markets. In order to use this model in a larger-scale financial
application (one written with the Microsoft NET Framework, for instance)
the deployed financial model must be integrated with existing C# applications,
run in the NET enterprise environment. Integration is usually performed by
an IT developer, rather than a MATLAB Programmer, in larger environments.

Instance — For the definition of this term in context of MATLAB Production
Server software, see MATLAB Production Server Server Instance.

dJ

JAR — Java archive. In computing software, a JAR file (or Java ARchive)
aggregates many files into one. Software developers use JARs to distribute
Java applications or libraries, in the form of classes and associated metadata
and resources (text, images, etc.). Computer users can create or extract JAR
files using the jar command that comes with a Java Development Kit (JDK).

Java-MATLAB Interface — Known as the JMI Interface, this is the Java
interface built into MATLAB software.

JDK — The Java Development Kit is a free Oracle® product which provides
the environment required for programming in Java. The JDK™ ig available
for various platforms, but most notably Oracle Solaris™ and Microsoft
Windows. To build components with MATLAB Builder JA, download the JDK
that corresponds to the latest version of Java supported by MATLAB.

JMI Interface — see Java-MATLAB Interface.

JRE — Java Run-Time Environment is the part of the Java Development
Kit (JDK) required to run Java programs. It comprises the Java Virtual
Machine, the Java platform core classes, and supporting files. It does not
include the compiler, debugger, or other tools present in the JDK. The JRE™
is the smallest set of executables and files that constitute the standard Java
platform.

M
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Magic Square — A square array of integers arranged so that their sum is the
same when added vertically, horizontally, or diagonally.

MATLAB Production Server Client — In the MATLAB Production Server
software, clients are applications written in a language supported by
MATLAB Production Server that call deployed functions hosted on a server.

MATLAB Production Server Configuration — An instance of the MATLAB
Production Server containing at least one server and one client. Each
configuration of the software usually contains a unique set of values in the
server configuration file, main_config.

MATLAB Production Server Server Instance — A logical server configuration
created using the mps-new command in MATLAB Production Server software.

MATLAB Production Server Software — Product for server/client deployment
of MATLAB programs within your production systems, enabling you to
incorporate numerical analytics in enterprise applications. When you use this
software, Web, database, and enterprise applications connect to MATLAB
programs running on MATLAB Production Server via a lightweight client
library, isolating the MATLAB programs from your production system.
MATLAB Production Server software consists of one or more servers and
clients.

Marshaling — See Data Marshaling.

mbuild — MATLAB Compiler command that compiles and links C and
C++ source files into standalone applications or shared libraries. For more
information, see the mbuild function reference page.

mcc — The MATLAB command that invokes MATLAB Compiler. It is the
command-line equivalent of using the compiler apps.

MCR — The MATLAB Compiler Runtime 1s an execution engine made

up of the same shared libraries. MATLAB uses these libraries to enable

the execution of MATLAB files on systems without an installed version of
MATLAB. To deploy a component, you package the MCR along with it. Before
you use the MCR on a system without MATLAB, run the MCR Installer.
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MCR Installer — An installation program run to install the MATLAB
Compiler Runtime on a development machine that does not have an installed
version of MATLAB. Find out more about the MCR Installer by reading
“Distributing MATLAB Code Using the MATLAB Compiler Runtime (MCR)”.

MCR Singleton — See Shared MCR Instance.

MCR Workers — A MATLAB Compiler Runtime session. Using MATLAB
Production Server software, you have the option of specifying more than one

MCR session, using the - -num-workers options in the server configurations
file.

Method Attribute — In the context of .NET, a mechanism used to specify
declarative information to a .NET class. For example, in the context of client
programming with MATLAB Production Server software, you specify method
attributes to define MATLAB structures for input and output processing.

mxArray interface — The MATLAB data type containing all MATLAB
representations of standard mathematical data types.

MWArray interface — A proxy to mxArray. An application program interface
(API) for exchanging data between your application and MATLAB. Using
MWArray, you marshal data from traditional mathematical types to a form
that can be processed and understood by MATLAB data type mxArray. There
are different implementations of the MWArray proxy for each application
programming language.

P

Package — The act of bundling the deployed component, along with the
MCR and other files, into an installer that can be distributed to others. The
compiler apps place the installer in the for_redistribution subfolder. In
addition to the installer, the compiler apps generate a number of lose artifacts
that can be used for testing or building a custom installer.

PID File — See Process Identification File (PID File).
Pool — A pool of threads, in the context of server management using MATLAB

Production Server software. Servers created with the software do not allocate
a unique thread to each client connection. Rather, when data is available on
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a connection, the required processing is scheduled on a pool, or group, of
available threads. The server configuration file option - -num-threads sets
the size of that pool (the number of available request-processing threads)
in the master server process.

Process Identification File (PID File) — A file that documents informational
and error messages relating to a running server instance of MATLAB
Production Server software.

Program — A bundle of code that is executed to achieve a purpose. Programs
usually are written to automate repetitive operations through computer
processing. Enterprise system applications usually consist of hundreds or
even thousands of smaller programs.

Properties — For this definition in the context of .NET, see Fields and
Properties.

Proxy — A software design pattern typically using a class, which functions
as an interface to something else. For example, MWArray is a proxy for
programmers who need to access the underlying type mxArray.

S
Server Instance — See MATLAB Production Server Server Instance.

Shared Library — Groups of files that reside in one space on disk or memory
for fast loading into Windows applications. Dynamic-link libraries (DLLs) are
Microsoft’s implementation of the shared library concept in for Microsoft
Windows.

Shared MCR Instance — When using MATLAB Builder NE or MATLAB
Builder JA, you can create a shared MCR instance, also known as a singleton.
For builder NE, this only applies to COM components. When you invoke
MATLAB Compiler with the -S option through the builders (using either mcc
or the Deployment Tool), a single MCR instance is created for each COM

or Java component in an application. You reuse this instance by sharing it
among all subsequent class instances within the component. Such sharing
results in more efficient memory usage and eliminates the MCR startup cost

in each subsequent class instantiation. All class instances share a single
MATLAB workspace and share global variables in the MATLAB files used
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to build the component. MATLAB Builder NE and MATLAB Builder EX
are designed to create singletons by default for NET assemblies and COM
components, respectively. For more information, see “Sharing an MCR
Instance in COM or Java Applications”.

Standalone application — Programs that can be executed on their own and
encapsulate a self contained set of MATLAB functionality.

State — The present condition of a the MATLAB, or MCR, runtime. MATLAB
functions often carry state in the form of variable values. The MATLAB
Workspace itself also maintains information about global variables and path
settings. When deploying functions that carry state, you must often take
additional steps to ensure state retention when deploying applications that
use such functions.

Structs — MATLAB Structures. Structs are MATLAB arrays with elements
that you access using textual field designators. Fields are data containers
that store data of a specific MATLAB type.

System Compiler — A key part of Interactive Development Environments
(IDEs) such as Microsoft Visual Studio.

T

Thread — A portion of a program that can run independently of and
concurrently with other portions of the program. See pool for additional
information on managing the number of processing threads available to a
server instance.

Type-safe interface — An API that minimizes explicit type conversions by
hiding the MWArray type from the calling application. Using “Generate and
Implement Type-Safe Interfaces”, for example, NET Developers work directly
with familiar native data types. You can avoid performing tedious MWArray
data marshaling by using type-safe interfaces.

w

Web Application Archive (WAR) —In computing, a Web Application Archive is
a JAR file used to distribute a collection of JavaServer pages, servlets, Java
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classes, XML files, tag libraries, and static Web pages (HTML and related
files) that together constitute a Web application.

Webfigure — A MathWorks representation of a MATLAB figure, rendered on
the Web. Using the WebFigures feature, you display MATLAB figures on a
Web site for graphical manipulation by end users. This enables them to use
their graphical applications from anywhere on the Web, without the need to
download MATLAB or other tools that can consume costly resources.

Windows Communication Foundation (WCF) — The Windows Communication
Foundation™ is an application programming interface in the .NET
Framework for building connected, service-oriented, Web-centric applications.
WCF is designed in accordance with service oriented architecture principles
to support distributed computing where services are consumed by client
applications.



A
Add-in
Creation 6-5
Packaging 6-5
Registration of 1-19
Add-in registration 1-19
Administrative privileges
Changing 1-19
Customizing 1-19
Advanced Encryption Standard (AES)
cryptosystem 5-6
Architectures
64-bit and 32-bit compatibility 1-8
array formatting flags 7-12

Blank cells
Handling of 4-14 4-41
build process 5-2

C

Cells with no data
Handling of 4-14 4-41
class 1-5
class method
calling 7-5
Class MWFlags 10-14
Class MWUtil 10-3
COM
defined 1-5
COM component
Registration of 1-19
utility classes 10-1
COM VARIANT A-2
command line

differences between command-line and

apps 5-2
Command line 6-4

command line interface 6-4
Compiler

security 5-6
Component Object Model 1-5
Component Technology File (CTF) 5-6
componentinfo function 9-2
CreateObject function 7-5
CTF (Component Technology File) archive 5-6
CTF Archive

Controlling management and storage

of. 8-13

Embedding in component 8-13

CTF file 5-6

D

data conversion
utility classes for COM components 10-1
data conversion flags 7-12
data conversion rules A-2
debugging
-G option flag 9-16
Dependency Analysis Function 5-2 5-5
Deployment Tool 6-4
deploytool
differences between command-line and 5-2
deploytool function 9-7
Dialog boxes
Creating 6-15
DLLs 5-6
utility classes for COM components 10-1

Empty cell handling 4-14 4-41
Empty cells

Handling of 4-14 4-41
Enumeration

mwArrayFormat 10-40

mwDataType 10-41

Index-1



Index

mwDateFormat 10-42

Error messages

Creating 6-15

errors

Excel B-7
MATLAB Builder EX B-3

Excel macro

running an 4-20 4-52

Excel Macro

F

creation from
MATLAB function 4-19
creation of 4-19

Files neccessary for deployment 1-18
Files needed for deployment 1-18
Files required for deployment 1-18
flags

array formatting 7-12
data conversion 7-12

Function with multiple outputs 6-11
Function Wizard

Index-2

Creating macros 4-2 4-24

creating macros with 4-19

Debugging MATLAB functions with 4-24

defining argument properties 4-19

Deploying MATLAB functions from scratch
with 4-24

Executing functions 4-2 4-24

executing functions with 4-19

Input Properties 4-9 4-37

installation of 4-4 4-29

macro execution 4-20 4-52

Output Properties 4-11 4-39

Output Ranges 4-11 4-39

Prototyping MATLAB functions with 4-24

purpose 4-3 4-27

running a macro 4-20 4-52

specifying argument properties 4-19

start-up 4-5 4-30
starting 4-5 4-30
Struct arrays

Working with 4-14 4-42
unsupported data types 4-3 4-27
. See using with functions ready for
deployment

functions 7-3

G

-G option flag 9-16
Graphical function

Running a 6-11
With no inputs or outputs 6-11

Graphical function execution 6-11

L

Using the Function Wizard 6-11

Library Compiler

differences between command-line and 5-2

Limitations 6-3
Load function 5-18
loadlibrary

M

(MATLAB function)
Use of 5-16

-M option flag 9-16
macro

execution of a 4-20 4-52
running a 4-20 4-52

Macro creation

with Function Wizard 4-19

Macros

Assigning a GUI control to 4-21 4-54
GUI buttons 4-22 4-54

GUI controls 4-22 4-54

Mapping a GUI control to 4-21 4-54



Index

Macros displaying dialog boxes
Creating 6-15
Macros displaying errors
Creating 6-15
.mat file
How to use with compiled applications 5-18
MAT file
How to explicitly include in dependency
analysis 5-18
How to force MATLAB Compiler to inspect
for dependencies 5-18
How to use with compiled applications 5-18
MATLAB Builder EX
Compilation targets 6-2
MATLAB Compiler
build process 5-2
MATLAB Compiler Runtime (MCR)
defined 1-21 8-2
MATLAB Component Runtime (MCR)
Administrator Privileges, requirement
of 1-21 8-2
Version Compatibility with MATLAB 1-21
8-2
MATLAB data files 5-18
MATLAB file
encrypting 5-6
MATLAB Function
End-to-End deployment of
as an Excel add-in or COM
component 4-24
MATLAB Function Signatures
Application Deployment product processing
of 5-14
MATLAB objects
no support for 6-3
mcc 9-9
differences between command-line and
apps 5-2
mcc command line 6-4
MCR 1-21 8-2

MCR Component Cache
How to use
Overriding CTF embedding 8-13
MCR Installer 1-21 8-2 to 8-3
methods 1-5
MEX-files 5-2 5-5 to 5-6
Microsoft Excel Add-in
Calling from Excel sheet 1-23
Calling from Excel spreadsheet 1-23
distribution 1-22
installation 1-22
Microsoft Visual Basic
Code access 4-21 4-54
Code modification 4-21 4-54
missing parameter 10-7
Multiple output functions 6-11
MWComponentOptions 8-13
MWFlags class 10-14
mwregsvr
Changing permissions with 1-19
Using 1-19
MWUtil class 10-3

New operator 7-6

o

Outputs produced
by Builder EX compared to Function
Wizard 6-2

P

Parallel Computing Toolbox
example of 8-8
Supplying Run-Time Profile Information
for 8-8
pass through
-M option flag 9-16

Index-3



Index

Permissions
Changing 1-19
mwregsvr 1-19
Specifying 1-19

S

Save function 5-18
security 5-6
shared libraries 5-6
shared library 5-6
Standalone App Compiler
differences between command-line and 5-2
Struct arrays
Defining input argument properties for 4-14
4-42
Working with 4-14 4-42

Index-4

structure array support
element-by-element organization 4-18 4-46
plane organization 4-18 4-46
Structure arrays 4-14 4-42
Deploying as inputs and outputs 4-19 4-47
Needs of end users 4-19 4-47
Use of macros with 4-19 4-47
subroutines 7-3

T

troubleshooting
MATLAB Builder EX B-3

\"4
VARIANT variable A-2



	toc
	Getting Started
	MATLAB Builder EX Product Description
	Key Features

	MATLAB Application Deployment Products 
	How MATLAB Builder EX Works
	MATLAB Builder EX Prerequisites
	Your Role in the Deployment Process
	Products, Compilers, and IDE Installation
	Macro Execution Security Levels in Microsoft Excel
	Deployment Target Architectures and Compatibility
	Migration Considerations for 32-bit and 64-bit Microsoft Excel

	Dependency and Non-Compilable Code Considerations
	For More Information

	Choosing Function Deployment Workflow
	Is Your Function Ready for Deployment?
	Other Examples

	Create a Microsoft Excel Add-In and COM Component from MATLAB Co
	Create an Excel Add-in in MATLAB

	Integrate an Add-In and COM Component with Microsoft Excel
	Files Necessary for Deployment
	Add-in and COM Component Registration
	COM Component Incorporation into Microsoft Excel using the Funct
	Distributing MATLAB Code Using the MATLAB Compiler Runtime (MCR)
	Install MATLAB Compiler Runtime (MCR) 
	MCR Prerequisites
	Add the MCR Installer to the Installer
	Install the MCR

	Add-in Installation and Distribution
	Calling Add-in Code from the Excel Spreadsheet


	Next Steps

	Customizing a Compiler Project
	Customize the Installer
	Change the Application Icon
	Add Application Information
	Change the Splash Screen
	Change the Installation Path
	Change the Logo
	Edit the Installation Notes

	Manage Required Files in a Compiler Project
	Dependency Analysis
	Using the Compiler Apps
	Using mcc

	Specify Files to Install with the Application
	Manage Support Packages

	Integrating with MATLAB Production Server
	Build Deployable Archive and Add-In
	Install the Deployable Archive
	Install the Excel Add-In
	Install with the Generated Installer
	Install with the Raw Files

	Data Marshaling Rules
	Default Marshaling Rules
	Change Rules for Marshaling Data into MATLAB
	Change Rules for Marshaling Data into Excel

	Change the Server Configuration
	XLA File Not Generated
	Server Configuration Add-in Not Enabled
	Error in myfunc: Object reference not set to an instance of an o

	The Function Wizard
	Executing Functions and Creating Macros Using the Function Wizar
	What Can the Function Wizard Do for Me?
	Installation of the Function Wizard
	Using Office 2007
	Using Office 2010
	Using Office 2003

	Function Wizard Start-Up
	Using Office 2007 or Office 2010
	Using Office 2003

	Workflow Selection for MATLAB Functions Ready for Deployment
	Defining Functions Ready to Execute
	Empty Cell Value Control
	Working with Struct Arrays

	Function Execution
	Macro Creation
	Macro Execution
	Using Office 2007 or Office 2010
	Using Office 2003
	Watch a Video

	Microsoft Visual Basic Code Access (Optional Advanced Task)
	Using Office 2007 or Office 2010
	Using Office 2003
	Mapping a Macro to a GUI Button or Control (Optional)

	For More Information

	End-to-End Deployment of a MATLAB Function Using the Function Wi
	What Can the Function Wizard Do for Me?
	Example File Copying
	mymagic Testing
	Installation of the Function Wizard
	Using Office 2007
	Using Office 2010
	Using Office 2003

	Function Wizard Start-Up
	Using Office 2007 or Office 2010
	Using Office 2003

	Workflow Selection for Prototyping and Debugging MATLAB Function
	About Project Files
	Quitting the MATLAB Session Invoked by the Function Wizard

	New MATLAB Function Definition
	Empty Cell Value Control
	Working with Struct Arrays

	MATLAB Function Prototyping and Debugging
	Prototyping and Debugging with myprimes

	Function Execution from MATLAB
	Microsoft Excel Add-in and Macro Creation Using the Function Wiz
	Creating an Add-in and Associated Excel Macro
	Creating a COM Component or a Macro Only Without Creating an Add

	Function Execution from the Deployed Component
	Macro Execution
	Using Office 2007 or Office 2010
	Using Office 2003
	Watch a Video

	Microsoft Excel Add-in and Macro Packaging using the Function Wi
	Microsoft Visual Basic Code Access (Optional Advanced Task)
	Using Office 2007 or Office 2010
	Using Office 2003
	Mapping a Macro to a GUI Button or Control (Optional)

	For More Information


	MATLAB Code Deployment
	Application Deployment Products and the Compiler Apps
	What Is the Difference Between the Compiler Apps and the mcc Com
	How Does MATLAB Compiler Software Build My Application?
	Dependency Analysis Function
	MEX-Files, DLLs, or Shared Libraries
	Component Technology File (CTF Archive)
	Additional Details


	Write Deployable MATLAB Code
	Compiled Applications Do Not Process MATLAB Files at Runtime
	Do Not Rely on Changing Directory or Path to Control the Executi
	Use ismcc and isdeployed Functions To Execute Deployment-Specifi
	Gradually Refactor Applications That Depend on Noncompilable Fun
	Do Not Create or Use Nonconstant Static State Variables
	Get Proper Licenses for Toolbox Functionality You Want to Deploy

	How the Deployment Products Process MATLAB Function Signatures
	MATLAB Function Signature
	MATLAB Programming Basics
	Creating a Deployable MATLAB Function
	Taking Inputs into a Function

	Load MATLAB Libraries using loadlibrary
	Restrictions on Using MATLAB Function loadlibrary with MATLAB Co

	Use MATLAB Data Files (MAT Files) in Compiled Applications
	Explicitly Including MAT files Using the %#function Pragma
	Load and Save Functions
	Using Load/Save Functions to Process MATLAB Data for Deployed Ap

	MATLAB Objects


	Microsoft Excel Add-in Creation, Function Execution, and Deploym
	Supported Compilation Targets
	Microsoft Excel Add-in
	Migration Considerations for 32-bit and 64-bit Microsoft Excel

	What Are MATLAB Builder EX Components and When Should You Create
	MATLAB Builder EX Limitations

	The Library Compiler and the Command Line Interface
	Using the Library Compiler
	Using the mcc Command Line Interface

	Add-in and Macro Creation from MATLAB Functions 
	Create Add-ins and Macros with Single and Multiple Outputs
	Work with Variable-Length Inputs and Outputs
	Overview
	Where Is the Example Code?
	Creating the Project
	Adding a MATLAB Builder EX COM Function to Microsoft Excel
	Calling myplot
	Calling mysum Four Different Ways
	myprimes Macro
	Inspecting the Microsoft Visual Basic Code (Optional)
	For More Information


	Execute Add-in With the Function Wizard
	Execute an Add-in to Validate Nongraphical Function Output
	Functions Having Multiple Outputs

	Execute a Graphical Function
	Create a Macro Using a Graphical Function

	Create Dialog Box and Error Message Macros
	Create a Macro That Displays an Error Message or Dialog Box



	Microsoft Excel Add-in Integration
	Overview of the Integration Process 
	Code Your Microsoft Visual Basic Application
	When to Use a Formula Function or a Subroutine
	Initializing MATLAB Builder EX Libraries with Microsoft Excel
	Creating an Instance of a Class
	Overview
	CreateObject Function
	New Operator
	How the MCR Is Shared Among Classes

	Calling the Methods of a Class Instance
	Programming with Variable Arguments
	Processing varargin and varargout Arguments
	Passing an Empty varargin from Microsoft Visual Basic Code
	For More Information

	Modifying Flags
	Overview
	Array Formatting Flags
	Data Conversion Flags

	Handling Errors During a Method Call

	Build and Integrate with Spectral Analysis
	Overview
	Building the Component
	Where Is the Example Code?

	Integrating the Component Using VBA
	Selecting the Libraries
	Creating the Visual Basic Form
	Adding the Spectral Analysis Menu Item to Excel

	Testing the Add-in
	Creating the Test Problem
	Creating the Data
	Running the Test

	Packaging and Distributing the Add-in
	Installing the Add-in

	For More Information

	Distribution to End Users
	Distribute Your Add-Ins and COM Components to End Users
	Distributing MATLAB Code Using the MATLAB Compiler Runtime (MCR)
	Install MATLAB Compiler Runtime (MCR) 
	MCR Prerequisites
	Add the MCR Installer to the Installer
	Install the MCR


	Deploying Your Microsoft Visual Basic Application
	Calling Compiled MATLAB Functions from Microsoft Excel
	Where Is the Example Code?

	Improving Data Access Using the MCR User Data Interface, COM Com
	Overview
	Supplying Run-Time Profile Information for Parallel Computing To

	MCR Component Cache and CTF Archive Embedding
	Overriding Default Behavior
	For More Information

	MCR Run-Time Options
	What MCR Options are Supported by MATLAB Builder EX?
	How Do I Specify MCR Options?


	For More Information

	Function Reference
	Utility Library for Microsoft COM Components
	Referencing Utility Classes
	Class MWUtil
	Sub MWInitApplication(pApp As Object)
	Parameters
	Return Value
	Remarks
	Example

	Sub MWInitApplicationWithMCROptions(pApp As Object, [mcrOptionLi
	Parameters
	Return Value
	Remarks
	Example

	Function IsMCRJVMEnabled() As Boolean
	Parameters
	Return Value

	Function IsMCRInitialized() As Boolean
	Parameters
	Return Value

	Sub MWPack(pVarArg, [Var0], [Var1], ... ,[Var31])
	Parameters
	Return Value
		Remarks
		Example

	Sub MWUnpack(VarArg, [nStartAt As Long], [bAutoResize As Boolean
	Parameters
	Return Value
	Remarks
	Example

	Sub MWDate2VariantDate(pVar)
	Parameters
	Return Value
	Remarks
	Example


	Class MWFlags
	Property ArrayFormatFlags As MWArrayFormatFlags
	Property InputArrayFormat As mwArrayFormat
	Property InputArrayIndFlag As Long
	Property OutputArrayFormat As mwArrayFormat
	Property OutputArrayIndFlag As Long
	Property AutoResizeOutput As Boolean
	Property TransposeOutput As Boolean

	Property DataConversionFlags As MWDataConversionFlags
	Property CoerceNumericToType As mwDataType
	PropertyDateBias As Long
	Property InputDateFormat As mwDateFormat
	PropertyOutputAsDate As Boolean
	ReplaceMissing As mwReplaceMissingData

	Sub Clone(ppFlags As MWFlags)
	Parameters
	Return Value
	Remarks


	Class MWStruct
	Sub Initialize([varDims], [varFieldNames])
	Parameters
	Return Value
	Remarks
	Example

	Property Item([i0], [i1], ..., [i31]) As MWField
	Parameters
	Remarks

	Property NumberOfFields As Long
	Property NumberOfDims As Long
	Property Dims As Variant
	Property FieldNames As Variant
	Example

	Sub Clone(ppStruct As MWStruct)
	Parameters
	Return Value
	Remarks
	Example


	Class MWField
	Property Name As String
	Property Value As Variant
	Property MWFlags As MWFlags
	Sub Clone(ppField As MWField)
	Parameters
	Return Value
	Remarks


	Class MWComplex
	Property Real As Variant
	Property Imag As Variant
	Example

	Property MWFlags As MWFlags
	Sub Clone(ppComplex As MWComplex)
	Parameters
	Return Value
	Remarks


	Class MWSparse
	Property NumRows As Long
	Property NumColumns As Long
	Property RowIndex As Variant
	Property ColumnIndex As Variant
	Property Array As Variant
	Property MWFlags As MWFlags
	Sub Clone(ppSparse As MWSparse)
	Parameters
	Return Value
	Remarks
	Example


	Class MWArg
	Property Value As Variant
	Property MWFlags As MWFlags
	Sub Clone(ppArg As MWArg)
	Parameters
	Return Value
	Remarks


	Enum mwArrayFormat
	Enum mwDataType
	Enum mwDateFormat

	Data Conversion
	Data Conversion Rules 
	Array Formatting Flags
	Data Conversion Flags
	CoerceNumericToType
	InputDateFormat
	OutputAsDate As Boolean
	DateBias As Long


	Troubleshooting
	Errors and Solutions
	MATLAB Builder EX Errors and Suggested Solutions
	Required Locations to Develop and Use Components
	Microsoft Excel Errors and Suggested Solutions
	Function Wizard Problems

	Deployment Product Terms

	Index

	tables
	MATLAB Suite of Application Deployment Products
	Application Deployment Roles, Goals, and Tasks
	Key Tasks for the Microsoft Excel End User
	Default Installation Paths
	Custom Installation Roots
	Key Tasks for the End User
	MATLAB Programmer
	Key Tasks for the MATLAB Programmer
	Information on CTF Archive Embedding/Extraction and Component Ca
	Microsoft Excel Developer
	Controls Needed for Spectral Analysis Example
	Registry Information Returned by componentinfo 
	Registry Information Returned by componentinfo (Continued)
	Array Formatting Rules for Input Arrays
	Array Formatting Rules for Output Arrays 
	Conversion Rules for Input Dates 
	mwArrayFormat Values 
	mwDataType Values 
	mwDateFormat Values 
	VARIANT Type Codes Supported 
	MATLAB to COM VARIANT Conversion Rules
	COM VARIANT to MATLAB Conversion Rules
	Array Formatting Flags
	 


